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CHAPTER 1 — INE IGHT CONTRACT
OVERV IEW

Traditionally, there are many offline activities associated with creating and administering contracts. 
For example, logs are maintained, spreadsheets are updated, and meeting minutes are filed.  As these
tasks are completed, the hope is that a corresponding update is made to keep the back end or financial
system in line with the reality in the field. 

InEight Contract provides a consistent and intuitive overlay to not only perform these functions, but
also ensure that the underlying systems (such as your ERP system) are in sync with actions taking place
in the field.  As an added benefit, the history and information associated with the activity is available in
real time and in one tool, making the contract management processes more efficient and accurate. It
eliminates the need for multiple side spreadsheets that require double-entry to keep up to date. 

1.0.1 ERP Integration

Contract can integrate with your ERP system to manage payments and other resources. If your
organization does not want to integrate with an ERP system, they can operate with a proxy ERP. Your
system administrator uses an organization setting to indicate whether to integrate with the ERP or use
a proxy ERP.

To enable ERP integration, set the ERP integration toggle in the organization settings (Contract >
Contracts > Contract Configurations) to ERP integration. If you have the Edit contract configuration
permission, you can switch the toggle as needed.

1.0.1 .1 Cons iderat ions for ERP system integrat ion

When using an ERP system, the system administrator specifies whether to integrate the following ERP
system functions:

l Tax calculation before publishing a contract. When set to Yes, the ERP system calculates
the tax before publishing a contract. When set to No, the ERP system calculates the tax
and sends the result back to Contract when publishing.

l Equipment details when publishing a contract. When set to Yes, the equipment details are
included with the purchase order line item details when sent to the ERP system. When set
to No, no details are sent to the ERP system and are available in Contract only.
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See your system administrator about the options used by your organization.

1.0.1 .2 Cons iderat ions for proxy ERP

If your organization does not integrate with an ERP system, you are responsible for the following:

l Currency conversion. Currency conversions are typically handled by an ERP system. In a
proxy ERP environment, you can use the conversion table in the project details (Project >
Project details > Details) for reporting only. If you get a notification that the currency is not
maintained in project details, contract your project administrator.

l Invoices and payment forms. The proxy ERP allows only one invoice per payment form.
l Payment progress maintenance. If you have the correct permission, you can edit the
following fields on the Payment Progress tab: Date cashed, Check number, Method, Paid
amount, and Retention released.

The proxy ERP simulates the successful publishing of purchase orders, vendor change orders, goods
receipts, accruals, and payment forms by issuing an auto-response. Validations that are in place for an
ERP system are not performed, and you are responsible for the accuracy of this information.

1.0.2 Contract Workflow

The functionality of Contract is organized into two areas:

l Bid Packages
l Contracts

The diagram below provides the overall workflow for Contract and how it integrates with other
applications, including InEight Change, InEight Progress, InEight Control, and your ERP system.

InEight Inc.  |  Release 25.9 Page 17 of 378

Contract User Guide



1.0.3 Bid Packages

The Bid Packages module allows you to itemize out the scopes of work that you intend to put under
contract. Bid Packages are usually created after the estimate is completed and the project is awarded.
Bid Packages also can track milestones leading up to contract execution to ensure you meet product
and service delivery dates, and to help you move the package from concept to under contract.

The diagram below illustrates the workflow followed in the Bid Packages module:
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1.0.4 Contracts

The Contracts module is where a contract’s lifecycle can be managed from creation to closeout.
Managing Contracts includes:

l Adding contract details and line items
l Adding supporting documentation, including the executed contract agreement
l Initiating a purchase order for the contract
l Adding associated vendor change orders (tied to Change Management)
l Allocating payments for invoices received in the field
l Following a closeout process for the contract

The Contracts module follows the workflow indicated below.
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1.0.5 Who uses InEight Contract?

The primary users of InEight Contract differ from the typical roles that use the rest of the InEight cloud
platform, namely Contract Managers and Contract Administrators. In other words, the main users of
Contract are employees focused on contract management as their primary role.

There are, however various touchpoints where other field personnel will use Contract as part of their
daily tasks. For example:

l Field Handlers that oversee specific work packages will perform specific functions in
Contract

l Field workers tasked with getting payment approvals for routing invoices will input that
information in Contract, where it will automatically sync to the back office system

l Project Engineers, Project Managers, and Controllers will access Pay Forms in Contract
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CHAPTER 2 — PROJECT SETUP

To manage contracts and bid packages successfully, the correct Contract settings must be set up
before project initiation. Some settings differ between the organization and project levels.

2.0.1 Organization settings

Prior to initiation, the organization and project settings are significant to successfully manage a project
in Contract. Organization settings are distinct from the project settings since they are defined by the
administrative level of your organization.

2.0.1 .1 Cont rac t templa tes

Contract Writer is a customized contract document writer intended to generate a complete contract
for a vendor or subcontractor to eventually agree to, accept, and sign. Contract writer can create
project-specific documents such as contracts, payment forms, and vendor change orders by combining
Microsoft Word or Excel templates defined at the organization and project levels.

Each template is a collection of predefined contract writer tags that autofill the contract document
with the information from your contract.

Template types subtab

The Template types subtab shows the templates register and gives you the tools you need to start
building templates.

You can download a sample template that gives you an idea of where to start with your template. You
can also get a list of general tags and collection table tags to be used in the template. After you have
opened the list, you can export the tags to a Microsoft Excel spreadsheet.

Download a sample templa te

You can download a sample template in Microsoft Word and Microsoft Excel formats. The samples
show how a contract could look in either format. This feature is available at both the organization and
project levels.
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To download a sample template, click the Download sample template icon on the template register,
and then select either Download Word template or Download Excel template.

Create a cont rac t templa te

To create a template for your contract documentation, you use predefined contract writer tags to
autofill your contract document with the information from the contract. From the Add contract
template record, select the View available tags icon to open a list of available tags. Select General tags
to see a list of tags that can be used in the body of the template only. Select Collection table tags to
see the list of tags that can be used in collection tables. General tags cannot be used in a collection
table.

The list shows the following information:

l Tag name.
l The location of the source of the data, which is the name of the page that Contract pulls the
information from when building the template.

l A description of the tag.
l Example text that shows what text might look like in your contract. Contract also uses the
example text in the sample template.

l The type of template for which the tags are valid.
l An example of how this information might look in the contract document.
l the type of template for which the tags are valid.

Tag names do not reflect custom labels that your organization might have set up. You can refer
to the Contract Custom Labels tab in project settings for custom label mappings.

After you have opened the list, you can export the tags to Excel. Refer to the instructions on the
Instructions tab of the Excel file for information about using tags and building a template.
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Mainta in f ie ld format t ing

Large text box fields, such as the Scope of the contract, Scope of change, Inclusions, Exclusions,
Warranty, Contract terms 1 - 4, and Vendor change order terms 1 - 4 fields, contain formatting tools
that let you use boldface type, numbered or bulleted lists, and other text formats. To preserve this
formatting in Micorosoft Word templates, you can insert a Word merge field instead of a tag for the
field.

To insert a merge field in a Word template, position the cursor, and then go to Insert > Quick parts >
Field. From the Field dialog box, select MergeField, and then enter the tag name without the brackets
in the Field Properties > Field name field (for example, Contract term 1). When a document is
generated, Word applies the formatting for the field.

Refer to the Instructions in the Contract templates tags spreadsheet for more information about merge
tags.

DocuSign tags

DocuSign eSignature tags for recipients let you embed signee information to pull into your organization
or project templates. DocuSign tags used in a template are read when sending a document for
signature.

The DocuSign tags serve as placeholders for the eSignatures. Contract's DocuSign tags include tags that
serve as placeholders for text boxes, check boxes, drop-down lists, and radio buttons added by the
document sender in the DocuSign Sender view. These tags are available for eSign 1-10 and for each
project contact. When you add the tags in the template, you ensure the corresponding item is
consistently placed.
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For text and drop-down lists, you only place one tag in the template. For check boxes, you place one
tag for each option. For radio buttons, a single tag places two buttons in the document. You can add
more radio button tags for additional buttons.

When you open a document with these tags in the DocuSign Sender view, the tags are present, but
they do not have values. You can add the values from the Sender view. For example, if the template
has three check box tags, when the document is opened in DocuSign, three empty check boxes are
shown. You then add the value for each check box in DocuSign.

Refer to the instructions on the Instructions tab of the Excel file for more information about DocuSign
tags.

Template types

Contract templates are classified by the template type. This classification can help you ensure that the
template suits your business needs based on the purpose of the template. Contract supports the
following template types:

l Contract
l VCO
l Payment claim
l Payment form
l Purchase order
l Other (for supplemental and exhibit information)

The template type indicates which general tags and collection tags are valid for the template. For
example, a payment form template can use the tags that are applicable for payment form templates.
Any template can use the tags for all templates. The template tags are validated when you attach a
template file to the template.

If you have invalid tags, the Template file section of the Details page shows a message that there are
validation errors. You must go into the Word or Excel template and fix the errors. You cannot publish
the template f there are any errors.

Template language

You can define the language in which the contract template is generated using the Select template
language field on the template Details page. Selecting a template language lessens the tags available.
For example, if you select Spanish as the template language, you can use only Spanish tags in the
template even if the language of your application is English. Upon generation, template and tags are
generated in Spanish.
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You cannot use tags in multiple languages in a single template. During template validation, the
application only searches the tags of the selected language instead of all languages.

Col lec t ion tab les

You can add multiple items to a contract, payment form, or vendor change order template by using a
collection table. You can create collection tables in Word or Excel that include those items and place it
into the template.

A collection table contains collection tags specific to a template type. General tags cannot be used in a
collection table. The Contract writer searches the information in the Contract application and returns
the values in the table. Collection tags are specific to the template type and table type. For example,
the Vendor Change Order template type has table types for VCO line items, VCO documents, VCO
issues, and others. A collection table can have tags for one table type only, but a template can have
multiple tables.

You can also use conditional table tags to set the language in a contract document collection table tag
based on the value specified in a custom field. Conditional tags let you set up different language and
tag string options that populate the contract document based on the value selected in the Custom list
field in the contract line item. For example, if the conditional field Line item Custom list 1 is set up with
values for line item, lump sum, and cost item, you can set up contract document text for line items,
text for lump sums, and text for cost items. See Conditional tag setup subtab for more information
about setting up conditions and using conditional tags in a collection table.

Add a col lec t ion tab le to a templa te

1. Export the collection tags list and follow the instructions on the Instructions tab of the
spreadsheet.

2. Open or create a new template in Microsoft Word or Excel. Keep in mind the template type
(contract, vendor change order, or payment form).

3. Create a table in the document or spreadsheet.

4. Enter headers, if applicable, and format the table to suit your business needs.

5. Enter a tag in each column. The tag can be from one table type only.

6. Save your document.

Collection tags do not show up on the Review templates page. If you have a template that has
only collection tags you see the message "No general tags found in this template" in the review
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area. You can see collection tags in the preview. If there is an error, you must fix it in the Word
or Excel document. If a field is missing, you must go to the contract and fix that item.

Tips for us ing template tags

Template tags are the building blocks of a Change document. The tags pull information from the
corresponding data field in the issue, PCO, or CCO detail to populate the document. Use the following
guidelines when you are adding tags to your template.

Additional instructions can be found in the tags export spreadsheet.

Genera l tag in format ion

l General tags cannot be used in a table.

l Equations are discarded in document generation. No tags in an equation are read.

l Some fields in the application have their own formatting that is applied in the template, such as
a bullet list. The general tags associated with those fields use the application's formatting, and
you do not have to enter additional formatting in the template.

Col lec t ion tab le tags

l Only collection table tags can be used in a collection table.

l Tags cannot be read from nested tables, such as a table within a table.

DocuSign tags

l Change the color of DocuSign tags to white, otherwise the tags show in the document. The white
text matches the background and hides the tag.

l When adding a DocuSign tag to an Excel template, the column or row must be large enough for
the entire tag name. when the Excel file is converted to a PDF to send to DocuSign, the system
cannot read the tag if the whole tag name was not visible in Excel.

DocuSign Advanced Opt ions

Contract supports the use of DocuSign Advanced Options. The DocuSign Advanced Options are
configured in DocuSign. These options let you customize the DocuSign experience. Your DocuSign
administrator can set up the following options in DocuSign:
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l Branding options let you select a logo and brand colors that were set up by the DocuSign
administrator, for the envelope.

l Reminders options let you specify whether DocuSign sends reminders to signees, when to start
sending them, and how often to send them.

l Expiration options let you set the number of days until the envelope expires and how often to
send alerts. After the envelope is expired, recipients can no longer view or sign the documents in
the envelope.

l Comments options let senders and recipients enter comments on documents in the envelope.

l Recipient privilege lets you give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

Microsof t Word documents

l Any text formatted in Change on the Details pages are retained in Word documents.

Microsof t Exce l documents

l For large text cells where you can format text, the formatting is converted to plain text.

l Any text formatted in Change on the Details pages is converted to plain text in Excel.

l Only the first sheet in an Excel template is read and tag information inserted. To generate
multiple Excel sheets, create multiple Excel files and merge them into a single PDF.

l The Change writer discards text boxes, word art, drawings, equations, and formulas inserted into
an Excel document.

l Tags cannot be used in calculations.

l The Pricing summary tags are not valid in Excel.

Bui ld your templa te

After the Excel file opens after downloading, you can copy the tags you need into a Word or Excel
version of your contract document, inserting them in the appropriate places within your
contract. Refer to the instructions on the Instructions tab of the Excel file for information about using
tags and building a template. You can insert tags into the body, header, or footer of the Word
template. You can also insert the tags in the body of an Excel template.
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1. Insert tags into the document as shown in the example.

When adding tags for DocuSign, change the font color to white, so the tag name does not
show in the generated document.

2. Name the template and save as an MS Word (.docx) document. 
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3. Return to the Contract template register, select the Add icon to create a new Contract template.
This opens the Details page.

Item
Number Name Definition

1 Preview
sample

Opens a preview of your template using the default sample data.

2 Create
new
version

Creates a new version of the template. This feature lets you update
the version of a template instead of inactivating it and then creating a
new one.

3 Control
buttons

Lets you cancel the template creation, save and publish, or only save
to access later.

4 Detail
area

Lets you name the template, specify the template type and language,
and add a description of the template.

5 Set as
default

Lets you specify at the organization level that a payment form or
purchase order template is the default. The default template is
attached automatically to any payment form workflow. The toggle
switch is active only when the Template type field is set to Payment
Form or Purchase order.

6 Tags Area where you can view and download the general and collection
table tags.

7 Template
file

Attach the template file which was created with the downloaded tags.
Tags are validated after the file has been attached.

8 Contract
types

Assigned contract types that could use this template. When the Set
as default field value is Yes for a payment form or purchase order, the
template becomes the default template when you download a
payment form or purchase order for the specified contract type.

9 Attributes Lets you add one or more market attributes that provide additional
ways to filter templates. Organization-level templates default to On for
project use. When a market is added to a template, the templates
default to Off for projects that do not have a matching market. When a
market is added to the project, Contract turns on any matching
templates that had previously defaulted to Off.

Overview – Contract template Details
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Template vers ions

When you update templates with additional information, you can create a new version of the template
instead of deactivating it. The Create new version button is enabled when you edit a template.

When you create a new version, the version numbering starts after the previous version. The new
template version starts in the draft state. You can edit any of the fields except the template type and
language. You can then attach the new file. Only one draft version can exist for a template at a time.

Only one version of a template can be active at a time. After you publish a new version, the previous
version becomes inactive and is removed from the Templates register.

The Version column of the Templates register lets you see the template version. When you click the
version number, the template version history is shown. The template names are linked to the
Template details page, so you can quickly view the detail information.
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The Version history subtab contains links to previous versions of a template. The version history shows
all versions in descending order, including inactive versions.

Versions of organization-level templates are available for use at the project level, but you can only
create a new version of those templates at the organization level.

Defau l t payment form templa te

You can use one template as the default payment form template. The default template is attached
automatically to any payment form or workflow. The default template is indicated by a yellow triangle
in the organization template register. You can set the default using the Set as default toggle setting on
the template Details page.

Bui ld a Cont rac t Templa te

1. From Organization settings > Contract, select Contract Templates.

2. Select the View available tags icon to view general or collection table tags. This example uses
general tags.

The Contract writer tag document opens.
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3. Select the Export tag list icon to export it to your hard drive as an Excel file.

4. Save the exported file.

5. Open the Excel file you just saved. The value in the Applicable for column indicates the template
type that can use the tag.

6. Copy and paste the tags into the Microsoft Word or Microsoft Excel document you are creating
as your new contract. 
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l Tags must be inserted exactly as they appear in the Tag name column.

l A template can use tags that are applicable to one template type plus the tags that are
applicable to all templates.

7. If applicable, you can insert one or more collection tables that are applicable to the template
type. Refer to the topic Collection tables for information about building a collection table.

8. After all tags are inserted into the contract Microsoft Word or Excel document, name the new
template as [your initials – contract template].

9. Save it as a Word (.docx) or Excel (.xlsx) file.

l Below is an example of a Word document with inserted tags

10. Return to the Contract templates tab and select the Add Contract icon.

11. In the Add a new template dialog box, fill in the fields with the following:

l Template name: Use the name you named your template

l Description: Test contract template

12. Under Contract types, select the following as your Assign contract types:

l Subcontract

l Service agreement

l Material contract
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13. Under the Template file section, select No template file attached.

14. Find and select the contract template you created in Step 8 of this Step by Step.

15. After it has uploaded, select Add.
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16. Validation notices for tags and collection tables are shown. 

l If the document was not validated, select the Not validated link to view the errors, fix
the errors in your document, save and publish again.

The file can be closed but not published with invalid tags. 

17. Click Save and Publish.

l Return to the Contract tab under Contracts.

You can edit the template name, description, markets, and set as default field for a published
template. Changes to these fields do not create a new version.

Item
Number Name Definition

1 Template The name you gave as the contract template.

2 Description The description you used when creating the template.

3 Status The status of the template after created. The status will show Draft,
Published or Saved.

4 Assigned
contract
types

The assignment(s) you made when creating the template. 
Assignments can be shown as Multiple, None or one type. 
Hovering over the ellipse will show the contract types which were
selected during creation.    
A None indicator with the gear will indicate that none were initially
selected.  However, when you select the gear icon, it will allow you
to select and then save it as an assigned type.

5 Template
type

The type of contract that can use the template. Valid types are
Contract, Payment form, Purchase order, VCO, and Other.

Overview – Contract Template Header
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Item
Number Name Definition

6 Template file Name of the file which was uploaded into the contract writer.

7 Created date Date which the contract template was created.

8 Created by Name of person who created the template.

9 Modified date Date which the last modifications were made to the template.

10 Modified by Name of the person who made the last modification to the
template.

11 Template
language

The language of the tags in the template.

Overview – Contract Template Header (continued)

Template set t ings subtab

Template settings let you configure characteristics for each template type at the organization level.
The Template settings subtab (Settings > Contract templates > Template settings) contains controls for
editing, watermark stamps, and PDF output.
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Item
number Name Definition

1 Allow users to edit the
document during
generation

Indicates whether users can edit a contract document of
this type when it is in the review stage. When set to Yes,
a user can edit the contract document from the Review
templates dialog box. When set to No, the contract
document cannot be edited from the dialog box, and the
user has to edit contract information in Contract.

2 Require a watermark
stamp upon document
generation

Indicates whether to apply a watermark stamp when a
document of this type is generated. When set toYes the
watermark is applied to the document, but is removed
after the document has been approved. You can
configure the watermark text and settings in the
Watermark stamp section of this page. When set to No,
the contract document does not have a watermark.

3 Output as PDF only Indicates whether you can only generate a PDF when
you create a contract document of this type. When set
to Yes, you cannot generate a Microsoft Word or Excel
document or make changes to the contract files
individually.

4 End watermark Indicates the contract approval event that must occur
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Item
number Name Definition

requirement event before the watermark stamp is no longer required for
this template type. For example, if you set the End
watermark event field to Contract approval, the
watermark is no longer required after the contract is
approved. You can also indicate that the watermark
stamp is always required regardless of the contract
approval event. The watermark is removed from the
generated document when the document is approved.
This field is enabled only when the Require watermark
stamp upon document generation toggle is set to Yes.

The Watermark stamp section lets you define watermark text and layout for the Select watermark
stamp drop down list in the Contract writer. You can define the text for all languages used in your
templates. The language of the watermark matches the language of the template.

Condi t iona l tag setup subtab

Conditional tags let you set the text used in a collection table based on the value specified in a custom
list. The conditional tags are based on Line item Custom list 1 and Line item Custom list 2. You can then
configure template text based on each value of the field. For example, if Line item Custom list 1 is set
up with values for line item, lump sum, and cost item, you can set up contract document text for line
items, text for lump sums, and text for cost items. The text that populates the table cell depends on
the value of the Line item Custom list 1 field.

You can configure the conditional tag text on the Conditional tag setup page (Organization settings >
Contract > Contract templates > Conditional tag setup).
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You can set up two conditional fields each for conditional tags for contracts, schedule of values, VCOs,
and payment forms.

Set up condi t iona l tex t

1. From the Conditional tag setup page, select a conditional tag in the Conditional tags column.

2. Click the Download conditional collection table tags icon to download instructions and lists of
valid tags for each conditional tag.

3. Click the Add conditional tag icon.

4. In the slide-out panel, select one of the field values for the conditional field. If applicable, select
the template language.

5. In the Conditional language filed, enter the text or tags for the condition. Refer to the conditional
collection table tags you downloaded in step 2 for a list of available tags. The image below shows
a mix of text and tags, with tags highlighted in yellow.
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To use conditional tags in a template, follow the instructions for setting up a collection table. In one of
the columns, enter the tag for the custom list such as, <<Contract: Line item custom list 1>>. In another
column enter the conditional tag such as, <<Contract: Line item Conditional tag 1>>. Refer to the
Conditional tag setup spreadsheet for a detailed example.

When you generate a contract document, Contact fills in the text that is specific to the condition of the
custom list.

2.0.1 .2 Conf igura t ions

Organization-level configurations let you customize Contract for your organization. To see the
configuration settings, go to organization settings, and then select Contract >Configurations.
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Accrua l /Receip t set t ings

The Accrual/ Receipt settings configuration lets you specify the accrual types for your organization. You
can also specify whether accrual submissions and receipt submissions require supporting documents.

For each accrual type, you must set up the following:

Setting Description

Accrual type
name

The name of the accrual type to be used in the Accrual type drop-down field on
the Accruals/Receipts Line Items page.

ERP Accrual
type

The name of the accrual type to be used in the ERP system.
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Setting Description

Debit general
ledger

The general ledger account associated with debits.

Credit
general
ledger

The general ledger account associated with credits

Active Indicates whether the accrual type is active in the organization.

Bid package type conf igura t ion

The Bid package type configuration setup lets you establish details by bid package type. You can also
indicate whether all milestones must be completed before converting to a contract.

Mi les tone complet ion

When the All required milestones must be completed before converting to a contract toggle is set to
Yes, a bid package must complete all milestones before you can convert it to a contract. When set to
No, you can convert the bid package at any time. This setting applies to all bid package types.

Al low work f low when over budget

The Allow workflow when over budget toggle lets you control whether workflow can be initiated for a
bid package type based on budget. When the toggle is set to No and the original base value of the bid
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package exceeds the WBS current budget, an error shows when you try to start the approval process.
You should then check the original base value or reach out to the project controller. When the toggle is
set to Yes and the original base value of the bid package exceeds the WBS current budget, a yellow
warning banner shows at the top of the Budget check tab if there is a loss. You can still start the
workflow if the bid package exceeds the current budget.

Inc lude bid packages in pr imary repor t ing sect ion

The Include bid packages in primary reporting section toggle lets you control the default for the Include
this bid package in primary reporting section field (Bid package details > Additional Details >
Reporting). The field value can be changed in the Bid package details.

Show Primary Reporting Bid Packages Only is a parameter in some reports, such as Buyout Review.
When this parameter is selected, only bid packages with the Include this bid package in primary
reporting toggle in the bid package details set to Yes are shown in the report.

Def ine cont rac t types

You can specify which contract types a bid package type is associated to. Click Assign contract types to
see a list of available contract types. Select the required contract types, and then click Add. You can
also click the X by the contract type in the Selected contract types field to delete a contract type.

Requi red f ie lds

You can enable or disable fields and specify if enabled fields are required or locked for workflow or
conversion to a contract.

For each bid package field, you can specify if it is enabled. If a field is enabled you can specify whether
it is required or locked. The settings for workflow and conversion work independently. When a field is
required for workflow or conversion, a value must be entered before you can start the approval
workflow or convert a bid package to a contract. Locking a field prevents users from changing values
after the workflow approval or conversion has been started.

The default for Enable settings is set to Yes for all fields, but you can disable any field except the
Currency field. When a field is disabled, it shows on the Bid package header tab, but it is dimmed, and
you cannot enter a value.

The Currency field is required for workflow and converting the bid package to a contract. This
setting cannot be changed.

Contract type conf igura t ion setup

The Contract type configuration settings let you establish details for contracts by contract type.
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Master agreements

As an organization, you can define which contract types should be considered a master agreement. To
set a contract type as a master agreement, set the Is this a master agreement field to Yes. When the
field is set to Yes, an additional tab is added in the application register home page for master
agreements. You can then specify whether to publish the master agreement to an ERP. When the Is
this a Master agreement field is set to Yes, the Allow Association to Master agreement field is set to No
and is disabled.

For contract types that are not master agreements, you can set the Allow association to Master
agreement field. When set to Yes, master agreements can be associated to the contract type, and the
Master Agreement tab is shown in the register home page.

Use change orders for th is cont rac t type

You can specify whether change orders are allowed for the contract type. When the Use change orders
for this contract type toggle is set to Yes, vendor change orders can be created in Contract. When set
to No, vendor change order functionality is not available.

Al low changes to ex is t ing l ines

When the contract type uses change orders, you can specify if lines can be updated in a vendor change
order. The Allow changes to existing lines toggle lets you restrict updates to existing lines in a vendor
change order. This prevents users from adjusting existing lines and aligns with the functionality of their
ERP system.

When the field is set to Yes, line items can be edited or deleted from the vendor change order.

When the field is set to No, the Add existing line items option on the Vendor change order line items
tab is disabled, and then all lines added to the vendor change order are Add new line item only. You
can only add new lines to the vendor change order. You cannot add existing lines. Existing lines are not

Page 44 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



editable and cannot be deleted. If the contract is associated to a master agreement, you can add a line
from the master agreement.

It is recommended that when you set the toggle to No, you also set the Maximum contract value
change allowed without a change order to be 0% to ensure that the line item cannot be changed. With
this configuration, every change must be a VCO and must be a new line.

Maximum schedule va lue change al lowed wi thout a change order
(%)

The Maximum schedule value change allowed without a change order (%) field lets you specify the
percent at which the total change across all schedule of values can be updated before a change order
is required. The setting validates both increases and decreases made to the schedule item. When you
set a percentage and make a change that exceeds the threshold, an error shows, and you cannot save
the schedule of values until you are within the threshold.

If you want all changes to require a change order, enter 0 in the field. If you want to allow all changes
without a change order, select the Unlimited check box.

Maximum cont rac t va lue change al lowed wi thout a change order
(%)

The Maximum contract value change allowed without a change order (%) field lets you specify the
percent at which a contract can be updated before a change order is required. The setting validates
deleted lines and both increases and decreases made to the contract. If you want to allow all changes
without a change order, select the Unlimited check box. If you want all changes to require a change
order, enter 0.

Al low overde l ivery on l ine i tems

The Allow overdelivery on line items toggle lets you specify whether the contract allows overdelivery
on a line item by a vendor. When the toggle is set to Yes, vendors can over deliver by a specified
percentage. When the toggle is set to No, vendors cannot overdeliver on line items.

When the Allow overdelivery on line items toggle is set to Yes, you can use the Maximum overdelivery
allowed per line item field to set the percentage of a line item that is allowed for overdelivery for the
organization. The project settings also have a Maximum overdelivery setting. You can select the
Unlimited check box to indicate that any percentage of overdelivery is allowed.

The project-level setting cannot be higher than the organization-level setting. If you change the value
of the organization-level setting to a number lower than the project limit, Contract updates the field in
the project settings for existing projects and contracts that had a limit set higher than the new
organization-level limit. If the organization setting is changed to a number greater than the project
limit, Contract does not update the project setting.
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Al low overpayment on l ine i tems

The Allow overpayment on line items toggle lets you specify whether overpayment of a line item is
allowed. When the toggle is set to Yes, you can overpay on line item by a certain percentage. You can
specify an overpayment percentage, or you can select the Unlimited check box. When the toggle is set
to No, overpayment on a line item is not allowed, and the payment form is not allowed to go through
the approval workflow or be submitted.

When the overpayment exceeds the specified percentage, the payment form cannot go through the
approval workflow or be submitted.

For more information about overpayment tolerance, see Overpayment tolerance.

Use payment c la ims for th is cont rac t type

You can specify whether to allow payment claims functions for the contract type. When this toggle is
set to Yes and the Enable Payment claims toggle on the Payment claim configuration page is also set to
Yes, the payment claims features are available for the contract type. This option is enabled only when
the Use schedule of values for this contract type toggle is set to Yes.

The payment claims functions apply only to contracts created after payment claims are enabled.

Al low accrued amount to exceed l ine i tem

The Allow accrued amount to exceed line item toggle lets you control whether accrual amounts can
exceed the maximum overage allowed per item. When the toggle is set to No, the accrual cannot
exceed the line item value. When the toggle is set to Yes, you can set the maximum overage allowed
per item. You can enter a percentage over the value of the line item, or you can select the Unlimited
check box to allow any amount over the line item value. The default is to allow unlimited overages.

Al low work f low when over budget

The Allow workflow when over budget toggle lets you control whether workflow can be initiated on a
contract type based on budget. When the toggle is set to No and the current value of the contract
exceeds the WBS current budget, an error shows when you try to start the approval process. You
should then check the current value or reach out to the project controller. When the toggle is set to
Yes and the current value of the contract exceeds the WBS current budget, a yellow warning banner
shows at the top of the Budget check tab if there is a loss. You can still start the workflow if the bid
package exceeds the current budget.

Requi red f ie lds

You can enable or disable fields and specify if enabled fields are required or locked for workflow and
purchase orders.
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For each contract header field, you can specify if it is enabled. If a field is enabled, you can specify
whether it is required or locked. The settings for workflow and payment forms work independently.
When a field is required for workflow or a payment form, a value must be entered before you can start
the approval workflow or generate a payment form. Locking a field prevents users from changing
values after the workflow approval or payment form has begun.

Suppor t ing documents requi rements

You can configure placeholders for required document types and subtypes for each contract type. You
can also specify requirements for publishing, workflow, and approvals. The placeholders show on the
contract's Supporting documents page. Document types that are added to a default location are
applicable to newly created items only.
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ClickManage documents to open a list of document types configured for Contract in the Manage
documents dialog box. You can then select the document types you want to require for the contract
type, and then click Add.

For each document type and subtype selected, you can select the locations, such as contracts and
vendor change orders, and whether they are required for workflow or publishing. You can also specify
whether document approval is required before publishing to the associated location.

When a contract of the type is created, Contract automatically adds blank lines for each of the selected
document types and subtypes as placeholders. For more information about adding supporting
documents to a contract, see Supporting documents.

Custom l is t

The Custom list setting lets your organization configure default lists that automatically populate
custom drop-down list fields for projects. The following custom lists are available:

l Contract custom list 1

l Contract custom list 2

l Line item custom list 1

l Line item custom list 2

Page 48 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



You can customize the name of the fields using the Custom labels settings. Use the Active toggle to
indicate whether the list item is active. When the value is active it is available in lists. If it is inactive,
the value is not available for use in future contracts or line items but is maintained where it was
previously used.

Custom lists 1 and 2 are also used in the Custom fields section of the Bid packages Overview page.
When the values are created in the bid packages module, the values are carried to the custom fields
when the bid package is converted to a contract.

After a custom list has been used you cannot delete it from the organization settings unless you delete
it from all line items. You also can inactivate a custom list, so it is not available for future use.

Custom lists set at the organization level are applied to the project level and default to Active.

Divers i ty par t ic ipat ion

The Diversity Participation page lets you define the values available in the applicable diversity
categories drop-down list in the Diversity participation section of the Contract header.

Use theMove up andMove down arrows to set the order of the items in the list.
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VCO ID customizat ion

Contract lets you customize your VCO numbering scheme to ensure consistent numbering.
Configuration settings at the organization and project levels let you specify whether to generate VCO
IDs sequentially, and if so, a prefix and starting number.

You can configure customized IDs using the ID customization configuration list (Organization > Settings
> Configurations > ID customization).

The Generate VCO IDs sequentially settings indicate whether Contract generates numbers sequentially.
When set to No, you can enter any number as the ID when you create the VCO. When set to Yes, you
can specify a prefix and a starting number that Contract uses when it automatically generates the VCO
ID.

The Prefix and Starting number fields are enabled only when the Generate vendor change order IDs
sequentially toggle is set to Yes. The prefix on the VCO is added to the ID in the exact way it is entered
in the field. If you want a space between the prefix and the starting number, you must enter it in Prefix
field. You can edit the starting number until a VCO has been created. After a VCO has been created, the
field is disabled.

The Allow projects to edit settings check box specifies whether you can override the settings at the
project level. When checked, the organization-level settings are the default at the project level, but the
project administrator can override the settings. When the check box is unchecked, the numbering
scheme is enforced at the project level. After you establish a starting number, and the first VCO is
created, you cannot change the starting number at the project level.

Payment c la ims conf igura t ion

The Payment claims configuration lets you enable payment claims functions and establish scheduled
dates.
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Item Description

1 Enable
Payment
claims
toggle

Lets you indicate whether payment claims functions are used at the
organization level. The toggle must be set to Yes if any project needs to use
payment claims. The payment claims functions can be turned off or on by
contract type in the Contract type configuration set up. Payment claims are
enabled only for new contracts created after the feature has been turned on
for a contract type.

2 Push
updates to
existing
projects

Indicates whether all existing project claim date settings are overwritten. If
set to Yes, dates in projects are overwritten. If set to No, the dates are
effective for new projects only.

3 Allow
projects to
add/edit
payment
claim
settings

Lets you indicate whether the organization-level settings can be edited at
the project level. When the box is not selected, fields on the project level
Payment claims configuration page are disabled.

4 Payment
claim due
date

The day of the month the claim is due. This date is used to calculate the
scheduled dates. For example, if you process claims on the 15th day of
each month, set this field to 15.

5 Payment
claim
scheduled
dates

The dates that certain requirements must be met.
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When Push updates to existing projects is selected, the organization settings, project settings,
and the payment claim details are locked and cannot be edited while the values are pushed to
projects. A warning banner shows in the settings and detail pages to indicate that the push
might take several minutes.

Payment c la im scheduled dates

The scheduled dates table lets you set up the timetable for claims. Each line in the table is an event
related to the payment claim date. The value in the Number of days column is the number of days
before (a negative value) or after (a positive value) from the payment claim date that the scheduled
event occurs. For example, if you require a meeting with the vendor five days before the payment
claim date, you could create a scheduled date called Vendor meeting and assign the number of days as
-5. If the certification of the payment claim takes place 12 days after the payment claim, you would set
the Certification date to 12.

You can specify whether each date is active or default. When a date is active (that is, the Active toggle
is set to Yes), it is available in the project, but you cannot edit the name or number of days at the
project level. When it is inactive, you can activate it at the project level and then rename it or change
the number of days. You cannot rename a date or change the number of days in the organization
settings unless the date is set to Active.

When the Default setting is set to Yes, the scheduled time automatically shows in the Payment Claim
Dates section of the Payment claims Details page.

You can configure up to 10 dates The Submission date and the Certification date fields are required,
and you cannot rename them, make them inactive, or change the default.

Tax set t ings

Tax settings help you estimate contract taxes before publishing a contract, so you can include taxes in
budgets and committed costs. This is particularly useful for organizations that use a proxy ERP because
you can estimate taxes without integrating with a third-party product. You can also specify whether
the payment form taxes are calculated based on gross price or net price and whether those taxes are
included in committed costs to InEight Control.

The tax settings at the organization level flow down to the project settings when the tax type's country
code matches the country listed in the project details. The organization can define the following:

l Position

l Tax description
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l Tax type

l ERP Code

l Default percent

l Country code

l Calculate payment form tax (net amount or gross amount)

l Include in committed cost

l Active status

The position indicates the order that the taxes are shown. To change the position of a tax, drag and
drop the line to the new position, and then click Save. The change position is available on all projects.

The tax description is a label that makes the tax recognizable to users. When a tax is referenced, the
tax description is shown in the InEight cloud platform, which matches the tax type or ERP code used in
APIs. The tax description is shown in the total tax information you see when you click the information
icon.

The tax type is used to identify the tax. Tax types must be unique by country code. The tax type values
are especially important in a proxy ERP environment to identify and match the taxes in the response. If
you use an invoice response from OneDrive to overwrite the taxes with a tax type that does not match
the project settings, Contract cannot read, store, or display the tax.

The ERP code is used to send information to the ERP system. If you are an ERP customer, you must
match ERP codes. The Tax type code should be sent in purchase order responses. If you use a Proxy
ERP, this field is ignored. You can set a country code, so the tax is only applicable to projects in a
specific country. You can also indicate whether to calculate the tax on the payment form net amount
(after retention is withheld) or the gross amount (before retention is withheld).

How tax is calculated depends on whether Contract is integrated with an ERP system, whether
Contract Tax Request (Application integration > Other) is configured, and whether the contract has
been published. Prior to publishing or clicking Estimate tax, the line item taxes are always estimated
from project settings. The table below represents how taxes are calculated when the purchase order is
published or Estimate tax is clicked.
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If tax is
calculated in ERP system or proxy ERP Used to figure tax

Unpublished
contract

ERP with Contract: Tax
Request configured

Contract: Tax Request

Unpublished
contract

ERP system without
Contract: Tax Request
configured

Settings

Unpublished
contract

Proxy ERP Settings

Published
contract

ERP system PO response from ERP

Published
contract

Proxy ERP Simulated purchase order response (using
settings)

Payment form
line items

Both Estimated proportionally from PO response

Payment form
details
summary

Both User-entered tax when adding invoice. The tax
fields and tax types are from the project settings

The Include in committed cost toggle specifies whether to include the tax in the Contract and InEight
Control committed value.

Vendor change order respons ib le par ty

You can configure vendor change-order responsible parties for the organization. The responsible
parties configured here populate the Responsible party drop-down list on the VCO record header.

You can delete a responsible party only if the party is not in use by a project. Additions or changes
made at the organization level are for new projects only.

2.0.1 .3 Cont rac t custom labels

Contract has settings that let you customize field names in the application to align with your business
terminology. You can customize the fields in all languages supported in the application.
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You can enter the label text for each of the fields in each language. The custom text replaces the
default text in field names, tab names, messages, templates, and other labels throughout the system.

The Enable custom labels toggle lets you switch between using your custom labels and Contract's
default labels. When switched on, Contract uses the defined labels in all languages. If you have not
defined a label, Contract uses the default text for that field. When switched off, Contract uses the
default labels for all fields in all languages. You can refer to the Contract Custom Labels tab in Project
settings as a legend showing the custom labels and how they are referred to in tags and in the Contract
user interface.

When custom labels enabled at the organization level do not apply to your project, you can switch the
Enable custom labels toggle in the project settings to Off. When custom labels are disabled at the
organization level, they are automatically disabled for all projects.
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2.0.2 Project Settings

To manage a project successfully within Contract, the correct project settings need to be set up before
project initiation. project settings are distinct from organization settings, which are defined by the
administrative level of your organization. The image below shows you the ways you can access project
settings from the Project home landing page.

Some settings defined at the organization level will limit the settings you can define at the
project level

The following steps walk you through how to navigate to project settings.
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Open Pro jec t Set t ings

1. From the InEight cloud platform home page, open theMain menu on the upper left side of the
page.

2. Click on the All projects & organizationsmenu option.
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3. On the Projects tab of the All projects and organizations page, search for the Steel Training Job.

4. Once found, click on the Project Name link of the Steel Training Job.
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l The Project home landing page opens
l To access project settings, you can either select Settings under Project on the left
menu bar, click on the View project settings tile, or click on the second level menu
drop-down list and select Settings

5. Select Settings from the left navigation menu.

InEight Inc.  |  Release 25.9 Page 59 of 378

Contract User Guide



l The Project settings page opens

6. Select the Contract icon on the left side of the page. You can use the expansion arrows to see
the application names.

2.0.2 .4 Pro jec t Set t ings Header

The project settings for Contract are organized into four tabs:

l Bid Packages
l Contracts
l Workflow Assignments
l Contract Templates
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l Configurations
l Contract Custom Labels

2.0.2 .5 Bid Packages Tab

Use Bid Packages?

The first setting under Bid Packages is a toggle switch to control whether Contract will include the Bid
Packages functionality or not. Depending on how your organization runs things, you may or may not
want to use InEight Contract for managing the bid package part of the process.

If there is already a bid package associated with your contract, you cannot turn off the bid package. If
you do, an alert appears to notify you.

InEight Inc.  |  Release 25.9 Page 61 of 378

Contract User Guide



Mi les tones

The second section under Bid Packages is populated by benchmarking milestones. On bid packages,
milestones are used to track your dates and deadlines and report on if you are ahead or behind
schedule.

Milestones set up by your organization at the Organization level are inherited on the Project settings
tab, where you can decide which ones are required to use on bid packages and in what order.
However, you are not able to change milestones to not be required if they were set to Required at the
Organization level. You can add new milestones at the project level.

You can include or not include milestones by selecting and deselecting the Required Yes/No toggle.
You cannot add or delete milestones from the list in Project settings, but milestones can be added in
the Organization settings if you have access.

Item
number Term Definition

1 Selection
column

Use to select a column for changing the position.

2 Position
indicator

Notes the position of the milestone.
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Item
number Term Definition

3 Milestone The name of the milestone.

4 Default
toggle

Indicates whether the milestone is required by default for your
project. Toggles for milestones that are required by the
organization are dimmed, and you cannot change them to
optional.

5 Remove
milestone

Use to remove a milestone. After a milestone is removed, it no
longer appears in the milestone list on the project bid package
Milestone page.

6 Directional
arrows

Move the selected milestone up or down in order.

The Letter of Intent/Award milestone represents selecting the vendor.

Div is ion of respons ib i l i t ies (DOR)

The third section of Bid Packages is Division of responsibilities (DOR). These are roles that will be
available to assign a person to when creating a bid package.

You can remove a role from being needed on a bid package. The drop-down list for that role then does
not appear when creating a new bid package.
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If there is already a responsibility associated with a bid package, you cannot turn off the role. If you do,
an alert appears to notify you.

2.0.2 .6 Cont rac ts Tab

To access Contract-related settings, select the Contracts tab.

Page 64 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



Contract Conf igura t ions

The first section under Contracts is Contract configurations, where you can adjust by contract type if
overdelivery on line items is allowed and what percentage per line item is allowed.

Overdelivery percentage caps are defined at an organizational level. For example, if the cap is
15%, a project can adjust to anything under 15% but cannot have a percentage anything above
15%.

Line I tem Account Set t ings

The second section under Contracts is Line item account settings, where you can toggle if a contract
can be split between multiple WBS codes.
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Del ivery Address

Below is the Delivery address section of this tab. This may be where your project’s materials will be
delivered (either on or off-site), or services will be performed. If your project has multiple job locations,
then enter them all. You must indicate which one will be the default location.

You may use your delivery address as your tax jurisdiction for states that have “point of receipt” taxes.
After the shipping addresses are entered, the team member with the tax-related information can enter
the tax jurisdiction code as needed. The tax jurisdiction code is used to drive how taxes will be
calculated for the project.  

Pro jec t ERP At t r ibutes

One of the purposes of Contract is to input the necessary information to create a purchase order (PO)
in your ERP system. Having a PO is important because without a PO, you cannot pay the vendor.
Typically, your ERP system will have certain required attributes to create a PO. Defining these
attributes in InEight will automate the filling in of those attribute fields in your ERP system for the
project. 
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Valuated vs Non-va luated Good rece ip ts

When using an ERP system, this must match your ERP system.

When your Good receipts are Valuated, the costs will calculate for that GR and quantity and value of
the goods received displayed in the line item tab > Progress view.

Non-Valuated means that no costs are calculated and only the quantity received will display in the line
item view > Progress view.

The table below provides definitions for each of these attributes.

Item
number Term Definition

1 Company
Code

The project legal entity, or the legal name you are doing business
under. It is where profit and loss will be reported. The company code
will populate from the default of the Organizational settings. 

2 Plant The project logistical entity and is tied to the company code. Any plant
associated to that company code will appear in the drop-down list.
Any plant associated to that company code will appear in the drop-
down list.

3 Storage
Location

A subset of Plant, it is the place where the materials are transferred or
delivered. If you are keeping inventory in SAP, it is where your
inventory is stored in the system, and where you can track that plan of
materials.

Once the plant is identified, enter the correct storage location using the drop-down.
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There are some larger jobs which would have more than one storage location. Make sure you list all of
them but indicate the default location.

Not i f ica t ions

The Notifications section of the Contracts tab lets you configure whether notifications for supporting
documents expiration is supported at the project level. The project-level setting functions
independently of the organization-level setting, so the person who works directly with the vendors
gets notification of expiring documents and can renew them on a timely basis. When you enable
notifications, the tab shows fields that let you specify the roles or users to receive notifications, the
number of days to be notified before document expiration, and the frequency of the reminder.
Settings in the document details specify whether the notifications go beyond the expiration date.

Contract Closeout

The final section of the Contracts tab is Contract closeout. This is where you can assign questions to
each closeout section. Any questions added here will be automatically applied to all new contracts.
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To add a question to a close out step, click on the Questions link under the Questions column.

A slide out panel appears on the right. You will be able to see current questions assigned to that step
that can be removed if they have not been used yet. You will also be able to search through current
available questions. A question can be added by clicking the plus button to the left of the question.
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You can delete a closeout section from project settings if it is not applicable and it is not used in any
contract. If the closeout section is used in a contract and the status is Not Applicable, Not started, or
Recalled, you can delete the section. You cannot delete contract closeout sections if they are used in a
contract and the status is Started or Complete.

Closeout sections and questions are added in the Organizational settings.

Contract Closeout permiss ions

Users assigned to complete contract closeouts do not have edit contract permissions. These
permissions are set at the Organization level and the Administrator should be contacted to set these
permissions. These permissions are assigned under Suite administration > Roles and permissions >
Contract.

2.0.2 .7 Cont rac t templa tes tab

The contract templates tab lets you create and maintain contract templates at the project level. You
can also set up the recipients for eSignature via DocuSign.
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Pro jec t and organizat ion templa tes

The Contract template tab in the project settings has headers for Project level templates and
Organization level templates. To create project-level templates, go to the Project level templates tab,
and follow the instructions described in the Organization settings topic.

Contract writer templates added at an organization level are available for projects by default and are
listed in the Project level tab register. Organization-level templates are marked with Organization level
in the Created by column.

To deactivate an organization-level template for a project, use the Project level use column to change
the check mark to a minus, and then click Save.

You can copy an organization-level template to the project level, so you can make changes specific to a
project without affecting the organization-level template. The new project-level template is version 1.
The template details are editable. After the project-level template is published, changes at the
organization level do not affect the project-level template.

2.0.2 .8 Conf igura t ions

Conf igura t ions

Project-level configurations let you customize Contract for your project. To see the configuration
settings, go to project settings, and then select Contract >Configurations. The configurable settings
include the following:
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l Custom list

l Decimal precision

l eSign setup

l ID customization

l Payment claims configuration

l Tax settings

l Vendor change order responsible party

Custom l is t

Custom lists let you create fields with drop-down lists. Values configured for the custom lists
automatically populate project drop-down lists in the specified order. Custom lists are also configured
at the organization level and are applied at the project level by default. You can add values for Contract
custom list 1 and 2 and Line item custom list 1 and 2.

You can select a list item, and then click the up or down arrows to change the value's position in the
drop-down list.

If you do not want to use an organization-level custom list value for a project, you can disable it (that
is, set the Active toggle to No). When you no longer want to use a project-level custom list value you
can deactivate it, or if it has not been used, delete it.

See Organization settings for more information about custom lists.

Decimal prec is ion

You can use the Decimal precision configuration to set the number of digits that follow a decimal point.
The precision decimals are used in contracts, bid packages, line items, and detail pages. Imports and
exports also support decimal precision. All imports and exports can support five digits after the decimal
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regardless of the setting. The fields are stored in the database with five digits after the decimal but are
shown on the UI according to the settings.

Contract writer tag output uses two decimal places.

You can choose separate decimal precision for values, quantities, percentages, and unit price.

You can choose 0-5 digits. If you do not enter a value, Contract uses a default value of 2 for the Values,
Percentages, and Unit price settings and 3 for the Quantities setting.

eSign setup

If your project is integrated with an eSignature provider, you can embed common signees into your
project templates. The eSign setup configuration lets you add the names of up to 10 recipients, along
with their companies, titles, and email addresses that can be used with every contract in the project.
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Each eSign recipient field in the list has a corresponding template tag. You can add the tag to templates
to require the signee's signature. The tags are read when sending the document for signature. The
recipients are also available to add to a document when you send the document for eSignature. See
Contract Writer for information about sending documents for signature. See Template types subtab for
information about using tags in templates.

If you edit the eSign setup, the recipients are available for new contracts only. You can override the
eSign recipients in the eSign section of the Contract header details.

ID Customizat ion

If projects are allowed to edit VCO IDs, that is, the Allow projects to edit settings check box at the
organization level is checked, you can override the organization-level numbering by setting the
Generate vendor change order IDs sequentially toggle to Yes. If set to No, IDs function as free text.

When the Generate vendor change order IDs sequentially toggle is set to Yes, the Allow users to edit
generated IDs toggle is shown, and the Prefix and Starting number fields are enabled. The last active
vendor change order ID number can be reused in the numbering scheme to reduce the number of gaps
when you must delete vendor change orders created in error. When the last vendor change order ID is
deleted, it is reused for the next vendor change order.
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A VCO cannot be deleted or renumbered after it has been executed. For example, you have
vendor change orders are numbered 001, 002, and 003. Vendor change orders and 001 and 003
have been executed, and 002 has not been executed. If you delete change order 002, change
order 003 is not renumbered, and the next vendor change order added would have the ID 004.

You can set the Allow users to edit Generated IDs to Yes to allow users to edit the generated IDs when
creating a VCO or for a VCO that has been generated from InEight Change. When the field is set to No,
you cannot edit the IDs and must use the IDs generated by Contract.

You can edit the starting number field only if a VCO has not been created.

Payment c la ims conf igura t ion

The Payment claims configuration lets you add or edit settings for your project. The fields on this page
are enabled only when the Allow projects to add/edit payment claim settings check box on the
organization-level Payment claims configuration page is selected.

The Allow users to add and remove date fields in a payment claim field indicates whether the dates
shown in the payment claim can be added or removed. When the toggle is set to Yes, you can add
dates or remove the default dates. When the toggle is set to No, you cannot add new dates or remove
default dates.

The Payment claim date due field shows the day of the month the payment claim is due. If the date is
different from the date in the organization settings, the date in the project settings is used.

When the Active toggle for a scheduled date is set to Yes, you can edit all fields. When the Active
toggle for scheduled date is set to No, you cannot edit values unless you switch it to Yes. When the
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Allow users to edit dates in a payment claim toggle is set to Yes, you can add dates or remove the
default dates. When the toggle is set to No, you cannot add new dates or remove the default dates.

See Payment claims configuration for more information about the payment claims settings.

Tax set t ings

Tax settings at the project level are used in conjunction with organization-level tax settings to estimate
contract taxes before publishing a contract. You can use the project settings to add additional taxes to
a project, such as a state or county tax. Taxes entered at the project level are listed before those
configured at the organization level. Project level taxes cannot be deleted if the tax has already been
used. If a tax is no longer applicable, you can deactivate it for future contracts. Marking a tax as
inactive removes the tax type for future contracts estimated taxes, but the tax column remains in any
register where it was listed if any contract on the project was created before the tax type as
deactivated.

Projects can configure the following for taxes:

l Tax description

l Tax type

l ERP code

l Default percent

l Country code

l Calculate payment form tax (net amount or gross amount)

l Include in committed cost

l Active status

Organization-level taxes are shown based on the project's country and tax type country code. They are
marked with the information icon. Organization-level taxes without a country code appear in all
projects. You can activate or inactivate an organization-level tax, edit the default percentage, change
whether to calculate the tax in a payment form based on the net or gross amount, and whether to
include the tax in the committed cost.

The tax description is a label that makes the tax recognizable to users. When a tax is referenced, the
tax description is shown in the InEight cloud platform, which matches the tax type or ERP code used in
APIs.

The tax type is used to identify the tax. Tax types must be unique by country code. The tax type values
are especially important in a proxy ERP environment to identify and match the taxes in the response. If
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you use an invoice response from OneDrive to overwrite the taxes with a tax type that does not match
the project settings, Contract cannot read, store, or display the tax.

The ERP code is used to send information to the ERP system. If you are an ERP customer, you must
match ERP codes. The Tax type code should be sent in purchase order responses. If you use a Proxy
ERP, this field is ignored. You can set a country code, so the tax is only applicable to projects in a
specific country. You can also indicate whether to calculate the tax on the payment form net amount
(after retention is withheld) or the gross amount (before retention is withheld).

How tax is calculated depends on whether Contract is integrated with an ERP system, whether
Contract Tax Request (Application integration > Other) is configured, and whether the contract has
been published. Prior to publishing or clicking Estimate tax, the line item taxes are always estimated
from project settings. The table below represents how taxes are calculated when the purchase order is
published or Estimate tax is clicked.

If tax is
calculated in ERP system or proxy ERP Used to figure tax

Unpublished
contract

ERP with Contract: Tax
Request configured

Contract: Tax Request

Unpublished
contract

ERP system without
Contract: Tax Request
configured

Settings

Unpublished
contract

Proxy ERP Settings

Published
contract

ERP system PO response from ERP

Published
contract

Proxy ERP Simulated purchase order response (using
settings)

Payment form
line items

Both Estimated proportionally from PO response

Payment form
details
summary

Both User-entered tax when adding invoice. The tax
fields and tax types are from the project settings
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Each tax type established here and in the organization settings defaults to include in committed
cost This configuration includes the taxes in the committed cost values in Control.

Vendor change order respons ib le par ty

You can configure vendor change order responsible parties for a project. The responsible parties
configured here populate the Responsible party drop-down list on the VCO record header. Responsible
parties for a project include those added at the organization level.

You can delete a responsible party only if the party is not in use by a project. Additions or changes
made at the organization level are for new projects only.

When a responsible party has been used in your project, but you do not need it for future contracts,
you can deactivate it instead of deleting it. When the Active toggle is set to No, it can no longer be
used in the project.

2.0.2 .9 Cont rac t custom labels tab

To view the default values of custom labels set at the organization level, select the Contract Custom
Labels tab. You can use the read-only display as a reference, so you can see where tag information is
mapped in a contract. When custom labels configured at the organization level are not right for your
project, you can disable them by switching the Enable custom labels toggle to No. When set to No, the
default labels from InEight are used.
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2.0.3 Workflow Assignments

The Workflow Assignments tab in project settings is where you set up approval processes for
approving contracts, vendor change orders, and payment forms. The settings include defining the
number of steps in your approval processes and making assignments of who approves each step. You
can set up the approval process for the following:

l Bid package approval setup
l Contract approval setup
l Vendor change order approval setup
l Payment claim approval setup
l Payment form approval setup
l Document approval setup

2.0.3 .10 Group Workf lows

Large contracts often have varying approvers, which can result in changing the project settings for each
segment of a contract. Configuring approver group workflows provides alternatives in the approval
process, which saves you from manually altering the workflow at the project level each time you
require a segment-specific workflow.

An approver group is a set of users or roles in steps, similar to an entire workflow. You can set up
multiple groups in a single step in a workflow. For example, when a project is done in segments, you
might have a different set of approvers for each segment. Instead of setting up a workflow that applies
to the whole project, you can create a multistep group workflow for each segment. You can have one
or more group steps in a workflow.

You can configure groups from the Group approver setup page (Project > Settings > Contract >
Workflow Assignments > Group approver setup). Each group can act as its own workflow. In the
sample image, a contract has two segments, each with a different field engineer and project engineer.
The business manager is the same for both segments. A business manager only group is set up for a
flow that only needs approval from the business manager, such as resubmitting a previously rejected
payment form. All contracts, VCOs, and payment forms in the project can use the groups.
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When you start the approval process from the contract, VCO, or payment form, you can select the
appropriate group workflow when you click Save and start approval.

Create group work f lows

Use group approval workflows as a single step in a larger workflow. The group workflow contains
users or roles arranged in steps, like the steps used in thresholds. Group workflows let you set up
segment-specific workflows to use when a contract has multiple segments or when only one user or
role has to give an approval (such as a previously rejected payment form).

Only one step in an entire workflow can have a group step.

1. Go to the Group Approver Setup page (Project > Settings > Contract > Workflow
Assignments >Group approver setup).

2. Click the Add group approval button. The Add group approver slide-out panel opens.

3. Enter the group approver name (for example, Segment 1), the step title of the first step (for
example, Field engineer), and the users or roles for that step, and then click Add. The
group and its step is added to the grid.

4. To add another step, click the Add another step link, and then enter the step title and
approvers. Click Add. Repeat this step as necessary to add all steps in a workflow.

You can change the order of the steps by selecting the step and using the up and down arrows. You
can use the group approval as a step when setting up contract, VCO, or payment form approval. Users
who are added to roles associated with active workflows can approve or reject workflow items. They
do not get a workflow notification, but the workflow item is shown in the Action items tab.
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Threshold-based Approva l Setup

Contract gives you the ability to set up value thresholds based on bid package type, contract type, or
vendor change order type at both organization and project levels. Contract uses an approval matrix
where any amount equal to or over the threshold set must be approved. Contract considers currency
exchange rates when initiating the workflow and reviewing the budget. When the workflow is started,
Contract converts workflow values from the project currency to the contract currency to see if the
value is greater than the threshold. For example, if the project currency is US dollars and the contract
currency is euros, Contract uses the conversion rate configured in Project details to convert the euros
to US dollars to determine whether the contract is over the threshold. If the converted value is greater
than or equal to the threshold, workflow begins.

The approval matrix and thresholds are set up under the organization and project settings. Steps that
are set up at the organization level are performed after the steps that are set up at the project level.

Under the organization settings, select Contract >Workflow Assignments, and then choose Bid
package approval setup, Contract approval setup, or Vendor change order approval setup. The
threshold set-up is similar for each tab.

Add a work f low threshold

A threshold is the value at which a bid package, contract, or vendor change order requires an approval.
You can add as many thresholds as required by your organization.

Steps configured at the organization level are performed in all approvals for a contract type. Additional
approval steps can be added at the project and contract levels, with organization-level steps
performed last. Organization and project-level thresholds cascade to every contract. In an individual
contract, you can add additional contract approval steps. These steps are first, regardless of the value
of the contract.

The following steps use contract approval set-up as an example. You can use the same steps for bid
package or vendor change order approval set-up.

1. To add a workflow threshold, select a Contract type, and then select the Add threshold icon to
open the Approval details.
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2. In the slide-out panel, enter the Threshold amount, Approval step title, and the users, roles, or
groups for the Assign approval roles. Click Add to complete. 

3. To add additional approval steps at the threshold, click Add another step.

4. Repeat steps 2 and 3 as needed to add all organization-level steps.

5. Click Save.

You add approval steps at the project level in the same manner from the Workflow assignments page
(Settings > Contract > Workflow Assignments).

In a contract, select theWorkflow Assignments tab. Organization- and project-level thresholds only
display after the contract value has reached the threshold. 
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Click the Add icon to add approval steps to the contract. 

You can edit any approval setup from the organization or project settings area. To edit, select the
Contract type and the step and then click the Edit icon. You can also assign an approver as required by
the organization level when you edit a threshold at the project level. When you edit a project-level
step, the Edit approval slide-out panel includes a view of the organization-level steps at the same
threshold. If the organization-level steps require editing, you can assign a user. All other fields of the
organization steps are read-only. If the organization-level steps do not require editing, the entire step
is read-only.

Organization steps that require editing are marked with a red triangle in the approval details. If there
are no project-level steps, you can assign approvers for the organization-level steps individually.
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Vendor approva l setup

The Vendor Change order workflow design is consistent with the Contract approval workflow.
Mandatory approval sets can be added at the project level using project settings or at an individual
contract level.

Like that of the Contract approval setup, you select the contract type from the left panel and create a
new one or edit an existing one. Assign threshold amounts can contain multiple steps and all steps for
all thresholds are always visible. To add a new step with a new threshold, select the Add another step
button.
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These steps appear as mandatory steps in a contract workflow assignments tab, Vendor change order
subtab for any contract created of the selected contract type. You can add additional contract specific
steps by selecting the plus icon.

All workflow steps added to a specific contract appear before steps added in the project
settings. Approval starts at the first step displayed and continues until all steps have approved.

You can add additional steps where the thresholds can be increased. If a Vendor change order
goes over the top amount, the first approval for first amount needs to be approved, then the
larger amount would be approved next.

Payment Cla im Approva l Setup and Payment Form Approva l
Setup

The Payment claim approval and Payment form approval is set up for each contract type.  Mandatory
approval sets can be added at the organization and project levels or at an individual contract level.

Like the other approval setups, you select the contract type from the left panel and create a new
workflow or edit an existing one. Payment claim or payment form approval steps are performed for all
payment claim or form approvals. There are no thresholds. You can enter as many steps as necessary
for your organization and project. You can assign a user, role, or group to each step.

At the project level, you can set a toggle to allow payment forms to be automatically submitted after
they have been approved.
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Document approva l setup

The Document approval setup lists document types for each contract type instead of thresholds. For a
contract type, you select a document type, and then add approval steps.

Copy a Workf low

When threshold steps are the same within a workflow type (that is, a subtab), you can reduce set-up
time by copying a workflow threshold from one contract type to another. When you copy a threshold,
the amount, steps and step names, and users/roles are duplicated in the new contract type.

You can copy the workflow threshold by clicking a Threshold amount, which includes all the steps in
the threshold, and then clicking the Copy approval icon. You can copy only one threshold at a time. In
the slide-out window, select the Contract type from the Copy approval to contract type drop-down
menu. You make adjust the threshold amount, step title, and approvers. Click the Copy button. The
new approval shows in the list for the contract type.

If a workflow step contains a group workflow, you cannot copy it to a workflow that already has
a group step.

Pro jec t Workf low Page

The project Workflow page enables you to view the details for your workflows for your project. It
collects information of all workflows that have been kicked off from Contract. Includes: Contract,
Payment Form, and Vendor Change Order workflows.​

Access the Workflow page through the Project settings.
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By selecting theWorkflows link, the Workflows screen opens.

Each column item, when selected, opens the details of that item. The Contract ID opens the contract
associated to that workflow type, etc.
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By selecting the items under the Status column, it allows you to view the progress of that payment
form.

The panel on the left of the screen enables you to view the general information on the contract
attached to this workflow. The body of the screen shows the whole life cycle of the workflow. If the
contract had been through workflow more than once, the most recent record is at the top of the
display, followed by the next recent. Each record shows the steps, and the user/role and how many
days each step has taken.

2.0.4 Permissions

Permissions for each role are configured in Suite administration. Refer to the InEight Platform help
topics for more information about roles and permissions.
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2.0.4 .11 Suppor t ing documents permiss ions

If you want a role to be able to add, edit, or delete supporting documents for bid packages and
contracts, you must select the Add supporting documents, Edit supporting documents, and Delete
supporting documents permissions which are nested under the Edit bid packages and Edit contracts
permissions. The check boxes for Add supporting documents and Edit supporting documents are
enabled when the Edit contracts permission is selected. The check box for the Delete supporting
documents permission is enabled only when the Edit supporting documents permission is selected.

2.0.4 .12 Payment c la ims permiss ions

Roles must have the Add payment claim, Edit payment claim, and Delete payment claim permissions to
use the payment claims functions in Contract. User must also have the Approve/Reject payment form
permissions to send a payment claim through the workflow.

2.0.4 .13 eSignature permiss ions

Roles must have the eSignature permission to correct DocuSign documents.

2.0.4 .14 Retent ion re lease permiss ions

Roles must have the Edit retention release permission to create, edit, convert or delete a retention
release invoice.
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CHAPTER 3 — NAV IGAT ION AND
BAS IC TOOLS

The following topics describe how to use the pages and registers in Contract.
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3.0.1 Page Navigation

In the following lesson, you will open the InEight cloud platform to explore the layout and start to
navigate around the application. You will access the platform through your web browser, using the link
provided by your manager or facilitator.

This takes you to the All projects & organizations page, where you can select any project you are
associated with.

If your project is not displayed on the initial screen, you can search by selecting the magnifying glass
icon in the top right corner. This search function will search all terms in all columns.

Navigate to InEight Cont rac t

1. From within the InEight cloud platform, click on the 1st Level Menu located at the top left of the
page. Then Select All projects & Organizations.
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2. Select your project.

l When you select a project, it takes you to the Project home landing page

3. Navigate to the InEight Contract application by selecting the 2nd level menu.
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4. Select Contract > Contracts from the 2nd level menu.

l The Contracts page of the Contract application appears

Once on a page within InEight Contract, you can use the 3rd level menu to toggle between
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Contract modules (Bid package and Contracts).

3.0.1 .1 Pro jec t Home Ti les

The Project home landing page contains Contract-specific shortcut tiles you can click on to navigate to
the appropriate Contract page. These tiles include:

l Bid packages
l Contracts
l Supporting documents

While the project is underway you see the status of all Bid packages, Contracts and Supporting
documents which support your project. 

Bid Packages Ti le

The Bid packages tile contains two key indicators:

l Awarded – Any bid package already associated to a vendor, and is ready to be or already
has been converted into a contract

l Unawarded – Scopes of work you are still processing
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The View icon takes you to the Bid packages page to view all your bid packages.

Contracts T i le

The Contracts tile contains key indicators:

l Executed – Both Parties have signed the contract
l Non-executed – Contract is out for signature or the contract is still being drafted
l In approval – Waiting for signatures on all documents
l Rejected – Contract is rejected (need to expand

The View icon takes you to the Contracts tab of the Contracts page to view all your contracts.

Suppor t ing Documents T i le

The Supporting documents tile contains three key indicators, reflecting the status of your supporting
documents:

l Pending
l Rejected
l Expiring
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The View icon takes you to the Supporting Documents tab of the Contracts page, where you can view
all your supporting documentation.

3.0.1 .2 Regis ter Pages

As discussed in Lesson 1 – InEight Contract Overview, there are two modules of InEight Contract, each
with their own page. Each of these main pages are considered register pages, meaning they consist of
rows and columns like a spreadsheet, to list out several lines of information at once.

Bid Package Page

Cont rac ts Page
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3.0.1 .3 Cont rac t Tools and Navigat ion

Each register page in InEight Contract contains menus and tools to help you navigate and perform key
functions on the page.

Title Description

1 Navigation
Bar

Contains Home, 1st, 2nd, and 3rd level menus.

2 Profile View Notifications and Logout.

3 Tabs Depending on the page (e.g., Contracts page), you will have tabs you can
click on to access pertinent information. 

4 Actions
Menu

Contains key functions you can perform, specific to the page you are on
such as, view import history, run a report, run a query, open an email log,
or launch the InEight Explore Contract dashboard.

5 Toolbar Contains functions for the register page you are currently viewing, with
specific editing options on the left (e.g., add, edit, delete, copy), and
options that involve the entire page on the right, including clear all filters,
search, import and export options, notes, and contract information.  The
Contract register includes the Download purchase order icon on the right
side, which is enabled when you select a contract.

Overview – Contract Register Page Tools and Navigation

Act ions Menu

The Contracts’ Actions menu offers tasks that can be executed at the Contracts page level.  They are:

l View import history
l Query builder
l Run report
l Email log
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l Launch dashboard
l Generate contract document (on Contracts and VCO registers only)

View impor t h is tory

Allows you to see the import history activities for documents which came into Contract. The history
includes the File name, location, status, total number of records, any errors and dates for modification.

Query bui lder

When selected, a new window will open where you can create queries. You can choose from the
Default queries list for Contract or Payment forms/invoices or select Add new query to build a new
one.  You can also access your previous queries which have been saved.

Run repor t

Allows you to run canned reports for Buyout review, Procurement status and Payment form status. 
When a report is selected, it will open in a new tab as shown below.
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Emai l log

From any project you have access to the Email log from the Action menu. When selected, the email log
will open then the support team will search and resend your email. The Email log is at the Organization
level and is meant for your shared services team to find emails which were thought deleted or lost.
Resending the emails, when found, does not restart the workflow.  It is a way to find lost, deleted or
misplaced emails.

Launch dashboard

You can launch the InEight Explore Contract dashboard without leaving the current application. When
you select Launch dashboard, Explore opens in a separate window.

Name Function

1 Project ID ID of the project you want to find.

2 Recipient
email ID

Name of the person who the email was sent to.

3 View email
log for

Selection of timeframe which you want (30 days or custom).

4 Email log The list of emails sent.

5 Resend email Allows the selected emails to be resent to the receivers.

6 Reset
parameters

Allow the parameters to reset to the default setting.

7 Information When selected opens a slide-out panel with information about the email

Overview – Email log
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Name Function

selected. It provides the date, subject, recipient and actual message.

8 Export Allows you to export selected emails.

9 Search Searches log for selected emails.

Overview – Email log (continued)

Toolbar

The toolbar allows you to use functions for the register page displayed, with basic editing functions on
the left and other functions on the right. The toolbar options will change depending on what page you
are currently on. The toolbar displayed below is for the Bid Package page.

Name Function

Bid
Pkg.
Page

Contracts
Page

1 Add Add a new bid package/contract/issue to the register
page.

X X

2 Edit Edit a selected bid package/contract on the register
page.

X X

3 Delete Delete a selected bid package/contract from the
register page.

X X

4 Copy Copy a bid package or contract that already exists. X X

5 Clear all
filters

Clear all filters in the grid table. X X

6 Export Export bid packages and contracts to an Excel X X

Overview - Toolbar
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Name Function

Bid
Pkg.
Page

Contracts
Page

template.

7 Import Import bid packages and contracts from an Excel
template.

X X

8 Notes View the notes for a selected bid package/contract
from the register page. The Notes slide out panel
displays the notes, and for contracts, the supporting
document notes. You can also add a note that will be
stamped with the author, time and date.

X X

9 Info The Info slide out provides information about the
selected item.

X X

10 Search Search all columns for content by the keyword you
enter.

X X

Overview - Toolbar (continued)

3.0 .1 .4 Cont rac t Record Page

From the Bid Package and Contracts register pages, you can drill in on a specific item to open its record
and consume more information. 

Icon Function

1 Breadcrumbs References the record you are on and the path to get there. You can
click on the breadcrumbs to go back to the register page.

2 Actions Menu Contains key functions you can perform, specific to the page you are on
(e.g., view import history or run a report).

3 Tabs Depending on the page, you will have tabs you can click on to access
pertinent information. 
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Icon Function

4 Toolbar Contains functions for the page you are currently viewing, with specific
editing options on the left (e.g., add, edit, delete, copy), and options that
involve the entire page on the right (e.g., search, import and export
options, contract info). 

5 Record
Information

Detailed information pertaining to the record tab you are on. This may be
in organized into a register or individual fields organized into sections.

6 View Menu Filter what appears on your display by selecting default viewsets from
the drop-down list, or by creating your own viewsets. 

3.0.2 Columns

3.0.2 .5 Expand Columns

You can expand a column as needed to see the entire title of that column by using the same method
that you would in Excel. If you hover over the column, you will see that your cursor changes from the
arrow to the width selector.
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The following registers retain the new size if you leave and then come back to the page:

l Bid Packages
l Contract
l Supporting Documents
l Accruals/Receipts
l Back Charges
l Contract > Supporting Documents

3.0.2 .6 Move Columns

You can move a column from one place to another using drag and drop. If there are columns that you
do not use, you can hide and unhide them from the view as needed.

Move Columns

1. On the Contract > Contracts page, click on a column header, hold down the left mouse button
and drag the column to the right. It appears raised with a shadow box.
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l Two black arrows will appear to guide you to the new column location

2. Drop the column header where you want to place the column.

3.0.2 .7 Sor t Columns

You can sort any column by clicking once on the column header.

Sor t Columns

1. To sort a column, click on the column header.

l A yellow up arrow appears on the column header indicating the column is sorted in
ascending order

2. Click the column header again and the column will sort in descending order.
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l The yellow arrow on the column header will now point down

3. Click the column header again to remove the sort.

l The yellow arrow will disappear

3.0.2 .8 F i l te r Columns

You can filter columns to drill in on key information pertaining to your specific needs.
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Fi l te r Columns

1. From the Contracts page of InEight Contract, click the inverted pyramid of the Type column
header.

l Depending on if the column rows are from a validated list, or a free text description,
you will get a drop-down list to filter the columns

l If the rows are from a free text, you will filter by selecting the required operator and
entering a keyword

l If the rows are from a validated list, you will filter by selecting the appropriate check
box

l You can also lock or unlock your filters using the lock buttons
l The operators available for selection are: Contains, Is equal to, Is not equal to, Starts
with, Does not contain, and Ends with

2. Hover over Filter, and a validated list appears.
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3. Select Material contract from the drop-down list, then click Filter.

l The Type column is filtered to Material contract, and the register only displays
contracts of that type

l The filter pyramid icon displays yellow to indicate the column is filtered

4. To clear a filter, click the filter pyramid icon, and then select Clear. To clear all filters, click
the Clear all filters button.
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3.0.3 Custom views

The Bid package, Contracts, Master agreements, and Vendor change order registers support custom
views. You can create custom views so that you can see a subset of columns of your choosing. You can
then save the view to use again or share the view with other users.

Create custom view

Create a custom view when you want to view specific fields on the Bid package register.

1. Use the column chooser to add or delete columns from the current view, and then click Save.

2. Select Save view as from the View menu. The Save view dialog box opens.

3. Enter a unique name for the view, and then click Save.

You can share custom views with other team members.

Share a custom view

You can share custom views with other users, such as team members, so they can view the same
subset of columns to help with collaboration.

The users you are sharing the view with must have the View permission for that project.

1. From a saved custom view, select Share view from the View menu.

2. Enter the names of the users you want to share the view with, and then click Share. The users
receive a notification in their Notifications list.

Your team members can use and save your view.
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Save a v iew created by someone else

When a team member sends you a custom view, you can save it and use as needed...

When a team member has shared a view with you, you receive a notification.

1. Click the Notifications icon in the upper right tool bar to see a list of notifications.

2. Click the notification to open it, and then click the link in the notification. A dialog box opens
prompting you to save the view.

3. Enter a unique name for the view, and then click Save.

3.0.4 Imports and exports

A convenient way to create items, such as bid packages, contracts, and line items, is through
importing. You can also export items to an Excel spreadsheet, so you can edit lines quickly or analyze
data using outside tools.

3.0.4 .9 Impor t data

The import template lets you import data into the register. The template is a Microsoft Excel
spreadsheet with columns to import that correspond to columns on the register.

The first worksheet contains the Instructions for the template, where the legend and guidelines are
located. The guidelines describe the information on the Import template, exporting with data and how
to update or add more information to the existing data.

The second worksheet, Data, is where you enter your data for the import. The columns are color coded
to indicate which columns are system generated, required data, optional data and ignored data. 

When using the template, keep in mind the following:
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l The names of the tabs must not be changed.
l Column names in the Data sheet must not be changed.
l Columns must not be removed or rearranged.

Impor t ing the Template

From the register, select the Import icon to begin the downloading.

The Import data from template opens for you to import and save the template or for you to drop a
completed template to be uploaded. The template is updated frequently, and it is best practice to
download a new template each time you want to import any template.
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After the template has been downloaded, you complete the required areas. Do not change the name
of the spreadsheet tabs.

After you have completed the information in the template, you can import it into Contract.

Impor t data f rom a template

Summary: Import data from a template when you want to add items in bulk.

Considerations: These steps assume that the Microsoft Excel template has been downloaded and
completed according to the template instructions. Because the available fields and their functionality
are frequently updated, it is best practice to download a new template each time you want to import
data.

Quick steps:

1. From the Import data from template window, drag and drop or browse to your template file.

2. If the Import dialog box has a field that lets you indicate calculations, such as whether to update
milestones based on duration or dates, select the applicable option.

3. Click Import.

After you have imported your Excel file, you can correct any errors in the Import history window.  After
you import, the new data shows in the register.

Contract validates the date format based on the person who imports the data. If the date
format does not match the preferences of that person, Contract generates an error in the
import history and removes the date.
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3.0.4 .10 Expor t a templa te wi th data

From the register, select the Export icon, and then selectWith data.

In the exported file, you can use the Data worksheet to update the applicable fields before importing
it.
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CHAPTER 4 — B ID PACKAGES

Bid packages are a scope of work that you intend to put under contract. Usually you create bid
packages after the estimate is complete and the project awarded, and use it to track design,
manufacturing, terms and conditions, and negotiations for long lead items, to follow their progress of
getting them from concept to under contract.
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4.0.1 Bid Package Overview

InEight Contract allows the following seven types of Bid Packages:

1. Buyout Reserve – the amount of the original budget that is being set aside for completion
or additional purchases later. This is typically used when you want to account for all the
costs of your budget, including costs that have not yet been allocated to scopes of work in
other bid packages. You can create a Buyout Reserve bid package to account for your
unallocated costs, allowing all budgeted costs to be included in your reporting.

2. Engineered Equipment – a type of equipment that is engineered to unique specifications
and developed with a vendor or manufacture.

3. Freight – an agreement for shipping by a third party.

4. Permanent Material – for materials which have specifications tied to the prime contract.
These materials are part of the structure or project.

5. Professional Services – agreements for customized, knowledge-based service.

6. Rental Agreement – agreements that define the amount of rent you will pay and the term
during which you are responsible for paying it.

7. Subcontract – a contract for a company or a person to do work for another company as
part of a larger project.

In Contract, you can create contracts for all your work, but it may not be necessary to create bid
packages for some of your contracts, such as professional services and rental agreements.

4.0.1 .1 Overv iew – Bid Packages Page

The bid package ID is automatically assigned after you submit your bid package.
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Title Description

1 View The View drop-down menu lets you specify whether to show all bid
packages in the register or only those in one of the following sets:

l Awarded
l Unawarded
l In approval
l Rejected

You can also create and share custom views.

2 Actions
Menu

View import history; run buyout review, procurement status and payment
form status reports; and launch the InEight Explore Contract dashboard.
The menu appears on all pages of the bid package. The Actions menu also
is available on the Overview, Milestones, and Supporting Document tabs
with the options to run reports or launch the Contract dashboard.

3 Tool Bar Allows you to add, edit, delete, copy, import, export, add notes, access
details and search bid packages.

4 Bid
Package
Register

A list of your bid packages.

Edi t f ie lds f rom the reg is ter

You can edit the following fields from the register:

l Custom lists 1 and 2

l Custom fields 1-10

l Kickoff date

l Project delivery date

l Original base value

l Contingency in estimate

l Un-awarded adjustment

l Escalation in estimate

l Owner change amount

l MIlestone float, date, and duration fields
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When you hover over an editable cell, the borders are highlighted in blue.

When you make a change to any of the editable fields, a blue dot shows to indicate a change that has
not been saved.

When you click Save changes, the edits are saved, and the blue dot is removed.

Edi t f ie lds in bu lk

When you need to make the same change to a free-text field or drop-down list in multiple bid
packages, you can select them all and edit them at the same time.

Edi t f ie lds in bu lk

Edit fields in bulk directly from the Bid packages register.

You can edit free-text fields and drop-down lists only.

1. Select the bid packages you want to edit, and then click the Edit icon. The Bulk edit dialog box
opens.
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2. Select the field and the value. You can select up to five fields.

3. Click Save.

4.0.1 .2 Edi t b id package f ie lds in bu lk

You can edit field values for a single bid package or for multiple bid packages in bulk. Columns that can
be edited in bulk include those with free text or a drop-down list.

Edi t b id package f ie lds in bu lk

When you need to make the same change to multiple bid packages, you can edit them in bulk instead
of updating them individually.

Only bid packages that are not yet approved or converted to a contract can be edited.

1. From the Bid package register, select the bid packages you want to edit, and then click the Edit
icon. The Bulk edit dialog box opens.
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2. Select the field you want to edit from the drop-down list, and then enter the value.

3. If you have additional fields, click the Add icon in the dialog box, and then repeat step 2. You can
add up to five fields.

4. Click Save to update the bid packages.

4.0.2 Bid Package Import Template

A convenient way to create bid packages is through import using the bid package import template. The
bid package template includes the budget and milestone dates for tracking progress of the bid package
and a division of responsibility. 

Milestones are set at the project level, as well as Division of responsibilities and email addresses. In this
template, all columns which are required, and which are optional are indicated. This will enable you to
upload completed bid packages.

You can also export existing bid packages, make changes and reimport the data to append any bid
packages.

For more information about importing and exporting, see Imports and exports.

4.0.2 .3 Impor t data

When using the Bid package import template, keep the following in mind:
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l All calculations are based on calendar days.
l The template supports the date format defined in your user preferences. Contract
validates the dates based on the person who imports the data. If the dates do not match
the preferences of that person, Contract generates an error in the import history and
removes the date.

l The template imports with DOR on project settings.
l Use email addresses for DOR user input.

4.0.2 .4 Updat ing or Appending Exis t ing Bid Packages

New bid packages can be added as new rows to existing data import or through new imports.

l If a bid package ID is provided, that bid package is updated.  If the bid package ID is blank,
the system will generate a new ID.

l Only columns that have been added to the Bid package list are exported. Use the Column
Chooser to update your payout and save before exporting.

l WBS and Specifications are fully overwritten.  For example, if there were four WBS codes
and you wanted to change only one WBS, you still must enter all four WBS codes in the
layout. If there is only one WBS code on the template, the system erases all existing
WBS’s and write this one only.

l When milestones are completed, no updates to the preceding milestones are imported.
l When a column is not in the import layout, existing data is not affected.
l If there is a column with a blank value, Contract erases the existing data or resets to
default data.

4.0.3 Add Bid Package

You can either add a bid package manually or import bid packages from an Excel template, as
described 4.0.2 Bid Package Import Template on page 120.

The following overviews provide key information on the fields you fill out when you create a bid
package manually.

Title Description

1 Description A brief overview which will show in your reports.

Overview - Add Bid Package – Bid Package Details

InEight Inc.  |  Release 25.9 Page 121 of 378

Contract User Guide



Title Description

2 Type Used for grouping bid packages in your reports.

3 Discipline A specialty area for your bid package. The disciplines are pulled from the
master data set up in InEight Platform.

4 Currency The currency of your bid package. If the currency for the bid package is
different from the currency defined in the project details, Contract converts
the project currency to the contract currency when performing a budget
check during the workflow process. If a currency conversion rate has not
been configured, Contract assumes the rate is 1:1.

5 Kickoff date The date you will issue your bid package to bidders or convert it to a
contract.

6 Project
delivery
(Need By)
date

The date you need products delivered or services performed.

7 Package
scope

The overall breadth of your bid package.

8 Risk The liability level of your bid package.

Overview - Add Bid Package – Bid Package Details (continued)
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4.0.3 .5 Overv iew – Add Bid Package - Budget

Title Description

1 Original base
value

The amount from the estimate.

2 Contingency in
estimate

A provision for incidental or unforeseen costs.

3 Escalation in
estimate

Any anticipated increase in the estimate. This
unusually represents the increase from when it
was originally estimated and when buyout
occurs.

4 Un-awarded
adjustment

Any amount from the original estimate which will
not be included now, but that you want to

Overview – Add Bid Package - Budget
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Title Description

contract.

For example, you may want to award only a
portion of the work to a sub now but plan to
award the remaining amount later. By putting
the unawarded amount in this field, you can still
account for the cost even though it is not yet
awarded.

5 Owner change
amount

The amount discussed for an owner change. 

Overview – Add Bid Package - Budget (continued)

Aside from the values associated with WBS code (covered later in this lesson), the values
defined on your bid packages are informational and do not integrate with other applications
until they become contracts.
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4.0.3 .6 Bid Package Header In format ion

When adding a new bid package, once you click Submit, the new bid package opens to the Overview
tab, with summary header information at the top of the page.

You can get to the bid package record page for existing bid packages as well by clicking the bid package
ID or Description from the Bid package register page, as shown below:

Information
Group Description

1 Breadcrumbs Shows your bid package ID and description. Click Bid packages to
return to the bid package register page.

2 Status Shows as New until you add milestones to your bid package. Then, the
status shows the milestone you are currently working to complete.

3 Original base
value

Shows the amount from the estimate you entered when you created the
bid package.

4 Total estimate Shows the sum of the original base value, contingency in estimate,
escalation in estimate, un-awarded adjustment and owner change
amounts.

5 Approval
status

Shows the status of the bid package approval.

6 Bid package
tabs

Overview, Milestones, Supporting Documents, and Workflow
Assignments.

7 Convert to
contract button

Opens and prepopulates the Add contract dialog box. You must have
selected values in the *Type, *Effective date and *Vendor fields. Click
the Add button to convert your bid package into a contract.

Overview – Bid Package Header Information
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Information
Group Description

8 Cancel and
Save buttons

The Cancel button closes your bid package and returns you to the bid
package register. The Save button saves changes you make to your bid
package. The Save and start approval button shows when there is a
workflow step at the organization, project, or bid package level. Click to
save your changes and start the approval process

Overview – Bid Package Header Information (continued)

4.0.4 Overview Tab

Bid packages default to the Overview tab (indicated by a blue underline). There are seven information
groups. Values within the Bid package detail and Budget information groups are auto populated from
information you entered during bid package creation.

Information
Group Description

Bid package
details

Specific attributes that describe and uniquely identify your bid package.

Budget Total estimated cost of the scope of work you intend to put under contract.

Additional
details

A section that includes drop-down subsections for division of responsibilities,
specifications, reporting, and custom fields.

WBS Work Breakdown Structure is a specific element of the scope of work to be
completed. If the project is reimported from inEight Estimate after creation, this
field is blank, and you must manually update it with a newWBS code.

Reference
data

Agreement ID and value fields are retained in the Reference data sections of
the contract after converting a bid package to a contract.
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Information
Group Description

If the Agreement ID or value is updated, similar to the DOR, it will not go
back to the Bid Package and update it there. It only happens when you
are converting from a Bid Package to a Contract.

eSign Lists of eSign recipients, Project contacts, and Division of responsibility names
that default as signees for an eSignature.

(continued)

Reference Data

Agreement and Purchase Order F ie lds Conver ted wi th Bid
Package

When you convert a bid package to a contract, the Agreement ID, Agreement value, Purchase order ID,
and Purchase order value fields in the External purchase agreement section are retained in the
Reference data section of the contract.
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This connection is not maintained beyond conversion. If you manually change these fields after
conversion in either the bid package or contract, the changes are not reflected in both locations.

4.0.4 .7 Create forms or mai l in InEight Document

If a project is associated with Document, you can create a form or mail item from a bid package.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract-to-Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

Creating forms or mail is initiated from the Actions menu. If Actions > Create document > Form
orMail is inactive, you can select the Settings (cogwheel) icon in the Actions menu to set up
integration with Document.
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Create a form in Document

You can create a Client RFI or Request For Information form in Document and add it to the Supporting
documents for the bid package in a single procedure.

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.

Create mai l in Document

You can create a mail item in Document and add it to the Supporting documents for the bid package in
a single procedure.

1. From the Details page go to Actions > Create document >Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.
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3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

l To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document sourceMy computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

l To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

l To send mail without an attachment, click Create. The Mail module in Document opens.
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5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

4.0.4 .8 eSign

The eSign section lets you view or add recipients to be used as default eSign signees. This section has
subsections for eSign, Project contacts, and division of responsibility. All signees must be added to at
least one section.

l Names in the eSign section are populated from the project eSign setup tab (Project settings >
Contract > Configurations >eSign setup). You can also manually enter the names of the signees.

l Names in the Project contacts section are populated with contact information from Project
contacts added in Project details. This section is for reference only. If you want to add or change
recipients, you must edit the Project Contacts.

l Names in the Division of responsibility section are populated with user information defined in
the Division of responsibilities section of the contract details. The company is populated from the
Company legal name in Project details. The title field is always blank. This section is for reference
only. If you want to add or change recipients, you must edit them in the Division of responsibility
section of the Additional details.

4.0.5 Milestones Tab

The Milestones tab displays the Scheduled dates and Milestones for your bid package, organized into
information groups.
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4.0.5 .9 Scheduled Dates In format ion Group

In the Scheduled dates information group, the Kickoff date and Project delivery (Needed by) date are
auto populated from the bid package wizard.

The Project delivery (Needed by) date represents when the material needs to be on site or when the
services need to happen. It is the date you are driving towards for having the contract finalized.

In the Contract delivery (Lead time) (days) field, you can indicate how much lead time you need for the
contract to be delivered, which is subtracted from the Project delivery (Needed by) date to calculate
the Contract target execution date field.
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4.0.5 .10 Mi les tones In format ion Group

In the Milestones information group, you can view the milestones needed to complete the bid
package. Some of these milestones may already exist on the bid package by default if specified in your
project settings (see tip below). Depending on the scope and complexity of the bid package, you may
want to add additional milestones to track the package’s progress effectively. You can tell which
milestones you added manually because you have an option to remove them, by clicking on the
remove icon (minus sign).
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Customer bid package milestones can be added for our organization by your project
administrator under Organization > Settings > Contract > Milestones.

4.0.5 .11 Scheduled Sect ion

For each milestone, there is a Scheduled section, where you can enter each milestone’s duration in
days or completion date. Each milestone has a completion date, set to the bid package’s Kickoff date
by default. Contract calculates the completion date or duration based on the values you enter. For
example, if you enter a duration, Contract calculates the completion date based on the milestone's
duration. If you enter a completion date, Contract calculates the duration based on the date.
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Forecasted Sect ion

Each milestone also contains a Forecasted section to help you predict the actual timeline of the bid
package. Use the Duration (days) or Completion date fields to adjust the Forecasted Completion dates.
The Completion date defaults for each milestone from the Kickoff date. 

The Duration (days) field and Completion date field work in tandem.  Changing the Duration of
any milestone will change its Completion date and vice versa.

The Milestones information group also shows the float for the bid package. You can set the Calculate
float based on field to calculate the float based on the contract target execution date or the project
delivery (Needed by) date. The total available float and the remaining float for the bid package are
shown.

Your float days calculated as the float days from the previous milestone plus the duration days of the
current milestone. The remaining float days are calculated as the difference between the Contract
target execution date and the date of the last forcasted milestone. The Total available float is now
calculated as the remaining float plus the sum of uncompleted scheduled milestone float..
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If you need any lead time for the contract delivery, you can enter this in the Contract delivery (Lead
time) (days) field, and it will subtract it from your float days. In this example, entering two weeks of
lead time lowers the total available float from 15 days to 1 day.

You can allocate your total available float days to your milestones as needed. As you do so, the
Remaining float will deduct the days you have allocated to indicate how many float days you have
remaining. In this example, 1 float day is allocated to the Issued for bid milestone. The date of the
following milestone (Request for Proposal) moves forward a day and the Remaining float changes from
1 to 0.

The following steps walk you through how to add milestones to a bid package and define their
scheduled and forecast completion dates.
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Mi les tone Complet ion

When you enter the actual completion date, the milestone Complete flag is automatically filled in. If
you delete the date, the flag no longer shows as filled in.

In the bid package’s header section, the Status of the bid package will then reflect the next incomplete
Milestone. 

When you create a bid package, a button appears on the top-right of the bid package record, to allow
you to convert the bid package to a contract. You will learn how to convert a bid package to a contract
in the next lesson.

4.0.6 Supporting Documents Tab

On the Bid Package Supporting Documents Tab, you can upload multiple documents such as:

l Blueprints/ drawings
l Project Plans
l Specifications
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l Quantity of Materials
l Sketches
l Timelines for Completion / Schedule
l Background Information
l Information About Potential Delays

Any Document that is relevant to the bid package should be uploaded. The supporting documents can
be a file or a link. You can also upload documents from InEight Document. The Bid packages Supporting
documents register lists all documents associated to the bid package.

Add a Suppor t ing Document

1. From the Supporting documents tab, click the Add supporting document icon, and then select
New Supporting document.

2. Complete the Add Supporting document page information. The Document type field uses the
defined list of document types that are available in Contract. You might have to enter additional
information depending on the document type. For example, if you use the Tax ID document
type, you enter a value in the Tax identification number field.

3. Enter a link to a document, or upload a file you have stored on your local laptop by clicking
Select File, and then selecting a file.

4. Click Add.

Page 138 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.

To download the document to your workstation, click Download file.

4.0.6 .12 Send bid package documents for eSignature v ia
DocuSign

When a project is integrated with DocuSign, you can send a bid package document to DocuSign for an
eSignature.

DocuSign tags can be embedded in a bid package supporting document. The DocuSign tags correspond
to DocuSign recipients configured in the project settings, project contacts, and user information
defined in the Division of responsibility section of the bid package details.

Refer to eSignature support for information about sending documents for eSignature via DocuSign.
Refer to Organization settings for information about using tags.

4.0.7 Workflow Assignments tab

Each bid package is unique and might require various levels of approval. The Workflow Assignments
tab lets you set up the applicable approval steps.
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Conversion to a contract is not dependent on approval. You can still convert the bid package at any
time; however, you cannot publish the purchase order for the contract until the bid package workflow
is approved. Bid packages that require approval are not available in a contract for association from the
Associate a bid package icon until they are fully approved.

Add work f low ass ignments

Set up workflow assignments at the bid package level when there are approval steps specific to the bid
package. Steps added at the bid package level are performed before those at the project level and
organization level.

Workflow steps can be assigned to users, roles, or groups. Groups must be created in the project
settings before they can be added to an approval workflow. Only users or roles that have permission
for approving and rejecting bid packages are shown when setting up the workflow.

1. From any page in a bid package, go to the Workflow Assignments tab.

2. Click the Add approval icon. The Add Approval slide-out panel opens.

3. Enter the step title, and then choose whether the step applies to users, roles, or groups.

4. Enter the name of the user, role, or group.

5. Repeat steps 2-4 as needed.

6. Click Add.

The steps are added to the workflow before the project-level and organization-level steps. The Save
and start approval button is added to the Overview page, and you can start the approval.
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Star t the approva l work f low

Start the approval process when the bid package is ready for final approval.

Approval steps must be configured at the organization, project, or bid package level. If you want to
make changes to the approval steps, you must go to the Workflow Assignments tab to make your
changes. If your organization has chosen to not allow workflow when the bid package is over budget,
an error message shows when you start the approval. See Organization settings for more information
about allowing a bid package type to go to approval when over budget.

1. Go to the Overview tab for a bid package, and then click Save and start approval. The Start
approval dialog box opens to the approval steps page.

2. Review the approval steps as necessary, and then click Next.

3. Review the bid package budget. Contract converts the workflow values from the project
currency to the contract currency to see if you have exceeded budget. If there is no conversion
rate listed in the project details, the conversion rate is assumed to be 1:1. When the bid package
is over budget, a yellow warning banner shows at the top of the Budget check tab, and the loss is
shown in red in the Gain/Loss column.
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4. Choose one of the following:

l If you do not want to add a message and attach supporting documents, click Start. The
approval process starts.

l If you want to add a message or attach supporting documents, click Next. The Add
messages page opens.

5. Choose one of the following;

l If you want to add a message to be included in the workflow email, type and format it, and
then click Next. The Attach supporting documents page opens.

l If you do not want to add a message, click Next. The Attach supporting documents page
opens.

6. Choose one of the following:

l If you want to attach supporting documents, click Next. The Attach supporting documents
page opens.

l If you do not want to attach supporting documents, click Start. The approval process
starts.

7. Select one or more supporting documents from the list of documents.

8. Click Start. The approval process starts.

Page 142 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



The approvers receive a notification of the approval item. If you are an approver, the workflow step is
shown on the Action items tab. When you start the approval process and you are the first approver in
the approval workflow, the first step of the workflow is automatically approved, and continues with
the next step, if applicable. If you are the only step in the approval, you receive a second email
confirming the new issue has been approved.

Users who are added to roles associated with active workflows can approve or reject workflow items.
They do not get a workflow notification, but the workflow item is shown in the Action items tab.

Worklfows that are not completed within 90 days are terminated and automatically removed from the
Action items tab.

When the workflow is complete, Contract sends a completion email to you as the initiator, people who
created the item, and the person who completed the last step.
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CHAPTER 5 — CONTRACT SETUP

The intention of the InEight Contract application is to manage and maintain your contracts. Your
company will still need to create, negotiate and execute a contract outside of the InEight module,
although you may use the Contract Writer tool covered in the previous section to generate the
documentation. Please refer to your legal department for contract negotiation and execution.
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5.0.1 InEight Contract Workflow – Contract Setup

5.0.2 Contract Creation

The InEight Contract application is used to house your contracts after they have been awarded,
negotiated and executed. Within the tool you can manage all your supporting documents (e.g., vendor
insurance, bonding documents, workers compensation, and all executed change orders). By having all
your contracts in one spot, the Reports application within the InEight cloud platform will allow you to
run reports to see what your total project is spending on buyout.

Within the InEight Contract module, you can create a contract in two different ways:

l Convert a bid package to a contract
l Create a contract from scratch using the Contracts page

5.0.2 .1 Create a cont rac t f rom bid package

The following steps walk you through how to convert a bid package to a contract when it is ready to be
awarded. When the bid package is converted, it will initially be empty, ready for you to add pertinent
information.
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Creating a contract from a bid package does not create a live connection between the contract
and the bid package. After a contract is created from a bid package, updates to one do not
produce updates in the other.

Create a cont rac t f rom bid package

Summary: Convert a bid package into a contract after the bid package is awarded, so you can use the
information that already exists for the new contract without having to enter it again.

Considerations: You can convert a bid package that has not gone through the approval workflow;
however, you cannot publish the purchase order for the contract until the bid package workflow is
approved. Bid packages that require approval are not available in a contract for association from the
Associate a bid package icon until they are fully approved.

1. From the Contract > Bid packages page, select a bid package.

2. Click the Convert to contract button located on the top-right portion of the bid package record.
The Add contract or master agreement dialog box opens.

3. Select a contract type from the Type drop-down list, and then enter or select values for all
required fields. You can optionally enter values for nonrequired fields as needed.
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4. Click Add to add the contract. A new contract is created with an automatically assigned contract
number. This number ultimately becomes the purchase order number when the PO is created.
This PO or agreement number remains the same during the life span of the agreement

What's next: Sometimes your vendors might ask for a PO number to get material ordered or to start
the process of supplying material.

5.0.2 .2 Create a cont rac t f rom scratch

During your project, you might identify a specific scope of work that you will need a contract for,
however, due to the nature of the work you will not need to produce a bid package. For example, you
may have rental or service agreements that are simple enough to set up the contract without a bid
package, or perhaps your project is a small infrastructure project that doesn’t require any long-lead
items that have a long buyout process. For instances like this, you will want to create a contract from
scratch.

The following steps walk you through creating a contract from scratch.

Create a cont rac t f rom scratch

Summary: Create a contract from scratch to start a contract from new information.
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Considerations: When you create a contract from scratch it is not associated with a bid package.

1. From the Contracts page, click the Add Contract icon. The Add contract dialog box opens.

2. Complete the following fields:

l Description
l Type
l Subtype (optional)
l Effective Date
l Vendor (optional)
l Storage location
l Scope (optional)
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3. Click Add. The Contract Header tab opens.

5.0.2 .3 Cont rac t tabs

Contract has the following Tabs which contain all the pertinent information for the contract. These
tabs are located along the top of the Contract record page and from left to right as follows:

l Header
l Line Items
l Schedule of values
l Vendor Change Order Log
l Back Charges
l Payment Forms
l Payment Progress
l Supporting Documents
l Workflow Assignments
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l Sync Log
l Contract Closeout

You will need to use the arrows to scroll over to the next header.

If technical field assistant lines are added to the contract, an additional header tab will be
created to house them.

The tabs are ordered based on how often are used; they do not reflect the order of a typical
contract management workflow.

You might need to use the arrows to scroll through all the tabs.

5.0.2 .4 Cont rac ts too lbar

The Contracts page has the Download purchase order, Contract Totals, and Notes icons available on
every tab.

Download purchase order

Click the Download purchase order icon to quickly download the default purchase order template for
the contract type when you are in a contract. If you want to use a purchase order other than the
default, you can use the Contract writer.

You can also download a purchase order directly from the Contract register. When you select a
contract in the register, the Download purchase order icon is enabled.

The organization-level default purchase order is attached in contract approval emails.

Contract to ta ls

Clicking the Contract Totals icon opens a slide-out panel that has a breakdown of your contract’s
totals.
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Tota l tax

The total tax is estimated when you click Estimate Tax in the Vendor or Delivery address field on the
header tab. Click the Information icon to see a break-down of the taxes. Taxes are calculated based on
the tax types and their default percent listed in project settings. When the contract is published, tax
information is updated from the purchase order response.

Manual ad jus tments

The Manual adjustments line lets you quickly see the total amount of updates to the contract that
were made outside of a vendor change order. The total is linked to the Changes drill-down view of the
line items tab, so you can see details of the Manual adjustments value. When you click the link, the
first line item with manual adjustments shows in the Manual adjustments table.
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Contract Invo ices

The Contract invoices section shows the state of all contract invoices in the system to gain visibility into
the processing of invoices. The section shows the amount and percentage of invoices in the contract
that have been assigned or submitted and what is remaining. The section is color-coded as follows to
give you a visual status of the contract invoices:

l Orange = Invoices assigned to the contract but not assigned to a payment form
l Yellow = Invoices assigned to a payment form in any status other than submitted
l Green = Invoices that have been submitted
l White = The contract total minus the submitted invoices

Click the Contract invoices link to go directly to the Payment Forms tab if your organization uses
payment forms or the Payment Progress tab if your organization does not use payment forms.

Reta ined to date ca lcu la t ion

In the Contract summary push panel, the Retained to date field calculation is Actual retained +
Remaining new retention value. This calculation considers what is already paid and new amounts even
if the retention rate is changed. If you make any changes on any retention line item It will calculate
only what is left on the line item.
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Notes

You can click the Notes icon to view the Notes slide out panel, which displays the contract’s notes and
supporting document notes. You can add notes in the bottom section, which will be stamped with the
author, time and date. It is important to remember that these notes, once entered, become a part of
the legal document and cannot be deleted.

5.0.2 .5 Send a cont rac t for approva l

To submit a contract for approval, click Save and start approval. If you have set up group workflows,
select the applicable group for the contract. For example, if you are starting the approval process for
Segment 1 of the project, select the Segment 1 group.
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5.0.3 Header Tab

The Header Tab contains the following sections for capturing key contract information:

l Details
l Diversity participation
l Contract terms
l eSign
l Additional details
l Reference data
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5.0.3 .6 Cont rac t deta i ls

The Details section of the Header tab shows basic information about the contract

Field/Section Function

1 Contract status Drop-down of statuses you can change manually to track the
progression of the contract. Contract must be in Executed status to
publish a PO to the ERP system

Changing the contract status to Executed is the action that
triggers the compliance review of supporting documents. Once
the supporting documents are approved by Compliance, the
Create Purchase Order button becomes active.

2 Description Free text entry; Brief overview of the contract which will display in
reports. The description can be edited as needed.

Page 156 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



Field/Section Function

3 Type Drop-down denoting the kind of contract. Different contract types map
to different PO types in ERP system.

4 Subtype An additional drop-down to further categorize contract type.

5 Effective date Beginning date of the contract, the date in which both parties have
signed the agreement.

6 Vendor Drop-down menu of all vendors set up in ERP system. You can click
the Advanced vendor search icon at the bottom of the list to see the
Select vendor dialog box that shows more vendor details and has its
own search function.

7 Payment term Drop-down menu to indicate terms of payment for the contract. Only
payment terms marked as Available in the Master data library are
shown in the drop-down menu.

8 Contract
currency

Drop-down menu; currency in which the vendor will be paid. If there is
no vendor or if the vendor does not have a currency assigned to their
record in the master data library, the field has a drop-down menu, so
you can select the contract currency. A warning icon is shown when
the selected Contract currency does not have an exchange rate set up
in the Project details, and a yellow warning banner shows at the top of
the page.

9 Delivery
address

Drop-down menu; Location where materials are delivered, or services
are performed.
Note: Delivery addresses can be added or modified in project settings
with proper permissions.

10 Storage
location

ERP entity for tracking materials within the ERP system.

11 Incoterms International commercial terms that specify which party is responsible
for material while in shipment to destination. Only Incoterms marked as
Available in the Master data library are shown in the drop-down menu.

12 Incoterm
location

Names the destination for Incoterms.

13 Country of
origin

The country where the project is being built.

InEight Inc.  |  Release 25.9 Page 157 of 378

Contract User Guide



Field/Section Function

14 Discipline Drop-down menu to indicate the discipline category the contract falls
under.

15 Two-way
match

Allows for paying invoices without formal goods receipts; typically used
for progress payments.

16 Scope of
contract

Free text entry field to provide more information on the contract’s
scope. You can use the Expand icon to expand the text box for easy
text entry and viewing. You can then collapse the text box when you
are finished.

Following are additional details about the header tab.

Contract Sta tus

The Contract status field is a drop-down that allows you to select the status of your contract.

The table below lists the status options available to select from.

Field/Section Function

Draft The contract is still being created.

In review Contract is following the workflow for approval.

Out for vendor
signature

Contract is with the sub or vendor for signature.
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Field/Section Function

Out for internal
signature

Contract has been signed by vendor of subcontractor and is now routed
for internal signatures.

Executed Contract has been signed by both parties.

Terminated Removed vendor or supplier off site.

Cancelled Contract has been cancelled or never got executed.

Closed Contract has been completed and closed out.

Descr ip t ion

Description is a free text field where you can enter the information to describe what the contract is for
(e.g., Steel – Supply and Install).

Type

The contract type will already be populated from when the user added a new contract.

Contract Subtype

Created to further categorize contracts, subtypes which can be added to each contract type in your
organization settings. Configure your organization settings by first creating a new subtype and then
associate it to an existing contract type.
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From the Organizational settings, select Contract > Contracts > Settings.

Go to Contract configurations, then select the settings icon under Contract type name.
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In the Subtype configurations slide out panel, select the subtypes tab.

To add a subtype, click in the new field under the Subtype name. Type in the name of your new
subtype, then click on the Add     icon to add to your list.  Then click Save.  The new subtype can now
be added to any contract type.

Ef fec t ive Date

The effective date is when your contract has been executed and becomes an official legal document.
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Vendor

The Vendor drop-down list shows all vendors that you have set up in the system. After they are added
to your vendor database under Master data libraries, you can search for them by vendor number or by
company name.

It is important to make sure you have the correct vendor tied to this contract as it will determine who
gets paid from your ERP system. If you are using a schedule of values, and the Hide in plan and
progress check box for a schedule item is not selected, changes made to the vendor on this page are
automatically updated in InEight Plan.

The Estimate Tax calculator for this field lets you estimate the tax for the contract line items. Prior to
publishing a contract, if you click Estimate tax, taxes are calculated based on the tax types and their
default percent listed in project settings. The estimated taxes are shown in the contract's line items
and the contract totals. When the contract is published, tax information is updated from the Purchase
order response.

Payment Term

Your payment terms are what you and the vendor or subcontractor agree on during contract
negotiations. From the drop-down list, you can select from several different options that InEight
Contract pushes to the ERP system. Once you have set these and executed the contract, it is difficult to
change afterwards.
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Only payment terms marked as Available in the Master data library are shown in the drop-down menu.

Contract Currency

You will need to select the correct currency for payment to the vendor. This should be determined
during contract negotiations and discussed with your business team to make sure you are able to pay
the vendor with the agreed upon currency prior to contract execution. If a vendor has not been
selected, the currency of the contract is used.
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Del ivery Address / Storage Locat ion

The delivery address will be set up during your project initiation. For instances where you want the
material to be delivered to a yard or a storage facility, or a subcontractor to show up to perform work
at an identified onsite location, you will have the option of picking that address.

The Estimate Tax calculator for this field lets you estimate the tax for the contract line items. Prior to
publishing a contract, if you click Estimate tax, taxes are calculated based on the tax types and their
default percent listed in project settings. The estimated taxes are shown in the contract's line items
and the contract totals. When the contract is published, tax information is updated from the Purchase
order response.

Incoterms

Incoterms indicate who is responsible for the material during shipment to the jobsite or the storage
location. This will default into the Vendor Master Record as terms for the materials to be shipped.

Only Incoterms marked as Available in the Master data library are shown in the drop-down menu.

Count ry of or ig in

A pull-down with a selection of countries where the project is located.
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Two-way match

The two-way match function in the contract module allows you to set a predetermined plan to pay a
vendor. This plan is paid against a set schedule, such as completion milestones or progress payments.

If Yes is selected, the ability to create goods receipts against the purchase order and denotes the goods
receipt as not applicable for all line items is disabled. When the purchase order is published, the ERP
system can be mapped to create an invoice plan.

If you do not know if your contract will have an invoice plan, the best practice is to leave the setting
selected to No. Otherwise, if you select Yes and then determine that an invoice plan is not correct after
the contract has been pushed to the ERP system, the ERP system does not allow you to make this
correction; a new contract must be drafted. 

Use the toggle to set Two-way match feature to Yes or No.

Disc ip l ine

The discipline pull-down list will provide the type of discipline categories you can choose for your
contract. The disciplines are pulled from the master data set up in InEight Platform.
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Scope of cont rac t

Free text area where you can indicate the scope of your contract.

5.0.3 .7 Divers i ty par t ic ipat ion

Diversity participation is required on certain contracts and can be federally regulated. Diversity
participation can include, but is not limited to

l Disadvantaged Business Enterprise (DBE)
l Minority and Women Owned Business Enterprise (MWBE)
l Service Disabled Veteran Owned Business Program (SDVOB)
l On-the-Job Supportive Services Programs (OJT/SS)

The following steps walk you through how to add diversity participation to your contract.

Add Divers i ty Par t ic ipat ion

Summary: Add diversity participation information, so you can track the diversity participation in the
project.
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Considerations: The percentage and value of the diversity participation can be tracked at an individual
line item level. This allows lines that do not count toward diversity participation to be excluded from
reporting.

1. From the Header tab, expand the Diversity participation section, and then set the toggle
Diversity Participation to Yes.

2. Select an Applicable Diversity Category.

To add multiple Diversity Participation Categories, click the Add Category Icon as many times as
needed.

3. Optionally enter the goal percentage represented by the vendor. You can have multiple diversity
participation categories on a contract, each with their own percentage. The sum of the
percentages does not have to equal 100%. The field is used for tracking and reporting purposes
only. It is not validated against the line items diversity participation fields.

5.0.3 .8 Cont rac t terms

The Contract terms section of the Header tab includes free-text fields where you write the language
which is in the physical contract document, such as inclusions, exclusions, warranty information and
other contract terms. You can expand the View details section for easy text entry and viewing. You can
collapse the section when you are finished.
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Some contracts have paragraphs for inclusions that list all the items that are included in the contract. A
contract manager would write in that field and then use the tag for inclusions in Contract writer to
generate the Microsoft Word document.

If you are not generating the Word document from Contract, you can use the field to write what is
included and then use that field for reference, so you do not have to open the scanned contract to
read.
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5.0.3 .9 eSign sect ion

The eSign section of the Header tab lets you view or add recipients to be used as default eSign signees.
This section has subsections for eSign, Project contacts, and division of responsibility. All signees must
be added to at least one section.

InEight Inc.  |  Release 25.9 Page 169 of 378

Contract User Guide



l Names in the eSign section are populated from the project eSign setup tab (Project settings >
Contract > Configrations > eSign setup). You can also manually enter the names of the signees.

l Names in the Project contacts section are populated with contact information from Project
contacts added in Project details. This section is for reference only. If you want to add or change
recipients, you must edit the Project Contacts.

l Names in the Division of responsibility section are populated with user information defined in
the Division of responsibilities section of the contract details. The company is populated from the
Company legal name in Project details. The title field is always blank. This section is for reference
only. If you want to add or change recipients, you must edit them in the Division of responsibility
section of the Additional details.

5.0.3 .10 Addi t iona l deta i ls

The Additional details section of the Header tab includes expandable sections for detailed contract
information.

Field/Section Function

Associate a bid
package

Prompts a window containing a list of all unassociated bid packages in the
project. This feature allows you to associate a bid package to the contract
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Field/Section Function

after creating the contract.

Bid Package
budget

Generates a quick look on where production is from the budget.

Division of
Responsibilities

Comes over from Bid package when converting.

Vendor contact The project assigned contacts associated to the contract vendor, or you
can enter any name in this field.

Retention Amount entered will pre-populate each line item for hold back during
invoice payment.

Liquidated
damages

Free text entry in terms of percentage or $ value. Maximum allowed
liquidated damages per the contract.

Technical field
assistance

Select Yes or No to specify vendor or supplier to provide  on-site
commissioning or training.

Reporting
(Switch)

Allows some contracts to be omitted from standard reporting. Typically
used for low risk contracts which don’t require high visibility.

Custom fields Fields you can use for entering information that is not covered on the tab.

Bid Package Budget

Gives you a glance overview of the budget running against the bid package associated to your contract.
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Div is ion of Respons ib i l i t ies (DOR)

These are roles that will be available to assign a person to when creating a bid package in Project
Settings.
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You can remove a role from being needed on a bid package. The drop-down for that role will then not
appear when creating a new bid package.

Vendor contact

Vendor contacts are defined in the project Assigned contacts associated with the contract vendor. Use
the Vendor contact section to select a contact to be the primary contact for the contract.

If there are no contacts defined for the vendor, the list is empty and you cannot add a contact. If a
vendor is changed or removed from the contract, the contact is removed.

Retent ion

Retention is the amount of money that is held back from each invoice until the contract is complete. A
contractor will always want to retain (hold back) a certain percentage of each invoice, as it ensures
that the vendor or subcontractor will continue to work until their scope is complete. In some cases,
retention will be waived. This typically happens when the relationship between vendor and contractor
is strong. In some cases, you will want to waive the retention; this is a case by case decision your
company would make.
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The amount of retention appears on each line item in the contract but is editable to suit those lines
which should not have retention. 

Tax Jur isd ic t ions

All organizations do not require a notification with a tax jurisdiction, selecting the Tax Jurisdiction
notification has a toggle On or Off. These are for clients which do not have a tax system. Access this
toggle from the Organization settings > Contract > Notifications.

Page 174 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



Liqu idated Damages

Liquidated Damages will occur when your vendor or subcontractor fails to meet milestones, material
delivery dates and other specific dates that have been agreed on in the terms and conditions in the
executed document. Many times, this will result in financial compensation. 
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Technica l F ie ld Ass is tance

Technical Field Assistance is used when your contracted vendor or supplier is specified in the contract
to provide field personnel for on-site commissioning or training. When a contract has technical field
assistance written into the vendor contract, those specifics can be added to the Technical field
assistance section in the Header tab. You can enter the Description, Contracted Quantity, Unit of
Measure, Unit Price, and comments for the purposes of tracking assistance from the Vendor. All this
information must be a part of the signed executed contract with the Vendor or subcontractor. 
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Adding this to your contract will give you the capability to track your budget for your technical field
assistance. This helps as a tracking tool to reduce overruns.

Repor t ing (Swi tch)

The reporting toggle allows you to include or exclude each contract from reporting functions. Toggle
the button to “Yes” if you want this contract to show up in reports, (e.g., Buyout Log, Procurement
Status Report).
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5.0.3 .11 Reference data

The Reference data section of the Header tab includes data generated by agreements and purchase
orders generated under the contract. These values can be entered manually or be received from a
JSON PO response from your ERP system. If the values received from your ERP system are different,
they will be updated in the Header tab. If values are blank in your ERP system, those fields will not be
updated in Contract. These fields are also available as columns in the Contracts list.
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When you copy a contract with an inactive vendor, the Agreement ID field still has the master
agreement ID, but the field is treated as a free-text field for reference; the contract is not actually
associated to the master agreement. If you activate the vendor, you must manually associate the
master agreement to the contract.

5.0.3 .12 Impor t a cont rac t templa te

If you have contract details already established on a spreadsheet and want to import this data into
Contract, Contract enables you to import that data into the program. Select the Import icon to begin
the process of importing this data.

On the top right of the screen is the Import icon. When selected, it will open the download the Import
data from template screen. You can import a template to complete or drag and drop your existing
template for importing back into Contract.
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The following data will have values will be populated automatically.

For Contract Line import template, the following data will have their values populated:

l Currency
l Pay terms
l Inco terms
l Discipline
l SubType
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l Contract type
l Storage location

After the spreadsheet is completed, save and drag it onto the to import it into Contract. The contract
description is limited to 100 characters. If the description exceeds 100 characters, an error is shown in
the import pending area of the import history.

Contract validates the dates based on the person who imports the data. If the dates do not
match the preferences of that person, Contract generates an error in the import history and
removes the date.

Contract automatically generates an email with the import results. The email contains a link to view
the Import History window where you can remove or fix the errors. To filter errors, click the Errors link
at the bottom of the page. A filtered error page shows the remaining errors.

No records are imported if there are any errors in the file.

5.0.3 .13 Create forms or mai l in InEight Document

If a project is associated with Document, you can create a form or mail item from a contract.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract-to-Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
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sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

Creating forms or mail is initiated from the Actions menu. If Actions > Create document > Form
orMail is inactive, you can select the Settings (cogwheel) icon in the Actions menu to set up
integration with Document.

Create a form in Document

You can create a Client RFI or Request For Information form in Document and add it to the Supporting
documents for the contract in a single procedure.

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.
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Create mai l in Document

You can create a mail item in Document and add it to the Supporting documents for the contract in a
single procedure.

1. From the Details page go to Actions > Create document >Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

l To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document sourceMy computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.
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l To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

l To send mail without an attachment, click Create. The Mail module in Document opens.

5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

5.0.4 Line Items Tab

The Line Items tab displays the line items that you will pay against in the ERP system, including
information about budget and commitment, schedule of values, change orders, payment progress,
payment forms, and accruals and receipts.

Line items are pay items for the contract. These can be materials, services, or credits. Material, Service,
and Credit lines each have a description, product category, quantity, unit of measure, value, WBS
phase code and general ledger account.  Additionally, line items may contain delivery schedules,
retention, tax amounts, equipment details, batch characteristics and comments as needed. 

Each line item on the contract needs to be added within the Contracts module, and these will become
the line items on the associated PO once the contract is pushed to an ERP system for PO creation. The
Line item details page includes sections for you to enter all relevant information for the line item. You
can add line items individually or import them via the import template.

5.0.4 .14 L ine i tems reg is ter

The Line items register lists all line items for the contract. The line items grid contains sections that let
you see related columns concurrently. The Line items sections include Details, Budget and
Commitment, Change Orders, Progress, Payment Forms, and Accruals/Receipts.

If the Change orders, Payment forms, or Schedule of values features are not enabled in the Contract
type configuration in the organization settings (Settings > Contract > Configurations > Contract type
configuration setup), the corresponding sections are not shown on the Line items tab.
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Items with errors show a yellow exclamation point indicator. You can hover over the indicator to see
the error. You can then click the Line item ID to edit the field.

The bottom of the grid shows the number of items in the grid, the number of items selected, and the
number of errors. To see only the selected items, click View selected. Click Clear selection to deselect
all items. You can click the number of errors to see all items with errors.

Many fields in the Details section are editable from the register, so you can quickly update a value
without opening the Edit details panel. Editable fields are highlighted in blue when you hover over
them.

Dr i l l -down views

Some of the views contain links that take you to a detailed page view for additional information.
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The Progress, Payment forms, and Change views let you export data to a Microsoft Excel spreadsheet
to give you easier access to data. Exporting to an Excel spreadsheet can help you scroll quickly through
data when you are looking for discrepancies.

To export data, select an item from the drill-down view, and then click the Export icon. The data is
exported to an Excel spreadsheet.

If there are multiple grids in the drill-down view, the Excel spreadsheet shows the data on separate
tabs.

Line i tems column management

The Line items register uses sections to group data. You can expand or collapse the columns and the
column selector builder to choose the information you want to see.

The first section of the grid contains identifying information, including the line item ID, type, material
ID, and description. The columns in the first section are stationary and cannot be collapsed. You can
expand the columns until the section takes half of the screen area. After you have reached the
maximum expansion, the scroll bar shows at the bottom of the section.
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You can click the arrow in the column header of the other sections to expand or collapse that section.
The Collapse icon for each section is floating, so it is always visible as you scroll. You can manually size
columns, so you can see the information you want. To collapse all collapsible sections, click the double
arrow in the first section.

The column management feature lets you rearrange grid sections, add or remove columns within the
sections, and remove sections if they are not needed. Click theManage columns icon in the toolbar to
open the Column Selector Builder dialog box.

The Available columns section shows all columns that are available for each section. To add a section
or column, select it, and then move it to the Selected Columns section. To remove a section or column,
select it, and then move it to the Available columns section. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot move columns between grid sections, except in the following
instances:
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l The Type, Material ID, and Description columns can be moved from the first section to the
Details section.

l Any columns from the Details section can be moved to the first section.

Click Save to apply the changes. The changes are saved for as long as you are on the Line items page.
To save the column arrangement as a view, expand the View drop-down menu, and then select Save
view as.

When you open the Line items register, only the Details and Budget and commitment tabs show. You
can add other sections and columns as needed. After you have added the sections or columns they
remain in the view until they are removed, or you reset the defaults in the Column Selector Builder
dialog box.

5.0.4 .15 Add or ed i t l ine i tems

You can use icons on the Line items register to add new line items or edit existing line items.

To add a line item, click the New line icon, and then select New line. See 5.0.4.17 Line items from
master agreements on page 198 for information about the From master agreement option to add
lines.

To edit a line item, select it and then click the Edit line item icon.

When you add a new line or edit a line, the Add or Edit line item slide-out panel opens. The panel
shows a condensed view of the Line item Details page.

You can also add a line by copying an existing line. To copy a line in the Line items register, select the
line and then click the Copy icon. Select Line item to copy to the register and assign a line number. You
can then edit the line item is needed. If the schedule of values is enabled for the contract, you can copy
a line item to the Schedule of values page. See Schedule of values tab for information about copying a
line item to the schedule of values.

Save

After you have filled out the Line item details page, save it.  There are several options for saving:
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l Save - will save and take you back to the Line Items tab
l Save and new - will save and then take you into a new blank Line item details page to start
a new line item

l Save and create delivery schedule – will save and take you to the schedule delivery page

5.0.4 .16 L ine i tem deta i ls

When you add a new line item, the Line item details slide-out panel opens, where you can fill in the
pertinent information for the line item. If you prefer to work with a full screen, you can click the View
full page icon at the bottom of the slide-out panel to show the full page view.

The Line item details page is organized in sections to group like information.

Line i tem deta i ls sect ion

The Line item details section of the Line item details page contains the basic details for the line item.

The Line type allows you to select what type of line this will be paid on. There are four different line
items to pick from:
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l Material
l Service
l Limit
l Credit (this would be used when there is a deposit or an expected refund)

When working with multiple line items you can Jump between line items navigation, details,
status for open and close a line item by selecting the downward arrow.

Mater ia l Type

When using Material ID numbers, companies use these 11-digit numbers to represent something
which is purchased, sold or rented. These companies mandate the usage of these numbers because of
their business processes. Other companies decide not to use the numbers and want to use free text. 
This is so they don’t have to search for the 11-digit number to represent what was used.

Page 190 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



If your organization uses a material master that has material attributes, the Long description field in
the Line item details is disabled, regardless of the Long description field configuration in the
Organization settings. You must click the Assign material attributes icon to add attributes that will
populate the long description.

The Product category field holds the 8-digit UNSPSC (United Nations Standard Products and Services
Code). These codes are universal and no longer the hierarchy. Your Materials Master will be brought in
automatically for you if you use it.  If you do not use a Materials Master, then you need to go and find
a UNSPSC or product category. If you cannot find the code, you can search using the advanced material
search.
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Serv ice Type

When Service is selected from Type, you will notice only one difference from Material.  You will lose
the Material Master ID within this tool. The Service type most likely acts differently in your ERP system,
so you will receive that differently in your ERP system as well.

Limi t Type

Limit lines are a special line type that do not have a quantity or unit of measure, but that you know you
will be paying for. Limit line items allow you to specify a lower dollar value and an upper dollar value
for the line item. The upper limit represents the most you would pay for that line item, and is the
amount calculated into contract totals. This can be helpful for items such as freight, which may be
spread over multiple invoices and do not have a quantity associated with it, but that you can specify an
upper and a lower dollar amount for that the total cost needs to fall between. If it falls within those
parameters, you will pay the invoice.

Credi t Type

Sometimes you may need to reduce the scope of your contract and add a credit line to reduce the
contract amount accordingly. For these instances, you would use the Credit line item type. Credit line
items contain the same fields as material line items, but any pricing you enter will automatically be a
negative (credit) value.

For example, when you enter 100 cubic yards at a unit price of $10, the system will display the unit
price as ($10.00) and the total price as ($1,000.00).

Credit lines reduce the total overall value of your contract. This is different than back charges,
which allow you to maintain your total contract value and just short pay the invoice. See Back
Charges for more information about back charges in a contract.

Val id i ty

Valid from and Valid through is the time frame when that line item is in effect. Think of Valid from as
your delivery date or first date of service. You can leave the end date blank unless there is a date
where claiming against this line item must no longer occur. 
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After the date entered in the Valid through field has passed, the line item is automatically set to
Closed. When the contract is already published and the line item closes, the Line Item ID field shows
the Revised line item icon. If you do not want the line item status to be Closed, you can manually
change the status and extend the Valid through date to a future date. Closed line items cannot be
added to vendor change orders or payment forms.

Agreement i tem ID

If the contract is associated to a master agreement, you can use the Agreement item ID field to
associate an unpublished line item to the master agreement. See Line items from master agreements
for more information about associating an existing line item to a master agreement.

Quant i ty & pr ic ing sect ion

Under Quantity & pricing, you can enter your quantity, unit of measure, and price for the line item and
then click Estimate tax. When it comes back, you get a response when the fields are completed. That is
when the tax is calculated, because the tax component lives outside of your ERP system, but Contract
must retrieve that tax information from your ERP system prior to calculating. If the organization has
been configured to Allow edits to Is taxable field (organization Settings > Contract > Configurations >
Line item type configuration), the Is taxable check box shows above the pricing summary for the line
item. This check box defaults to selected. The taxes for the line are estimated either from project
settings or from a third-party integration. When the Is taxable box is not selected, no taxes are
estimated from project settings. Any tax information that is provided in the Tax request response,
purchase order response, or manually uploaded via LogicApps file are shown regardless of the Is
taxable check box and are considered when calculating taxes on payment form line item.

Click the Information icon to see estimated tax information based on the project settings.
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Account ass ignment deta i ls sect ion

Account Ass ignment Deta i ls

Assignments encompass the WBS and Cost Centers giving you the flexibility to assign contract line
items to different account assignments. This gives the project flexibility to be able to assign line items
to a WBS as well as a cost center within the ERP system based on the project specific requirements.

WBS Category

For WBS Category, the selections available to choose from are Permanent, Consumables and Rentals.
You need to pick the appropriate drop-down for that line item.

Whatever is selected for the WBS category, it triggers the General Ledger Account and the type of
materials. You must have the category selected because it controls your ERP system’s GL and taxability.
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Once a Purchase Order (PO) is created, you cannot change the vendor or the line type because
these become hard coded. If mistakes were made, you must create another line item and delete
the wrong one.

Account Dis t r ibut ion

When Account distribution is selected as “Single” all your costs for that line item will be tied to one
WBS code.

A Split by drop-down appears with the option to split your costs by Quantity, Percentage or Value.
Once you have that determined, you can split as needed between multiple WBS elements in the boxes
below. You can also add as many WBS items to that line item as needed.
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Cost Center

Cost center adds an account assignment type to complement the existing WBS type. Some projects
need to be charged to a different type of an account that does not integrate with Control but does
integrate with the ERP system. They would get their numbers through Control, Plan or Progress. Having
the Cost Center option gives you the flexibility to assign contract line items to different account
assignments in the ERP system. Based on project specific requirements.

The Cost Center is a free-text field. However, in the Master Data Library, cost centers can be defined to
use. If your organization maintains cost centers in the Master Data Library, they l appear as an auto-fill
under the cost center pull-down. There is nothing in this field which forces you to have an exact make
with any other items listed.

Cost center fields and columns appear throughout the application where WBS code fields and columns
already exist. Cost Center selection would be used when costs are being charged to the overall project
and not to a specific WBS.

Addi t iona l f ie lds sect ion

The Additional fields section contains five custom fields, which you can define in the Organization
settings. You can use these fields to map a custom line item JSON to your ERP system. Organizations
specify the names of the custom fields on the Contract Custom Labels page of the organization
settings.
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Addi t iona l deta i ls sect ion

The Additional details section contain fields that let you add a percentage for goods receipt, diversity
participation, and overdelivery tolerance at a line-item level.

Divers i ty Par t ic ipat ion

Diversity participation fields let you manage the diversity participation percentage and value for a line
item. The Percentage field calculates a value based on the percent of the value of the line item. The
Value field calculates a percent based on the value of the line item. The two lines work together. When
you update one, the other updates automatically. For example if the value of the line item is $50,000,
and you update the percentage of the diversity participation to 10%, the value of the line item
becomes $5000. If you update the value of the line item to $6000, the percentage becomes 12%.
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When the line item value is updated using a vendor change order, the percentage is used to
calculate the new diversity value.

5.0.4 .17 L ine i tems f rom master agreements

A master agreement is a type of contract, set at the project level, between a general contractor and a
supplier to purchase goods or services later. When a contract has been associated with a master
agreement, you can add a line item from the master agreement to take advantage of the terms,
conditions, and pricing of the master agreement. You can also associate an existing line item to the
master agreement. See Master Agreements for more information about master agreements.

Add a l ine i tem from the master agreement

You can add a line item directly from a master agreement. When you add lines from the master
agreement, line item details are predefined, and the association to the master agreement line item is
automatically created.

The contract must already be associated with a master agreement.

1. From the Line items tab of the contract, click the Add line item icon, and then select From
master agreement. The Add from master agreement dialog box opens.

2. Select a line item from the list.

3. Click Add. The line item is added to the line item register. The Type and UoM columns are
dimmed and cannot be changed.

You can now create a purchase order from the line item.

Assoc ia te an ex is t ing l ine i tem to a master agreement

You can associate a line item to a master agreement, so you can use the terms of the master
agreement to purchase the line item.

The contract must already be associated to a master agreement, and the line item must already be
created and saved. You can only associate a contract line item that has not been published. After the
contract line item is published on the purchase order you can no longer associate it to a master
agreement. Line items that are already associated to a master agreement have the Line Item Id and
Type fields dimmed in the Line items register; all other fields are editable in the register.
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1. From the Line items tab in the contract, click the line item number. The line item Details page
opens.

2. Select a master agreement line item from the Agreement item ID field drop-down list.

3. Click Save. The line item is associated to the master agreement.

Disassoc ia te a l ine i tem from the master agreement

You can disassociate a contract line item from the master agreement item when you no longer want
the item tied to the master agreement line item.

You can remove the association at any time. After the association is removed you can reassociate the
contract line item to the same master agreement line item.

1. From the Line items tab in the contract, select the line item, and then click the Edit line item
icon. The line item Details page opens.

2. Click the Disassociate icon next to the Agreement item ID field, and the click Yes in the
confirmation box.
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3. Click Save. The association is removed from the contract line item. The value of the line item
goes to the generic MPA 0000 line.

You can associate the line item to a different master agreement line item.

5.0.5 Schedule of values tab

As you work on a contract, you often need to see the quantity or value of a line item claimed against a
component, so you can progress the contract. A component is used in InEight Plan and InEight Progress
to divide a cost item into manageable and identifiable parts, so they are easy to track. The schedule of
values lets you see the totals claimed by a component. You can also use the totals to reconcile a
vendor invoice with the contract line items.

The Schedule of Values tab shows the details of line item parts. Each part is made up of a description,
schedule quantity, unit of measure, unit price, schedule value, and WBS code. You can choose whether
to have the schedule item available to use in Plan and Progress or to hide it from those applications.
The Schedule of values page lists all of the schedule items for the contract. A warning shows if the
schedule value exceeds the Net price of the line item.
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The Contract discipline (Project Settings > Assigned disciplines and commodities) must be set to
Available to send schedule of value items to Plan.

5.0.5 .18 Quant i ty and value in the schedule of va lues

The schedule of values can help you track values and quantities of line items. If you want to track only
the value of a line item, you can create a value-only schedule item. A value-only schedule item can
include positive, negative, or zero value but have zero quantity, so you can track and claim value
without entering a quantity.

5.0.5 .19 Add a schedule of va lues

To add a schedule of values, click the Add schedule of value icon on the Schedule of values tab.

5.0.5 .20 Add schedule i tem

When you add a new schedule item, the Add schedule of value slide-out panel opens, where you can
fill in the pertinent information for the schedule item.

Field Function

1 Contract line item ID Select the line item associated with the schedule of value item.

2 Description Free text entry field to describe what the schedule of value
item is.

3 Schedule quantity The total quantity of the item. When this field is enabled, the
quantity must be greater than zero.

4 UoM Select the unit of measure for the schedule of value item. The
unit of measure can be different from the unit of measure for
the line item.

5 Unit price The unit price, in the currency of the contract, of the schedule
of value item. The unit price is automatically calculated when
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Field Function

the schedule value or schedule quantity is updated. A negative
number can be entered for the unit price when an item has a
negative value.

6 Schedule value Contract calculates the schedule value based on the quantity
and unit price.

7 Value only Select the Value only check box to create a value-only
schedule item. Checking this box disables the Schedule
quantity and Unit price fields. Also, the Hide in plan and
progress field is set to Yes and then disabled.

8 WBS code The WBS code assigned to the line item.

9 Hide in plan and
progress

Select the box to hide the schedule item from Plan and
Progress. Deselect the box to track the schedule item as a
contract component in Plan. If an item has a value other than
zero in Plan and Progress, you cannot deselect this check box.
If you have made a mistake and need to deselect the check
box, you must go to Plan or Progress, and then edit the item
there. After it is edited, you can deselect the check box. A
schedule item that is hidden in Plan and Progress can be
claimed directly from Contract.
When the check box is not selected, any changes made to the
vendor in the contract details are automatically updated in
Plan.

10 Valid from/ Valid
through

Enter the valid dates for the schedule of value item. The dates
must be within the associated line item valid from and valid
through dates. Any contract claims using the schedule item
must be posted within these dates.

11 Custom fields The contract-level custom fields.
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You can also add a schedule of value item from the Line items register. Any line item type can be
copied. To copy a line item from the Line items register to the schedule of values, select the line item,
and then expand the Copy icon. You can then select To schedule of values. A notification shows that
the line item has been added to the schedule of values. The following columns are copied with the line
item:

l Line Item ID

l Description

l UoM

l Quantity

l Unit Price

l WBS code

l Valid from/ Valid through

l Custom fields

The Hide in Plan/Progress field in the schedule of values defaults to Yes. You must manually fill in the
remaining fields. The line item is automatically associated to the schedule of values.

When you copy a limit line item to the schedule of values, the Value only check box is automatically
checked and disabled. The unit of measure defaults to a value of PLS.

If the line item had been deleted or closed, the line item is copied, but the line item ID is left blank.

You can use the import and export feature to set up and maintain a large schedule of values.
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5.0.5 .21

5.0 .5 .22 Schedule of va lues reg is ter

After you add a schedule of values item, Contract adds a schedule item ID and adds it to the Schedule
of value items register. The register lists all schedule items for the contract. The schedule of values grid
has sections for schedule of values details, contract claims, component progress, and summary
progress. Arrows in the column headers let you collapse or expand the section. Multiple sections can
be collapsed. The first section, which includes the Schedule line item ID, Contract line item ID, and
Description cannot be collapsed. You can click the double arrow in the first section to collapse the rest
of the sections.

The bottom of the grid shows the total number of items and the total number of selected items. To see
only the selected items, click View selected. Click Clear selection to deselect all items. The Go to
Schedule ID link helps you quickly find Schedule items that are not visible on the page.

Schedule of va lues deta i ls

The Schedule of value items section shows the following:

l Schedule quantity

l Component quantity

l Unit of measure

l Unit price

l Schedule value

l WBS code

l Whether the item is hidden in Plan and Progress

l Valid dates

Prior to publishing the contract, the Original schedule value column shows the current value.
Publishing captures the current values as the original value. If you add a new schedule item after the
contract is published, the new item will have the Original value column set to 0, and the Manual
adjustment column set to the amount of the new schedule item.

If the schedule values for a line item exceed the net price of the line item, all schedule items for that
line item are marked with a warning icon in the Schedule values column. To keep totals in sync, you
must change the number in the line item or the schedule items. If a schedule item has been claimed in
Plan or Progress, you cannot delete the schedule of values item. You can update the item, and then the
update goes to Plan or Progress.
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If a schedule item is not hidden in Plan and Progress, the Component quantity column shows the
Component quantity from Plan. If the value is modified in Plan by splitting the contract component, a
blue dot shows next to the quantity to indicate the component quantity does not match the schedule
quantity.

If there is no quantity claimed, you can delete a schedule of values item that is not hidden from Plan
and Progress.

The total schedule value amount shows at the bottom of the section.

Contract c la ims

The Contract grid section shows the quantity and value claimed in Contract. The total amount claimed
in Contract shows at the bottom of the section. If the current date is not between the valid from and
valid through dates of the associated line item, an error icon shows in the Contract line item ID column
of the register, and no claims can be made from associated schedule items.

See Claim schedule items from Contract for information about claiming in Contract.

Component progress

The Component progress grid section shows claims that were made in Plan and Progress. Click on a link
in the Quantity claimed or Value claimed column to go to quantity tracking in Plan.

The total amount claimed in Contract shows at the bottom of the section.

Summary progress

The Summary progress grid section shows the total of claims made in Contract and in Plan and
Progress.

Field Function

Quantity claimed The total number of items claimed.

Value claimed The total amount (that is, the quantity multiplied by the unit price)
claimed.

% Complete The percent of the schedule value that has been claimed.

Quantity remaining The number of items that remain to be claimed (that is, the schedule
quantity minus the quantity claimed).

Value remaining The value that remains to be claimed (that is the schedule value
minus the value claimed).
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Date fields in the toolbar let you narrow the dates that components were claimed.

The total value claimed, percent complete, and value remaining show at the bottom of the section.

Payment c la ims

The Payment claims grid section shows the quantities and values used in payment claims. For
information about Payment claims, see Payment claims.

Field Function

Vendor quantity The quantity of the claim for a vendor.

Vendor value The value of the claim for a vendor.

Certified quantity The quantity of claims that have been certified.

Certified value The value of claims that have been certified.

Certified delta The difference between the vendor value and the certified value.

Pending quantity The quantity of claims that are pending certification.

Pending value The value of claims that are pending certification.

Pending delta The difference between the vendor value and the pending value.
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Payment forms

The Payment forms grid section shows information about the quantities and values of payment forms
associated to the schedule line item. For information about payment forms, see Payment Forms.

Changes

The Changes grid section shows vendor change orders associated with the schedule item.

Field Function

Executed quantity The number of items that were executed in the vendor change order.

Executed net
amount

The net amount executed in the vendor change order.

Vendor change
order ID

The vendor change order ID.

Manual
adjustments

The total of all value changes made without a vendor change order after
the contract is published.

Schedule of va lues co lumn management

The Schedule of values register uses sections to group data. You can expand or collapse the columns
and use the column selector builder to choose the information you want to see.

You can choose between the standard grid and the single grid registers. The single grid register
features faster loading and scrolling times, and collapsible sections that are color coded to be
consistent with the Line items tab. The standard grid presentation, features collapsible sections that
are a light gray color. Delays in scrolling and loading might occur. Use the Schedule of values single grid
toggle at the top of the page to switch between the presentations. When the toggle is set to On, the
enhanced single grid version shows. The toggle defaults to On.

The first section of the grid contains identifying information, including the schedule line item ID,
contract line item ID, and description. The columns in the first section are stationary and cannot be
collapsed. You can expand the columns until the section takes half of the screen area. After you have
reached the maximum expansion, the scroll bar shows at the bottom of the section.
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You can click the arrow in the column header of the other sections to expand or collapse that section.
The Collapse icon for each section floats, so it is always visible as you scroll. You can manually size
columns, so you can see the information you want. To collapse all collapsible sections, click the double
arrow in the first section.

The column management feature lets you arrange grid sections, add or remove columns within the
sections, and remove sections if they are not needed. Click theManage columns icon in the toolbar to
open the Column Selector Builder dialog box.

The Available columns section shows all columns that are available for each section. To add a section
or column, select it, and then move it to the Selected Columns section. To remove a section or column,
select it, and then move it to the Available columns section. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot move columns between grid sections, except in the following
instances:
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l The Contract line item ID and Description columns can be moved from the first section to the
Schedule of values items section.

l Any columns from the Schedule of value items section can be moved to the first section.

Click Save to apply the changes. The changes show for as long as you are on the Schedule of values
page. To save the column arrangement as a view, expand the View drop-down menu, and then select
Save view as.

When you open the Schedule of values register, only the Schedule of value items and Summary
progress tabs show. You can add other sections and columns as needed. After you have added the
sections or columns they remain in the view until they are removed, or you reset the defaults in the
Column Selector Builder dialog box.

Copy a schedule of va lues i tem

When you want to add more than one schedule of values items for a single line item, you can add one
schedule item and then copy it. This can save you time when you have a line item that applies to a
large scope of work and you want to track it in smaller segments. You can create a schedule of values
item for the line item and then copy the schedule item and change details instead of entering
information multiple times.

When you copy a schedule item, only values in the Schedule of values section of the Schedule of values
register is copied. You must add data to the Quantity claimed and values sections as needed.

Copy a schedule of va lues i tem

Summary: Copy a schedule of values item when you need multiple schedule of values items that are
similar in description or value, so you can add them quickly.

Considerations: The copied schedule item has the same data in the Schedule of values sections as the
original. After copying, the schedule values for the original item and the copied item show with a
yellow with a yellow caution icon because their values added together exceed the line item value.

1. From the Schedule of values register, select the schedule item you want to copy.

2. Click the Copy schedule item icon.
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The copied item is given a schedule line item ID and shows on a new line.

3. Edit the new and original schedule items as needed.

Remove or de le te a schedule i tem

When a schedule item is not needed, you can remove it or delete it from the schedule of values. When
you remove a schedule item, it is permanently removed from the contract, and subsequent schedule of
value items are renumbered. When you delete a schedule item, the item shows in the register with a
strikethrough, and it cannot be edited. The remaining schedule items are not renumbered, so you can
maintain the schedule of values ID order. Only schedule items that have not been claimed in InEight
Plan, InEight Progress, or Contract can be removed or deleted.

You can remove a schedule item if it has never been associated to a vendor change order, payment
claim, or payment form. To remove a schedule item, select it, and then click the Remove schedule of
value icon.
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You can delete a schedule item when the vendor change order, payment form, or payment claim has a
net value of 0 and the following conditions are met:

l The Contract claim sum of all claims is 0

l The Payment claim Certified section is 0

l The Payment form This submission section is 0

To delete a schedule item, select it, and then click the Delete schedule of value icon. The item is
deleted and shows a strikethrough. The Hide in plan and progress check box is automatically set to Yes
and disabled.

VIDEO | Delete or Remove Schedule of Values

Undo a dele t ion of a schedule i tem

If a schedule item was deleted from the schedule of values, you can re-add it from the contract
Schedule of values tab or the vendor change order Schedule of values tab. To re-add the item, click the
Undo schedule removal icon.
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The strikethrough is removed from the schedule item, and the value of the schedule item is added
back into the contract. When you re-add a deletion in a vendor change order, the Change order
adjustment section of the vendor change order Schedule of values tab is updated.

5.0.5 .23 Cla im schedule i tems f rom Cont rac t

You can claim individual schedule items or multiple schedule items from the Schedule of values page.
Claiming in Contract lets you track claims that might not be tied directly to work performed daily in the
field.

You can view claim history of an item from the Contract claim history tab of the Edit schedule item
slide-out panel (Edit > Contract claim history).

Schedule items must be claimed within the Valid from and Valid through date range defined in the
schedule item details. If the claimed date falls outside of this date range, the schedule item cannot be
claimed. An error message shows with the Claimed date or Posting date field if the entered date is
invalid. If only a valid from date is specified, an error shows when the claimed date is earlier than that
date. If only a valid through date is specified, an error shows when the posting date is later than that
date.

Cla im a schedule i tem in Cont rac t

You can claim a schedule item from the Edit schedule item slide-out panel.
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The schedule item Hide in plan and progress check box must be set to Yes. After an item has been
claimed, the value of the Hide in plan and progress field cannot be changed.

1. Select a schedule item, and then click the Edit schedule icon. The Edit Schedule item slide-out
panel opens.

2. Go to the Contract claim tab.

3. Enter the claimed quantity or claimed value. The other value is automatically calculated. A
prompt asks if you want to recalculate the other field based on the entered value.

l If you choose to recalculate, the other value is calculated.

l If you choose not to recalculate, you can enter a value, including values that are rounded.
The values might not match mathematically.

When you make a claim against a value-only schedule of values item, you can only claim
value. The ability to claim quantity is disabled and cannot be recalculated.

4. Enter the claimed date and any notes.

5. If you want to claim additional items, click the Add claim icon in the slide-out panel, and repeat
steps 2-5 as needed.

6. Click Add.

The Quantity claimed and Value claimed columns in the Contract section of the register are updated.
All columns in the Summary progress section are updated.

Cla im mul t ip le schedule i tems

You can claim multiple schedule items at one time from the Schedule of values register.
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The schedule item Hide in plan and progress check box must be set to Yes. After an item has been
claimed, the value of the Hide in plan and progress field cannot be changed.

1. From the Schedule of values register, click the Claim multiple schedule items icon. The Claim
multiple schedule items dialog box opens.

2. Enter the claimed quantity or value for each item. The other value is automatically calculated. A
prompt asks if you want to recalculate the other field based on the entered value.

l If you choose to recalculate, the other value is calculated.

l If you choose not to recalculate, you can enter a value, including values that are rounded.
The values might not match mathematically.

3. If you want to claim additional items, click Add schedule item. The Add schedule items dialog
box opens.
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4. Select one or more schedule items, and then click Add. The items are added to the Claim
multiple schedule items dialog box.

5. Enter the claimed quantities or values for the added items.

6. Click Claim.

The Quantity claimed and Value claimed columns in the Contract section of the register are updated.
All columns in the Summary progress section are updated.

Cla im schedule i tems f rom a spreadsheet

When you have many schedule items to claim at one time, you can use the import function to claim
these items.

The schedule item Hide in plan and progress column of the spreadsheet must be set to Yes. Claims for
schedule items with Hide in Plan and Progress set to No are ignored upon import. After an item has
been claimed, the value of the Hide in plan and progress field cannot be changed.
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1. On the Schedule of values tab, optionally select items to be exported.

l If you select items, only those items selected are exported.

l If you do not select any items, all items are exported.

2. Click the Export icon, and then selectWith data. A Microsoft Excel spreadsheet with the
schedule items is downloaded.

3. Open the template, and then claim items in the Quantity claimed or Value claimed columns, and
then save the file.

4. Click the Import icon. The Import data from template dialog box opens.

5. Browse for the file or drag and drop it to the dialog box.

6. Indicate whether to import values based on the quantity, value, or both. If you select Quantity,
the Value claimed is recalculated regardless of what was entered and vice versa. If you select
Quantity and Value, both columns are read regardless of whether they match. You are
responsible for maintaining those fields.

7. Click Import. Data is imported and the results are emailed when completed.
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From the email notification, click Review data. The import history page opens, and you can review the
import. The Schedule of values page is updated. The import history shows the import type used in the
Schedule of values.

Cla iming templates

If you have many schedule items or if you have a group of claims that you use on a regular basis, such
as at the end of the week or each time concrete is poured, you can create a claim template. The
template can help you quickly find the schedule items you need each time the event occurs.

Create a c la iming template

You can create a claiming template when you claim multiple schedule items.

1. From the Schedule of values register, select one or more schedule items, and then click the
Claim multiple schedule items icon. The claim multiple schedule items dialog box opens.

2. Add the schedule items for the template as you do when you Claim multiple schedule items, and
then click Save as template. The Save template dialog box opens.

3. Enter the name of the template, and then click Save.

You can use the claiming template to make a claim from contract.
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Cla im mul t ip le i tems f rom a template

You can load an applicable template when you have a group of claims that are used regularly, so you
do not have to search for each item.

A template must already be created.

1. From the Schedule of values register, select one or more schedule items, and then click the
Claim multiple schedule items icon. The claim multiple schedule items dialog box opens.

2. Click Load template. The Load template dialog box opens.

3. Select the template you want to use, and then click Load. The template opens in the Claim
multiple schedule items dialog box.

4. Review the template, and add or remove items as needed.

5. Enter the claimed quantities or values for the added items.

6. Click Claim.

5.0.5 .24 Conver t a schedule of va lues to a payment form

You can quickly convert schedule of value items to a payment form from the Schedule of values
register. The new payment form is automatically populated with values from the schedule of value
items for the date range selected.
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Conver t a schedule of va lues to a payment form

Convert a schedule of values into a payment form when a claimed schedule item is ready to be paid.

You must have payment form permissions to convert schedule of values items to payment forms, and
the Contract type must be configured to use payment forms. Items must be claimed before they can
be converted to a payment form. The item can be claimed in Contract or Plan or Progress.

1. From the Schedule of values register, select the claimed items to convert. Click the Associate
schedule item icon, and then select Payment form. The Add payment form dialog box opens.

2. Enter the payment form information, and then click Add. The payment form is added, and the
Payment form Details page opens.

You can continue adding payment form information on the Payment form Details page. The schedule
items you selected show in the Payment forms Schedule of values page.

5.0.5 .25 Conver t a schedule i tem to an accrua l or rece ip t

You can convert a schedule item into an accrual or receipt from the Schedule of values register.

Conver t a schedule i tem into an accrua l or rece ip t

Convert a schedule item into an accrual or receipt from the Schedule of values register, so you do not
have to enter the information on the Accruals page.
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You must have accrual/receipt permissions to convert schedule of values items to an accrual or receipt.
Only items that are eligible for goods receipts can be converted. If the receiving amount causes the line
item to be over the allotted tolerance, an error message is shown when you convert to a goods receipt
or accrual.

1. From the Schedule of values register, select one or more schedule items.

2. Click the Associate schedule item icon, and then select Accrual/Receipt. The Add new item
dialog box opens.

3. Select the type, and then add a description and posting date.

4. Click Add. The accrual or receipt is created, and the schedule of values quantity is shown on the
corresponding line item. If the value of the Summary Progress Value Claimed field is 0, the item
is added to the accrual, but defaults to a 0 value. When you convert a value-only schedule of
values item, Contract converts the sum of the claimed values of the schedule of values
associated to the parent line item.
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5.0.6 Supporting documents

The Supporting Documents tab contains all the documentation for the contract in one location. This
includes all insurance, surety, waivers, etc. Because this information is in one tab, the contract,
compliance, and finance teams can verify the vendor has supplied all necessary documentation for
compliance with the subcontract.

5.0.6 .26 Add Suppor t ing Document

On the Add supporting document window, you are required to specify the document type. All system-
managed and custom document types are supported.

The Add supporting document window requires additional data dependent on the type of document
you attach.  For example, the Insurance document type requires the following addition fields: Subtype,
Insurer, Effective date, Expiration date and Notes. You can also add a document from InEight
Document.

Single sign-on (SSO) is available for Contract to Document features, such as adding a document
from Document. When you use one of these features, the Document sign-on page opens, and
you can enter your credentials. This creates a sign-on token that lets you remain signed in until
the session ends. The first time you sign in to Document, a black secondary window and the
Document Home window also opens. You can close these windows. SSO is activated, and they
are not shown again.

Document types Insurance, Surety, Certification, Tax ID form, and Other have the option to send
notifications when the document expires. An expiration value is set at the organization and project
levels that indicates the number of days before the responsible parties receive notification. When the
Expiration notification enabled toggle is set to Yes, notifications are sent until you turn off the setting
in the document or after 180 days past the expiration date. The Expiration notification enabled toggle
remains set to Yes, so you can quickly see that notifications were sent. The Tax ID form document type
also has a field for the Tax identification number.

Add Suppor t ing Cont rac t Documents

Summary: Add documents to support the contract.
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Considerations: If the document type and subtype show as a placeholder in the Supporting documents
register, you must add the document to satisfy the requirement. See Document placeholders for more
information.

1. On the record page for the contract, select the Supporting Documents tab.

2. Click the Add Document icon, and then select New supporting document.

3. Add Supporting Document details – Title, Document Type, File/Link, Executed date (if applicable)
and Notes.

4. Click Add. The document is added on a new line

Document p laceholders

The organization can specify default document types and subtypes for a contract type. The required
document types show as placeholders in the contract-level Supporting documents register with a
yellow warning triangle.
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The organization can configure the default types as required for workflow and publishing. If
configured, workflow or publishing cannot take place until those documents have been added.

You cannot change the document type or subtype when you add or edit a placeholder. You also cannot
delete a placeholder or a document added to the placeholder.

Add document to a p laceholder

Summary: Add a document to a placeholder when a yellow warning triangle shows on the contract-
level Supporting documents. The placeholders must be replaced by documents before publishing or
workflow as configured by your organization.

1. From the Supporting documents register, hover over the yellow warning triangle, and then click
the Add document link in the text. The Edit supporting document dialog box opens.

2. Enter the required information and then upload the document. You can then click Save to add
the document to the Supporting documents register.

Adding Documents to Suppor t ing Documents Regis ter

For a quick way to add documents to a central location to add all at once to a contract can be done at
the Contract tab. You can add a new supporting document or a document from InEight Document.

To add a new document, go to the Contracts > Supporting Documents tab. Click the Add Supporting
document icon, and then select New Supporting document.

Complete all the fields required, including uploading the document you want to be attached from your
desktop or from InEight Document.
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After you select Save, the document is saved to the register and ready to be linked to a contract later.

When you upload a document of type Proposal, subtype from Vendor in InEight Change and associate
it to a Contract ID, the document is visible in Contract as read-only on the main Supporting document
register and the Contract supporting document tab.
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If a VCO was selected in Change, it is also shown on the VCO supporting document tab. The proposal
has an approval status of Not applicable, and Contract Document workflow is not considered. Only the
Change workflow for the document is considered. The document is read-only in Contract.

5.0.6 .27 View a suppor t ing document

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.

To download the document to your workstation, click Download file.

5.0.6 .28 Upload a document to InEight Document

You can upload a saved supporting document to InEight Document from Contract, so you do not have
to load it in Document, and then link it back in Contract.

Upload a document to Document

Upload a supporting document to Document when you want to take advantage of Document's
organization and versioning features.

Only documents with the document sourceMy computer can be uploaded.
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1. From the Supporting documents register, select a document with the document sourceMy
computer, and the click the Upload icon.

2. If you are not already signed into InEight Document, use your credentials to sign in to
InEight Document.

The Upload window in the Documents module of Document opens with the document you
selected in Contract already attached.

3. If you want to add more documents, you can add them at this time.

4. Click Save and Transmit. The document is now saved in the Document Documents module.

5. Close the Document window. Contract shows the Edit supporting document dialog box. The file
link is replaced with the document link form Document.

6. Click Save. The Supporting documents register refreshes with the file link to the Documents
module. The Document source is replaced with InEight Document, and the External document
type and status are now populated.

5.0.6 .29 Suppor t ing documents approva l

Document approvals can be started for one or more documents. To start the approval process, select
the documents, and then click the Start approval button.

After you start the approval process, the Start approval dialog box shows all of the steps for each
document selected.
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Group steps include a drop-down menu for group selection. You can add the Current approvers column
to the register to easily see the person or role responsible for the current approval step. For workflows
with one or more group steps, you must select groups for each group step in each document. After you
enter all information, click Start to start the approval process. The Start approval dialog box stays open
until all workflows have successfully started.

If you have an approver role, you can review and either reject or approve the contract's supporting
documents from the Supporting documents register or from your Action items register.

With appropriate permissions, you can recall a document after it has been approved. To recall a
document, click the Edit icon to open the Edit supporting document dialog box, and then click Recall
approval.

5.0.6 .30 Show or suppress a document in a generated cont rac t
document

You can specify whether a supporting document details are shown in a generated document. A toggle
on the Supporting documents register, Show in generated document, lets you indicate whether the
document is shown in a collection table in a generated document based on the collection table type.
When you have a supporting document that you do not want to show in a collection table, set the
toggle to No. When a document is generated, only the documents that were set to Yes are shown.
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A document that is available at more than one level, such as a contract-level document available on
the contract and VCO Supporting documents pages, can have a different setting at different levels. For
example, you might set the toggle at the contract level to Yes to show in a generated document. You
could set the toggle at the VCO level for the same document to No to not show in a VCO document.
Contract uses the setting that corresponds to the level of the collection table tags in the template.
Using the previous example, Contract shows the supporting document in a collection table as follows:

l When you generate a document for a contract, the document is shown because the only
collection table type in a contract document is a contract table.

l When you generate a document for a VCO that has a contract-level collection table, the
document is shown because it is part of a contract-level collection table.

l When you generate a document for a VCO that has a VCO-level collection table, the document is
not shown, because the document is suppressed at the VCO collection table level.

5.0.7 Workflow Assignments

Each contract is unique and may require various levels of approval. The Workflow Assignments tab
allows you to set up the proper approval steps. The approvals are broken down into different parts of
the contract management process (contract, change order, and payment form) to allow for maximum
flexibility in the approval workflow.

When the Projects must select specific users... check box in the organization workflow approval setup
(organization Settings > Contract > Workflow assignments > [Bid package or Contract type] > Add
approval dialog box) is selected, you must assign specific users to each role in each step. When the
check box is not selected, and there are multiple roles assigned in a single step, you can assign one
user to any role in each step before workflow can begin.

If a role in a workflow assignment has no users assigned to it, the workflow cannot be started. A
warning indicating that there is no applicable user for the step is shown.
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Workf low Ass ignment

1. From the Workflow Assignments tab of a contract, select the type of approval setup.

2. On the approval set up page, click the Add approval icon. The Add approval slide-out panel
opens.

3. Enter the step title and then assign users, groups, or roles as approvers, and then click
Add.

4. Click Save on the approval setup page.

Star t the approva l work f low

Start the approval process when the contract or vendor change order is complete and ready for final
approval.

Approval steps must be configured at the organization, project, or contract level. If you want to make
changes to the approval steps, you must go to the Workflow Assignments tab to make your changes. If
your organization has chosen to not allow workflow when the contract is over budget, an error
message shows when you start the approval. See Organization settings for more information about
allowing a contract type to go to approval when over budget.
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1. Go to the Header tab for a contract or the Details page for a vendor change order, and then click
Save and start approval. The Start approval dialog box opens to the approval steps page.

2. Review the change approval steps as necessary, and then click Next.

3. Review the contract budget. Contract converts the workflow values from the project currency to
the contract currency to see if you have exceeded budget. If there is no conversion rate listed in
the project details, the conversion rate is assumed to be 1:1. When the contract is over budget, a
yellow warning banner shows at the top of the Budget check tab, and the loss is shown in red in
the Gain/Loss column.
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If information required for the workflow is missing, the applicable section header in the
contract Additional details section on the Contract Details page shows a red warning icon.

4. Choose one of the following:

l If you do not want to add a message and attach supporting documents, click Start. The
approval process starts.

l If you want to add a message or attach supporting documents, click Next. The Add
messages page opens.

5. Choose one of the following:

l If you want to add a message to be included in the workflow email, type and format it, and
then click Next. The Attach supporting documents page opens.

l If you do not want to add a message, click Next. The Attach supporting documents page
opens.

6. Choose one of the following:

l If you want to attach supporting documents, click Next. The Attach supporting documents
page opens.

l If you do not want to attach supporting documents, click Start. The approval process
starts.
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7. Select one or more supporting documents from the list of documents.

8. Click Start. The approval process starts.

The approvers receive a notification of the approval item. When you start the approval process and
you are the first approver in the approval workflow, the first step of the workflow is automatically
approved, and continues with the next step, if applicable. If you are the only step in the approval, the
item is set to Approved.

Users who are added to roles associated with an active workflow can approve or reject workflows
items. They do not get a workflow notification, but the workflow item is shown in the Action items tab.
Worklfows that are not completed within 90 days are terminated and automatically removed from the
Action items tab.

You can view document approval workflow progress and history on the project Workflows >Workflow
details page. If the workflow has been recalled, the name of the person who recalled the workflow is
shown in the workflow heading.

When the workflow is complete, Contract sends a completion email to you as the initiator, people who
created the item, and the person who completed the last step.

5.0.8 Contract Writer

If there is a need to create a customized contract document between the contractor, owner or
subcontractors, Contract provides Contract writer to aid in the development. This is a legal document,
which needs to be signed by all parties and stakeholders.

5.0.8 .31 Create a Cont rac t document

When you are ready to create a contract document, you can generate it from one or more templates.
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Create a cont rac t document

1. To use a template in a contract, open Contract, and then select the Contracts tab.

2. Select a contract ID to open a contract.

l The contract Details opens for the selected contract

3. From the Actions drop-down menu, select Generate contract document.
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4. Select the template type from the submenu. Only template types applicable to the Contract tab
you are currently on are enabled.

l The Contract template page opens for you to select the created contract template
l The list shows available templates assigned to the contract type
l The Contract template details sections lets you specify details about your contract
document

5. Move one or more templates from the Available templates column to the Selected templates
column.
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Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

6. In the Contract template details section, choose one of the following in the Generate document
as field:

l Individual documents to get a separate document for each template you selected.
l Merged document (PDF only) to merge the templates into a single PDF document.

7. If you selected Individual documents in the previous step, use the Generate document file type
as field to indicate whether to download as a template file type or download as a PDF. If you
selected Merged document in the previous step, skip this step.

8. Use the toggle to indicate whether to save the contract document in the Supporting documents
tab. If you choose to save in the Supporting documents tab, add the name of the document. This
document name shows in the Title and File/Link columns of the Supporting documents register
after the document is generated.

9. Select the watermark text. If the organization-level settings require a watermark and the end
watermark event has not occurred, the Select watermark stamp field is required. If the end
watermark event has occurred, the watermark is optional.

10. Click Next. The Review templates page displays the templates in the order you selected.

Choose the template you want to review from the Review templates list. The template tags
display as fields in the display area. The message, "No general tags found in this template" in the
display area can indicate that the table consists of only collection tags. If the Allow users to edit
the document during creation toggle in the template details is set to No, the fields on the Review
page are disabled.
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The Review templates dialog box lets you edit or add information to the fields that populate the
document after it is generated. Any field that is blank is not added to the document, and you
cannot add information later.

11.  Make changes and additions to the contract information. Use the Review templates list to select
the next template, and make changes.

12. After you have reviewed all changes, you can see a preview of your document by clicking the
Preview document button. The preview opens in a separate window with the tags filled in. If you
used collection tables in any of your templates you can view them in the preview document. The
content of the preview varies as follows:
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l If you selected Download as a PDF document when you generated the document, the
preview contains all of the templates in the order you specified.

l If you selected Download as individual documents when you generated the document, the
preview contains only the template that was displayed when you clicked Preview
document. You can preview other documents by selecting the file from the Review
templates list and clicking preview document.

13. Click Finish. If you created a merged document, Contract writer downloads a PDF that includes
all of the templates. If you created individual documents, Contract writer downloads a PDF for
the selected template only.

Changing data in Review contract fields updates the data published in the contract
document but does not update the data field in Contract. 

Create a cont rac t document f rom the reg is ter

You can generate a contract document from the Contract, VCO, or Master agreement register without
having to open the contract or VCO.

1. Select one contract, VCO, or master agreement in the register.

2. Expand the Actions menu, and then click Generate contract document.

The Generate contract wizard opens for you to follow the procedures and generate a contract
document.

5.0.8 .32 eSignature suppor t

When a project is integrated with DocuSign, you can use Contract's Supporting documents pages to
send and manage documents that have DocuSign tags. DocuSign functions are supported on the
Contract-level, bid package, document, back charge, and payment form Supporting documents pages.

Send cont rac t documents for eSignature v ia DocuSign

When a project is integrated with DocuSign, you can send a document to DocuSign for an eSignature.

DocuSign tags can be embedded in the contract template. The DocuSign tags correspond to DocuSign
recipients configured in the project settings, project contacts, and user information defined in the
Division of responsibility section of the contract details.
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Send a document for eSignature

After a document has been created, you can send it for official eSignatures via DocuSign.

Documents must be in Word, Excel, or PDF format. They must be saved to the contract or VCO
supporting documents page with the document sourceMy computer. You must have Edit contract
permissions to send documents. Ensure that your browser's pop-up blocker is disabled before you click
Send from the Contract DocuSign wizard. You must have the permission Send for eSignature to send a
document for signature.

1. From the contract or VCO Supporting documents page, select one or more documents with the
document sourceMy computer, and then click the Send for signature icon.

The Send for signature wizard opens.

2. Review the Names in the Assigned section of the wizard. If you want to add additional recipients,
find their names in the Unassigned section, and then click the Add icon. All signees in the
Assigned section have ad-hoc signee tags that can be placed on the document in DocuSign.
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3. For each assigned recipient, specify in the Action column whether they need to sign the
document or if they are just to receive a copy.

l When the value is Needs to sign, the recipient receives a document that is ready to sign.

l When the action is Receives a copy, the recipient receives a snapshot of the document in
the signing order. For example, if the recipient marked Receives a copy is second in the
signing order, they receive the document after those first in signing order, even though
they are not signing.

4. Review the values in the Signing order column. The numbers in the column specify the order in
which the recipients are sent the document for eSignature. You can assign a single number to
multiple signees. The signee or signees with signing order 1 are notified first by DocuSign. After
all signees in signing order 1 have signed, DocuSign notifies all signees with signing order 2, and
so on.

5. If recipient information is missing from the Assigned section, update the information as needed.
Any updates you make are saved in the DocuSign section on the header tab of the contract.

6. Click Next. The Add message page opens.

7. Enter an email subject line and message to the recipients, and then click Send. A DocuSign
window opens with the documents you chose.

If the DocuSign window does not open, ensure that your browser's pop-up blocker is
disabled.

8. If your DocuSign administrator has configured Advanced Options, you can expand the Actions
menu, and then select Advanced Options.
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You can then customize the following options:

l Branding – Select a logo and brand colors, set up by the DocuSign administrator, for the
envelope.

l Recipient privileges – Give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

l Reminders – Specify whether DocuSign sends reminders to signees, when to start sending
them, and how often to send them.

l Expiration – Set the number of days until the envelope expires and how often to send
alerts.

l Comments – allow senders and recipients to enter comments on documents in the
envelope.

Click Save. You are returned to the document.

9. Optionally, add additional tags for signatures, initials, and dates. All names from the Assigned
section of the wizard are shown in a drop-down list in the upper left pane. Select the name of
the person you want to add, and then select Signature, Initial, or Date Signed, and then click the
place in the document. If the document has tags for a text box, drop-down list, check box, or
radio buttons, add the values to the document.
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10. Click Send.

The documents are routed for signature, and DocuSign sends an email message to each recipient
based on the signing order. In Contract, the DocuSign status column on the Supporting documents
page is populated with the status of Sent. You can hover over the status to see the name of the person
who sent the document and the status of the signatures. The Contract writer automatically adds the
sender to the last position of the list with the action Receives a copy. After it is completed, the signed
document is loaded as a supporting document with a document type Signed document. The person
who sends the document to DocuSign receives an email notification when the document signatures
have been completed and also receives a copy.

When a supporting document has a DocuSign status of Created, Sent, Completed, or Signed, you can no
longer edit the file link.

Correct document sent to DocuSign

Sometimes you find you must make corrections, such as changing signees or adding or changing
documents, after the envelope has been sent to DocuSign. Often, going through the eSignature
provider to make a correction results in voiding the envelope and incurring the charge of creating a
new one. You can avoid the expense of additional envelopes by initiating corrections to the envelope
in Contract.

Edi t a sent document

Make corrections to an envelope after it has been sent to DocuSign.
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When a supporting document has a DocuSign status of Created, Completed, or Signed, you can no
longer edit the file link. When the status is Sent, you can edit the document in the original eSign
envelope without incurring the expense of additional envelopes.You must have the Correct eSignature
permission to correct DocuSign documents.

1. On the Supporting documents register, hover over the ellipsis in the DocuSign status column for
a sent document. The DocuSign Status dialog box is shown.

2. Click the Correct button. DocuSign opens with the view of the original envelope.

Make the corrections in the DocuSign envelope. Refer to DocuSign documentation for more
information about envelopes.

DocuSign cer t i f i ca te of complet ion

After signing is completed, the certificate of completion is now available when you hover over the
ellipsis in the DocuSign status field in Supporting documents.

The certificate of completion is stored in Supporting documents, but it does not take up a separate
entry in the Supporting documents register. The certificate does not expire in Contract.
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When you click View certificate of completion, a preview of the certificate from DocuSign opens in a
new tab. You have the option to download the file if you want to store it separately.

5.0.9 PO Creation

Purchase Orders are used to send the contract line items and financial data to your ERP system. This
creates a platform for you to acknowledge the receipt of goods and services, as well as track quantities
and pricing so vendor payments can be processed.

The following items are required for the Create Purchase Order button to become available:

l The contract must be approved by a project administrator if indicated within the
workflow assignments.

l All required supporting documents must be uploaded and approved by the
compliance team. Note: This includes a copy of the executed contract.

l If the contract is in the approval process, the purchase order cannot be created until
approval is complete.

5.0.10 Master Agreements

A master agreement is a type of contract, set at the project level, between a general contractor and a
supplier to purchase goods or services later. A master agreement lets you set up the terms, conditions
and pricing of a contract. You do not commit the value of the agreement until you write an associated
contract or purchase order against it. For example, a master agreement could be an agreement to
purchase services across multiple years of a contract. Instead of purchasing all the services now, you
can write contracts for the services against the agreement as needed over the duration of the project.
All transactions of the contract purchase order associated to the master agreement for visibility.

A master agreement is not a standard contract purchase order. Because you receive and pay against all
the contracts and purchase orders associated to it, it is not necessary to create a goods receipt or
payment term against a master agreement. These are made against the individual associated
contracts.
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5.0.10.33 Conf igura t ion

You configure a new contract type to be specific for master agreements. A contract type that is
configured to be a master agreement can only be used as a master agreement.

Settings in the Contract type setup configuration in the organization settings (Settings > Contract>
Configurations > Contract type configuration setup) let you indicate whether a contract type is a
master agreement and, if so, whether to publish to the ERP system. For contract types that are not
master agreements, you can indicate whether to allow association to the master agreement.

To configure a contract type as a master agreement, set the Is this a Master agreement toggle to Yes,
and then indicate whether to publish to the ERP system. After the master agreement has been used,
you can no longer change these settings. The master agreement tab is only shown in the register home
page if there is one contract type that has the Is this a master agreement setting set to Yes.

When defining the required fields for the master agreement, it is best practice to set the Enable,
Require for purchase order, and Lock after purchase order settings to Yes. A vendor is required by the
ERP system. If you publish to an ERP system, you must enable the Vendor field and require it for a
purchase order or publishing will fail. Other field requirements must match those of your ERP system's
requirements, so you can successfully sync the master agreement to the ERP system.

For contract types that are not master agreements, you can indicate whether the contract type can be
associated to a master agreement. A contract must be associated to a master agreement to be able to
write contracts of that type from the master agreement. Set the Allow association to Master
Agreement toggle to Yes to allow associations. Set the toggle to No if you do not want to be able to
write contracts against the agreement.
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5.0.10.34 Create a master agreement

You can use Contract to create and manage master agreements. The following steps walk you through
the process of creating a master agreement.

Create a master agreement

Create a master agreement in Contract when you want to have an agreement about contract terms
and pricing without having to commit the financial resources right away.

Master agreements are created on the Master agreements tab. You must have at least one contract
type configured as a master agreement to see this tab.

1. From the Contract >Master agreements tab, click the Add master purchase agreement icon. The
Add master purchase dialog box opens.

2. Complete the following fields in the dialog box:

l Description

l Type

l Subtype

l Effective date

l Vendor

l Storage location

l Scope of contract

3. Click Add. This brings you to the Master agreements Header tab, which is similar to the
Header tab for a contract.

4. Complete the header information, and then click Save.

You can now complete the remaining tabs as you would with a regular contract.

5.0.10.35 Master agreement tabs

Master agreements can have the following tabs, based on your master agreement contract
configuration:

l Header

l Line items

l Schedule of values
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l Vendor change order log

l Back charges

l Supporting documents

l Workflow assignments

l Sync log

l Contract closeout

l Associations

The Associations tab is unique to master agreements. The other tabs work the same as the Contracts
tabs.

5.0.10.36 Cont rac t to ta ls icon

Click the Contract totals icon to display a slide-out panel that has a breakdown of the master
agreement's totals.
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The slide-out panel is similar to the Contract totals slide-out panel with the following exceptions:

l A section for change orders shows the total amount of change orders, total amount of potential
change orders, and the accrued liquidated damages.

l The Received to date, Contract invoices, Submitted to date, Paid to date, Retained to date
amounts, and percentages come from the contracts that have been associated to the master
agreement and not from the master agreement itself.

See Contract creation for more information about the Contract totals slide-out panel.

5.0.10.37 Master agreement banner

The master agreement banner shows at the top of all pages in the master agreement to help you track
the current value and associations.

The Current value is the amount of the master agreement. The remaining fields come from the
contracts associated with the master agreement. For example, as you write associations to the master
agreement, the Associations value increases.

The Remaining to buy field on the Associations and Vendor change order tabs is automatically
calculated. The remaining to buy is the difference between the master agreement current value and
the total associations current value.

5.0.10.38 Master agreement l ine i tems

The Line items tab lets you define the line items of the master agreement. These line items can be used
when you add line items to an associated contract. You must have at least one line item to publish the
master agreement.

The line items register is similar to the register for contract line items. The first line in the line item
register of every master agreement is a default placeholder 0000 line item, where a net price can be
manually entered. This line item is used to hold value that is not specifically applied to numbered line
item. For example, if you add an associated contract or purchase order that already has a line item, the
value of the associated line item will show in the 0000 line item progress viewset.
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Contract line items can be reassigned to master agreement line items. All information, other than
quantity, from the master agreement line are updated.

See Line items tab for information about line item details.

5.0.10.39 Publ ish a master agreement

After you have added one or more line items, you can publish the master agreement.

Publ ish a master agreement

When you publish the master agreement to the ERP system, the ERP system creates a master
contract. You then write purchase orders against the master contract.

The master agreement must have at least one line item.

1. Go to a master agreement.

2. Click Publish master agreement. The master agreement is available for association. If Contract is
configured to publish the master agreement to the ERP system, a master contract is created in
the ERP system.

You can now associate contracts to the master agreement.

After the master agreements has been published, you can still update it. To update, enter your
changes, and then click Save. The Update master agreement button is enabled. Click the button to
update the master agreement.

5.0.10.40 Assoc ia t ions

The Associations tab lists all contracts that are associated to the master agreement. After a contract is
associated with the master agreement, any purchase orders created from the contract go against the
master agreement.

Page 248 of 378 InEight Inc.  |  Release 25.9

Contract User Guide



The values in the banner do not include tax. You can see tax values in the Total tax column on the
Associations register. The tax amount is the sum of the Tax amount field in all line items for associated
contracts. To see a break-down of all taxes that make up the total tax, hover over the information icon
in the Total tax column.

You can associate a new or existing contract to a master agreement from the Associations tab. Bid
package vendor flow to Master agreement vendor upon association.

You can download a purchase order from the Associations tab.

Add a new cont rac t to a master agreement

You can create a contract and associate it to a master agreement in a single procedure.

You can use only those contract types that are allowed to be associated with a master agreement.

1. From the Associations tab, click the Add contract icon, and then select New contract/purchase
order. The Add contract dialog box opens.

2. Enter information in the fields as you would with any contract. The contract type drop-down list
includes only those contract types that are allowed to be associated with a master agreement.
The Vendor field is disabled as is filled with the vendor name from the master agreement.

3. Click Add. The contract Header page opens.

You can then add contract details with any other contract. See Line items tab for information about
adding line items to an associated. contract.

Add an ex is t ing cont rac t to a master agreement

Associate an existing contract to a master agreement

You can associate an eligible contract to a master agreement from the Associations tab.

Contracts are eligible when the contract type allows association with a master agreement and the
vendor is the same as the vendor of the master agreement or has not been assigned.

1. From the Associations tab, click the Add contract icon, and then select Existing
contract/purchase order. The Add existing contract dialog box opens.

2. Select a contract from the list of eligible contracts, and then click Add. The contract is added to
the Associations register. If the contract had no vendor assigned, the vendor in the contract is
updated to the vendor of the master agreement.
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You can add line items from the master agreement. See Line items tab for information about adding
line items to an associated contract.

5.0.10.41 Close out master agreement

When you no longer want contracts to be written against the master agreement, you can close it out.
You can either close out the entire master agreement, which closes all line items, or you can close
individual line items.

Close out master agreement

Close out a master agreement when you no longer want contracts to be written against it. Closing out
the master agreement closes all of its line items. Any existing contracts associated with the master
agreement remain open until they are closed.

You cannot add line items from a closed master agreement even if the contract is already associated to
it.

1. From the Details section on the Header page of the master agreement, change the Status field to
Closed.

2. Click Save. The Update master agreement button becomes the Closeout Master agreement
button.

3. Click Closeout Master agreement to close out the master agreement. The master agreement is
removed from the Agreement ID drop-down list on the Contract header.

4. Click Update master agreement to publish the closure to the associated contracts. The master
agreement is no longer available for use.

Close out a master agreement l ine i tem

Close out a master agreement line item when the line item has run out of resources or for any reason
you no longer want contracts written against the line item.

This function is recommended when the master agreement has multiple line items. If the master
agreement only has one line item, it is best practice to close out the master agreement.
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1. From the line item details, change the value of the Status drop-down list to Closed.

2. Click Save. The line item is no longer available in lists when you add a line item from a master
agreement.
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CHAPTER 6 — CONTRACT
MANAGEMENT

The topics that follow describe these contract management concepts:

l Line item maintenance and management

l Creating and managing vendor change orders

l Logging back charges to the vendor

l Create accrual or goods receipt submissions and reversals

InEight Inc.  |  Release 25.9 Page 253 of 378

Contract User Guide



6.0.1 InEight Contract Workflow – Contract Management

6.0.2 Line Item Management

After you add a line item, Contract adds a line item ID and adds it to the Line items register. The
register lists all line items for the contract, and you can view line item information and copy, edit, and
delete line items.

The total net price is shown at the bottom of the page.

6.0.2 .1 View l ine i tem informat ion

The Line items register includes the following tools to help you quickly see line item information in one
place.

Number Name Description

1 View You can view additional data blocks to show information related to line
items.
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Number Name Description

2 Line error
indicator

A yellow warning icon shows whether an error, such as a missing
required field, exists in the line item. Errors must be fixed before you
can publish a line item. If you try to publish the contract without fixing
the errors, a red warning icon is shown

3 Selection
tools

Show you how many line items in the list are selected and lets you
view only the selected items. You can also click Clear selection to
clear the selections.

4 Errors Shows the number of line items with errors. You can click the n Items
link to view only the line items with errors.

5 Net value The net value of all line items.

6.0.2 .2 View data b locks

You can view the following data blocks to supplement the line item view:

l Budget and commitment

l Schedule of values

l Change orders

l Progress

l Payment forms

l Accruals/receipts
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6.0.2 .3 Copy ing a Line I tem

Select the line item you want to copy and click the copy icon.  You can then choose the sections of the
line item that you want to copy. The system duplicates the line item details of the selected sections. 
This function can be useful when inputting multiple lines on a contract.  After you have copied line
items, you can edit the line item details to reflect any necessary changes.

6.0.2 .4 Edi t ing a Line I tem

There are two ways to edit line item details once a line item has been created or copied. You can edit
line item details in the line item overview page, or you can select the line item you wish to edit and
click the edit line item icon to open the Line item details page for that line item.

You cannot edit the Type field after starting an approval.
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6.0.2 .5 Dele t ing a Line I tem

You can delete a line that has not been published to the PO. Highlight the line item and select the
delete icon.

If you need to delete a line item which has been published to a PO, you would perform the same
process. However, a strike-through will appear on that line item until it is carried through to
your ERP system and processed.

If goods receipt and invoice payments have been applied to the line item, you can delete that
line item without having GR/IR adjustments performed on the back end. Contract line items are
automatically closed when they are deleted. The Deletion, No further delivery, and No further
invoice indicators are sent to the ERP system.

If you see a yellow pencil on a line item it means that this line has never been sent over to your ERP
system.

6.0.3 Vendor change orders

On your contracts, you may need to manage and track contract changes between you and the vendor
(subcontractor or supplier) to account for unforeseen changes that come up during the execution of
the project. In the system, these are called vendor change orders or VCOs, and on each contract
record, you can add VCO records to keep track of these changes.

You manage VCOs by opening a contract’s record and selecting the Vendor Change Order Log tab.
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The Vendor Change Order Log tab lists all the VCOs for your contract. The Totals row at the bottom of
the Vendor CO amount column shows the total of all vendor change orders for the contract.

6.0.3 .6 Unass igned change i tems

The Unassigned Change items field shows the sum of any issue, PCO and CCO pricing items from
InEight Change which have been assigned to the vendor contract, but not yet associated to a VCO. You
can click the link in the Unassigned Change items total to see a list of the unassigned change items that
contribute to the total. You can then click on an issue ID to view details of the change item in InEight
Change.
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You can associate unassigned Change items to a new, existing, or executed vendor change order. To
associate a Change item, select the check box for the item, and then click Associate.

In the Associate Change item dialog box, you can associate the Change item to a new or existing
unpublished vendor change order.

If you have the permission Edit executed vendor change order details, you can select Executed to view
a list of executed vendor change orders. Using the Executed option can be helpful when a change order
was executed without the Change items, and you want to reduce the value of the unassigned Change
items and assign any items that were missed at a later time.

The permission Edit executed vendor change order details can be added in Permissions > Contract >
Contracts > Edit contracts.
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6.0.3 .7 Remain ing to buy

The Remaining to buy field shows the amount left in the unawarded value of the bid package. If the
contract is a project Master Agreement, the Remaining to buy field reflects the difference between the
Master Agreement current value and the sum of the current value of all associated contracts.

6.0.3 .8 Vendor change order (VCO) record

To open a VCO record, click on the hyperlinked VCO ID.

The Vendor change order record contains a header and tabs of information to track your change order.

Field/Section Function

1 VCO total The total cost for the change order agreed upon between you and the
vendor.

2 Remaining
amount to
allocate

The remaining change order cost not covered by the line items on the
VCO. The value of this field must be zero +/- 0.00999 to start
workflow, submit, publish, or execute the VCO. The +/- 0.00999
accounts for differences in decimal precision.

3 Delay days
due to issue

Documents how long of a delay the change order causes.

4 Responsible
party

Tracks who is responsible for the next step in processing the VCO.
Options include (e.g., client, vendor/sub, your company name). These
options are defined by your administrative team.
With the correct permissions, you can change the responsible party.
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Field/Section Function

5 Vendor CO
status

Tracks what step the VCO is on in the change order process. While the
options on the drop-down list are company-specific, examples include:

l Draft
l In review
l Out for signature
l Execute and publish

With the correct permissions you can change the status.

6 Approval
status

Displays the status of the VCO workflow approval.

7 Contract totals
icon

Displays a slide out panel that contains a breakdown of your contract’s
totals.

8 Add
supporting
document

Lets you create a new supporting document or add a supporting
document from the Supporting document list or InEight Document.

9 Notes icon Opens a slide out panel for entering notes related to the contract.

10 Cancel, Save
and Start
Approval, and
Save buttons

Select to cancel, Save and start Approvals or save the VCO.

6.0.3 .9 Vendor change order (VCO) creat ion

The following steps walk you through adding a vendor change order to your contract.

Add a vendor change order

1. From the Contract > Contracts page, click a contract ID or description to open a contract.

2. Click on the Vendor Change Order Log tab.
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3. Click the Add icon to add a vendor change order.

The Vendor change order details page opens.

4. Fill out the vendor change order information.

5. In the banner at the top of the page, select the Responsible party from the drop-down list, and
then enter Draft for the Vendor CO status.

6. Click Save.

The Vendor change order record contains tabs for entering the following VCO details: Details, Schedule
of values, Line Items and Supporting Documents.
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6.0.3 .10 Deta i ls tab

Use the Details tab to enter vendor change order details, terms, associated change items, and back
charges.

Field/Section Function

1 Vendor
change order
details

Where you can enter basic information about the VCO, including
Vendor change order number, Description, Vendor change order
amount, Effective Date, Change order type, and Scope of change.

2 Vendor
change order
terms

Where you can enter terms about the VCO, including vendor change
order inclusions, exclusions, and warranty. You can also configure
ten custom terms in Organization > Settings > Contract custom
labels.

3 Associated
change items

Where you can add issues or existing change items to the section,
indicating the issue status, value type, contributed value, PCO name,
and CCO name. You can also add an existing issue. If the issue has
multiple pricing items, a line for each pricing item is added. The
Contributed value column shows the amount of each pricing item.
Contract converts the contributed value from the project currency to
the contract currency.

4 Back charges Enables you to add a back charge to VCO. Any back charges
associated with the VCO from the Back charges detail page are
displayed here automatically.
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6.0.3 .11 Schedule of va lues tab

The Schedule of values tab contains schedule of value items from the contract-level Schedule of values
page. You can use the schedule items in the vendor change order to provide detail that is not provided
by line items. You can also push values from schedule items to the Line items tab or pull schedule item
values into the Line items tab.

The vendor change order Schedule of values tab format is similar to the contract Schedule of values
tab. It contains the following sections:

Section Description

Current
schedule line
value

The line value in its current state in the contract schedule of values.

Change
order
adjustment

Detailed information about the change order for the scheduled item.

Total revised
value

The total revised value of the schedule item. As you make changes to a
schedule item through a vendor change order, the total revised value reflects
the value after the change order is executed.

See Schedule of values tab for more information about the schedule of values.
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Add new schedule i tems

You can add a new schedule item to the vendor change order schedule of values when the item does
not already exist on the contract-level schedule of values.

1. From the vendor change order Schedule of Values page, click the Add icon, and then select Add
new schedule item. The Add Schedule item slide-out panel opens.

2. Enter the schedule item information, and then click Add.

3. The schedule item is added to the VCO schedule of values with a schedule ID of New.

The schedule item can be edited as needed. After the VCO is executed and published, Contract assigns
a Schedule item ID and adds it to the Contract Schedule of values register.
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Add an ex is t ing schedule i tem

You can add a schedule item that already exists in the contract-level schedule of values to the vendor
change order schedule of values.

1. From the vendor change order Schedule of Values page, click the Add icon, and then select Add
existing schedule item. The Add Schedule item dialog box opens with a list of schedule of value
items from the contract-level schedule of values.

2. Select one or more items, and then click Add. The items are added to the schedule.

You can update the Quantity or Value columns in the Change order adjustment section. When you
update the Quantity column, the value in the Value column is automatically adjusted, and vice versa. If
you want to include the items in the vendor change order, you must push them to the line items tab.

You can also add a schedule of value item from the Vendor change order Line items register. Any line
item type can be copied. After the line items are copied, the schedule of value items show in the
Change order adjustment section of the vendor change order schedule of values and are automatically
associated to the line items. To copy a line item from the Line items register to the schedule of values,
select the line item, and then expand the Copy icon. You can then select To schedule of values. A
notification shows that the line item has been added to the schedule of values.
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The following columns are copied with the line item:

l Contract line item ID

l Description

l UoM

l Quantity

l Unit price

In the Change order adjustments section, the values of the Quantity, Unit Price, and Value columns are
calculated as follows:

l When the line item has a positive net price, a quantity, and a unit price in the Change order
adjustments section, the copied schedule item uses the line item change order adjustments
quantity and unit price.

l When the line item has a positive net price and a quantity in the Change order adjustments
section but no unit price change, the copied schedule item uses the line item change order
adjustment quantity and calculates the unit price as the adjusted net price divided by the
adjusted quantity.

l When the line item has a positive net price and a unit price in the Change order adjustment
section but no quantity change, the copied schedule item uses the line item change order
adjustment net price divided by the change order adjustment unit price to calculate the quantity.

l When the line item has a negative net price in the Change order adjustment section, the copied
schedule item will be value-only.

The Hide in Plan/Progress field in the schedule of values defaults to Yes. You must manually fill in the
remaining fields. The line item is automatically associated to the schedule of values.

Any deleted line items are copied, but they do not have a line item ID.
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Push schedule i tems to the L ine i tems tab

Push schedule items to the Line items tab when you want them to be included in the vendor change
order.

Contract pushes only the line items that are associated to the Contract schedule of values. If there are
schedule items that are not associated to the Contract schedule of values, you must execute and
publish the vendor change order. The Push to line items button is enabled if any of the schedule items
have a Contract line item ID. When the Contract line item ID is blank for all items, the Push to line
items button is disabled, and you cannot push items to the Line items tab.

1. From the Vendor change order Schedule of values page, click Push to line items.

A warning message indicates that the push updates the Line Items tab with values from the
schedule items. If the associated line item has a zero unit price, the message indicates that the
adjustment quantity and unit price cannot be calculated and asks if you want to proceed.

2. Click Yes to push the schedule items to the line items tab. Any value or line item that was added
to the Line Items tab is removed. Contract then pushes only the line items that are associated to
the Contract schedule of values and calculates the line item values. If the line item has a zero
unit value, no values are calculated for the Change order adjustments section of the vendor
change order. You can add them manually.

On the Line items page, the total values are shown in the Net price column in the This submission
section. If there are multiple schedule items tied to the line item, Contract adds them together to
populate the Net price column.

6.0.3 .12 Schedule of va lues tab

Vendor change orders have their own schedule of values pages. You can add a schedule of values, so
you can see the quantity or value the change order has against a component.
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You can add new or existing Schedule items. Items added to this page are added to the Schedule of
values at the contract level only after the VCO is published. When you add a value-only schedule item
to a vendor change order, only the Value field is editable.

After you execute and publish a vendor change order, the Schedule of values tab is a snapshot of the
values at the time of execution.

Impor t and expor t schedule i tems

You can use the VCO schedule of values template to quickly add schedule items and then import them
to a vendor change order. Use the import template to add new schedule items or edit existing items.
For more information about how to use the template, refer to the Instructions tab of the Microsoft
Excel template.

For information about importing, see Imports and exports.

Delete a schedule i tem

When a schedule item is not needed in the contract, you can delete it via the Vendor change order
Schedule of values tab. When you delete a schedule item, the item shows in the register with a
strikethrough, and it cannot be edited. The Schedule quantity and Unit price values are moved to the
Change order adjustment section as negative values. When you execute and publish the vendor
change order, the schedule item is deleted with a strikethrough in the parent contract.

6.0.3 .13 L ine i tems tab

Vendor change order line items show how you are going to apply the amount you indicated in the VCO
to the contract. Under the VCO’s Line items tab, you indicate what line items in the contract pertain to
this change order. After you execute and publish a vendor change order, the Line items tab is a
snapshot of the values at the time of execution.

The Line items tab lets you manage the line items for a vendor change order. The Line items tab is
described below.
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Field/Section Function

1 Line item
details

This section of the register contains the Line item ID, Description, UoM,
WBS, GL account, and Product category. You can scroll to view all the
columns.

2 Current line
value

For line items that already exist, containing their original quantities and
pricing.

3 Change order
adjustments

Displays the adjusted quantities and pricing you add to existing line
items or define on newly added line items.

4 Total revised
line value

The total of the Current line values and Change order adjustments
added together.

5 Remaining
amount to
allocate

As you total up your line items, their total amounts subtract from the
VCO total to give you the remaining amount that needs to be allocated. 

6 Pull from
schedule
items

Lets you pull items from the Schedule of values page to update the line
items.

When a line item has been revised but not published, a Revised line item icon shows in the Line item ID
column for that line item. The icon lets you quickly see that changes have been made to the line item,
and you can decide if you want to proceed with the VCO or payment form.

Line i tems reg is ter

The Vendor change order line items register lists all line items for the vendor change order. Arrows in
the column headers let you collapse or expand the section. Multiple sections can be collapsed. The first
section, which includes the Line item ID, Description, UoM, and Cost center, cannot be collapsed. You
can click the double arrow in the first section to collapse the rest of the sections.
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The bottom of the grid shows the total number of items and the total number of selected items. To see
only the selected items, click View selected. Click Clear selection to deselect all items.

You can rearrange the columns within a section using the Column Selector Builder. To open the
Column Selector Builder, click theManage columns icon. The Available columns section shows all
columns that are available for each section. To add a selection or column, select it, and then move it to
the Selected Columns section. To remove a section or column, select it, and then move it to the
Available columns section. Click Save to apply the changes. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot add columns to the first section in the grid. You cannot move columns
between sections.

You can search for specific available or selected columns. For example, you could search for value
Price, and the search results show all columns called Unit Price and Net Price in all sections.

Vendor change order l ine i tems

On your VCOs, you can indicate the line item breakdown of the agreed upon change order amount in
one of the following ways:
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l Add line items that already exist on the contract and alter them
l Copy line items from the VCO Line items page
l Create new line items to document the change

You must publish the contract before you can bring line items into the VCO or create a new line item
from a VCO.

Executing a vendor change order will update the contract line items, contract total, and the ERP
system purchase order

Enter L ine I tems in to a Vendor Change Order

1. Click the Line Items tab in the Vendor Change Order.

2. Click the Add line item icon, and then select Add existing line item or Add new line item. If you
have a master agreement in place for the contract, you can select From master agreement. For
this step by step, select Add existing line item.

The Add existing line item dialog box opens.
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3. Select a line item.

4. Click Add. The line item is added to your vendor change order

You can also add a line by copying an existing line. To copy a line in the Line items register, select the
line and then click the Copy icon. Select Line item to copy to the register. You can select which sections
you want to copy. You can then edit the line item is needed. The copied line item ID is New. A line item
ID is assigned after the VCO is executed.

Pul l schedule i tems in to the L ine i tems page

After you update the quantities for a submission in the Schedule of values tab, you can pull the items
from the schedule of values to update the line items page.

Considerations: The Pull from schedule items button is enabled if any of the schedule items have a
Contract line item ID. When the line item ID is blank on all schedule of value items, the Pull from
schedule items button is disabled, and you cannot pull items from the schedule of values.

1. From the Line items tab, click Pull from schedule items. A warning message indicates that values
in the line items will be overwritten. If the associated line item has a unit price of zero, the
message indicates that the adjustment quantity and unit price cannot be calculated and asks if
you want to proceed.
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2. Click Yes. The values from the Schedule of values page overwrite the values on the Line items
page. If there are no values on the Schedule of values page, Contract sets the quantity and net
price to 0.00. Any value or line item that is not associated to schedule items is removed. If the
line item has a unit value of zero, no values are calculated for the Change order adjustments
section of the vendor change order. You can add them manually.

Impor t and expor t l ine i tems

A convenient way to add line items is to import them using a line items template. You can also export
line items for reviewing and updating offline. You can import or export from the vendor change order
Line items tab.

Impor t l ine i tems

Contract provides an import template that you can use to enter line items in bulk. From a vendor
change order, go to the Line items tab, and then click the Import data from template icon.
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The Import data from template opens, and you can click Import template to download the template.
InEight updates the template frequently to match the updates to Contract, so it is recommended to
download a new template each time you plan to import.

The first page of the template contains the instructions for the templates. The guidelines describe the
information on the import template, exporting with data, and how to update or add more information
to the existing data. The Template page is where you enter you line items. The columns are color
coded to indicate which columns are system generated, required data, optional data, and ignored data.
You can complete the required areas for the line items. After you complete the spreadsheet, save it
and drag it onto the dialog box, and then click Import to import the line items into contract.

Contract validates the dates based on the person who imports the data. If the dates do not
match the preferences of that person, Contract generates an error in the import history and
removes the date.

Do not change the name of the spreadsheet tabs.

After importing, you receive an email message listing status, the total line items, the total imported,
and number of errors. If the status is pending, click the Review data link to see the line items that have
completed and those with errors. You can correct the lines with errors from the Import history grid,
select them, and then click Import to continue with the import process. The import is reprocessed, and
Contract sends you an email message when the import is completed. The VCO line items tab shows the
lines that were imported with the Line item ID New.

Expor t l ine i tems

The export function lets you export line items with data. If there are no line items in the VCO but there
are line items for the contract, the export template lists all lines tied to the contract. If you add a line
to the VCO and you export with data again, it only pulls the line that you added. The line does not have
a line item ID.

6.0.3 .14 Suppor t ing documents tab

You can add a supporting document a Vendor Change Order by selecting its tab. From the Supporting
Documents tab under the Vendor Change Order tab, the add button now has two drop-down options
to add a New supporting document or From supporting document list. When you add from the
supporting document list, a window is shown with a list of existing documents to choose from.
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When New Supporting document is selected, the Document type is set by default Draft change order
and Vendor change order ID is automatically filled in with the current VCO ID. Vendor change order ID
is also filled if you change Document type to Executed change order.

Selecting the From Supporting document list will show those documents, which are out in the register
and have not yet been assigned a contract. By choosing the documents you need, they will be added to
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the VCO. You can associate a Draft change order or Executed change order supporting document to
multiple VCOs.

Selecting From InEight Document takes you to the InEight Document log-in window, where you can
sign into the application and select a document.

When you remove an approved supporting document from within a VCO, it is still associated to the
contract but not to the VCO. If you want to disassociate a VCO document from a Contract, you must
disassociate it from the Supporting document tab or the Supporting document register.

View a suppor t ing document

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.
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To download the document to your workstation, click Download file.

Create forms or mai l in InEight Document

If a project is associated with InEight Document, you can create a form or mail item from a VCO.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract to Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

Creating forms or mail is initiated from the Actions menu. If Actions > Create document > Form
orMail is inactive, you can select the Settings (cogwheel) icon in the Actions menu to set up
integration with Document.

Create a form in Document

You can create a Client RFI or Request For Information form in Document and add it to the Supporting
documents for the VCO in a single procedure.
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1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.

Create mai l in Document

You can create a mail item in Document and add it to the Supporting documents for the VCO in a single
procedure.

1. From the Details page go to Actions > Create document >Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.
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3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

l To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document sourceMy computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

l To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

l To send mail without an attachment, click Create. The Mail module in Document opens.
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5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

6.0.3 .15 Assoc ia ted change i tems

Often there will be issues or pricing items captured by the foreman or superintendent in the field that
you want to tie to your vendor change order. These issues and pricing items reside in InEight Change,
but you associate them to vendor change orders on your contracts. You can also add a new issue to
associate to your change order. The following Step by steps describe how to associate an issue or
vendor pricing items from a PCO or CCO to your VCO in Contract.

Issues are any potential concern that you want to track and monitor on a project, that may or
may not become change orders. Issues are further defined in the training materials for the
InEight Change application.

Add a new assoc ia ted change i tem

1. From the contract header page, click the Vendor Change Order Log tab.

2. At the Associated issues section, click the Add Icon to add an issue.
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3. Select Add new issue.

4. On the Add a new issue window, fill in the fields, and then click Add.

The issue is now added to the register under Associated change items.

5. Click Save. The issue is now in Change on the Pending issues page if you are not an issue
approver or the Issue log if you are an approver.

Add an ex is t ing change i tem

1. From the Associated change items section of the Vendor change order details, click the Add
issue icon, and then select Add existing change item. The Add Change item dialog box opens.
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2. Select a pricing item. Items in the issue column have pricing that was added at the issue level. If
the Issue column is blank, and there is a value in the PCO or CCO column, the pricing items were
added at the PCO or CCO level.

Adding the issue does not automatically add the PCO and CCO pricing items added at the
PCO and CCO levels. If you want to add the pricing items added at the PCO and CCO levels,
you must select them.

3. Click Add. The pricing items are added to the Associated change items register. If you delete a
PCO later, all rows associated with the PCO are removed.

After pricing items are added, you can click the Add notes icon in the Description column to add a
description. After a description is added and saved, the column shows a View icon that you can click to
see the description of the pricing item.

VCOs created in Change

VCOs can also be created by InEight Change users. VCOs created in Change come in with a Draft status
and are automatically associated with the issue, PCO, or CCO where it was created. The Created by
field is set to the name Service Account for VCOs created in Change.

6.0.3 .16 Pro jec t - leve l Vendor change order log

You can view a log of all VCOs for a project on the Vendor Change Order tab at the project level. The
log provides visibility to all VCOs for all the contracts in the project for tracking purposes, including
those created from InEight Change.
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The register has filtering, column resizing, and information features like other registers in Contract.
Data in the columns are linked to any associated issues, PCOs, or CCOs in Change. You can see
associated issues, PCOs, and CCOs, in the Issue ID, PCO ID, and CCO ID columns.

Click the Information icon to see information about the VCO. The information slide-out panel has links
to the line items, associations, back charges, supporting documents, and contract.

VCOs that were automatically created in Change have the Name Service Account in the Created
by column.

6.0.4 Back Charges

A back charge is a billing for work or costs incurred by one party that, in accordance with the
agreement, should have been performed or incurred by the party originally contracted to do the work.
For example, if you have a subcontractor responsible to move aggregate from one location to another
and their loader goes down, you may have them use one of your own loaders onsite and then back
charge the sub for the hours they used your loader.

Back charges can also be used to assess liquidated damages. You will log back charges under the Back
Charges tab of your contract record. You can associate a back charge to an issue to enable tracking in
InEight Change.

Add a back charge

1. From the Contract > Contracts page, open the Structural Steel contract.

2. Click on the Back Charges tab.

3. Click the Add Back Charge Icon.
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4. Complete the Add back charge page by filling in the following:

l Description: Redo galvanizing
l Date supplier Notified: [Yesterday]
l Date back charge work completed: [Last Wednesday]
l WBS Code: 1087 – Structural Steel
l Back Charge Amount: 5000
l Comments: Galvanizing rubbed off due to improper shipping. Used ABC Co. to
reapply

5. Click Add.

l The back charge is now logged in the register to reference for billing the vendor
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6.0.4 .17 Assoc ia te an Issue to a Back Charge

Frequently, when a vendor receives a back charge, they want to track it in InEight Change. You can
associate an issue from Change to the back charge from the Back charge Details tab. Only one issue can
be associated with a back charge.

Tie an Exis t ing Issue to a Back Charge

After an back charge has been added, you can associate an issue from InEight Change to it.

1. Click the Add associated issue icon, and select Add existing issue.

2. Select an issue from the list in the Add issue page.

3. Click Add.

Tie a New Issue to a Back Charge

After a back charge has been added, you can associate a new issue to it. When you create the new
issue and associate it with the back charge, the issue is added to InEight Change.

1. Click the Add associated issue icon, and then select Add new issue.

2. Use the Add new issue window to add the issue name, issue start date, and a description
of the change.

3. Click Add. The issue shows in the Associated issue grid, but it has not been added to
InEight Change.

4. Click Save. The issue is added to the InEight Change application.

6.0.4 .18 Add Suppor t ing Documents to a Back Charge

On the back charge Supporting Documents tab, you can upload multiple documents, such as email
messages and invoices. Any document that is relevant to the back charge should be uploaded. The
supporting documents can be a file or a link, or can be added from InEight Document.

Add a New Suppor t ing Document

1. Go to the Supporting Documents tab.

2. Click the Add supporting document icon, and then select New Supporting document.
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3. Complete the Add supporting documents page with the following information:

l Title
l Document type
l File or link
l Notes

4. Click Add.

Add an Exis t ing Suppor t ing Document

1. Go to the Supporting Documents tab.

2. Click the Add supporting document icon, and select From supporting document list.

3. Select one or more documents.

4. Click Add.

The supporting documents in the list are associated with a contract. When you disassociate a
contract from the Supporting document register, the back charge is also disassociated

6.0.4 .19 Send back charge documents for eSignature v ia
DocuSign

When a project is integrated with DocuSign, you can send a back charge document to DocuSign for an
eSignature.

DocuSign tags can be embedded in the contract template. The DocuSign tags correspond to DocuSign
recipients configured in the project settings and project contacts.

See 5.0.8 Contract Writer on page 232 for information about sending documents for eSignature via
DocuSign. See 2.0.1 Organization settings on page 21 for information about using tags.

6.0.4 .20 Ass ign a Back Charge to a Payment Form or Vendor
Change Order

You can assign a back charge to either a payment form or a vendor change order by clicking the
appropriate link in the Assignments section of the Back charge Details tab. Assigning the back charge to
a vendor change order or payment form can help you with tracking the back charge through the
system.
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When you assign a back charge to a payment form, it is automatically added to the list of back charges
on the Payment form detail page. The back charge is automatically listed on the Vendor change order
detail page when you associate it with a vendor change order.

6.0.4 .21 Spl i t a Back Charge

You can split a back charge into multiple charges. After the back charge has been split, you can treat
the back charges independently of each other, and associate different issues or assign to payment
forms or vendor change orders.

6.0.5 Accruals/Receipts

After goods or services are provided, you can use the Accruals/Receipts tool to track the associated
cost. If you have a receipt or invoice, you can enter it in Contract to send the cost to your ERP system.
If you have received goods or services but have not yet been invoiced, or you intend to pay for it later,
you can create an accrual.

To access the Accruals/Receipts log, select the Accruals/Receipts tab.

Creat ing a New Accrua l or Goods Receip t

You can create new goods receipts by clicking the Add icon.

To open an existing goods receipt, click on the hyperlinked ID.  You must select the ID of the receipt. 
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The Accrual/Receipts record contains a header with key information and actions.

Field/Section Function

1 Contract The Contract ID and name the accrual or goods receipt is associated to.

2 Vendor The Vendor ID and name on the contract.

3 Description Description of the receipt or accrual.

4 Posting Date This is the date of when the cost will hit the back-end accounting
system or ERP system.

5 Delivery
number

The delivery number of the goods receipt.

6 Supporting
Documents
file/link

Upload or link any items associated to the goods receipt or accrual
(e.g., invoice, material receipt, PO, pictures, etc.).

7 Save and
Submit

Submit the goods receipt or accrual. This will send the registered
quantity or amount to the accounting system/ERP system and adjust
any associated line items. In a proxy ERP environment, this adds the
goods receipt or accrual information to the contract line items in the
accrual/receipt view set. Contract sends accruals to InEight Control only
after they have been submitted.

8 Save This will save the goods receipt or accrual information as a draft. No
information will be sent to the accounting system/ERP system. In a
proxy ERP environment, no information is added to the accrual/receipt
view set.

Overview – Accrual/Receipts Record Header
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The following steps walk you through adding a goods receipt using the accruals/receipts tool.

Add an Accrua l or Goods Receip t

Summary: Add a goods receipt when the goods or services have been delivered. Add an accrual when
the goods have been delivered, but you have not yet received an invoice and want to post the costs in
the current month.

1. From the Contracts register, select the Accruals/Receipts tab.

2. Click the Add icon. The Add new item dialog box opens.

3. Select the Accrual or Receipt item type, and then enter a description, contract ID, and posting
date.
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When creating a goods receipt, the Contract drop-down list shows only contracts with line
items that are expecting a goods receipt.

When creating an accrual, the Contract drop-down list shows all contracts containing line
items.

4. Click Save. The Accruals Receipts Line items page opens.

5. Click the Add icon to add line items from the contract previously selected.
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6. Select the line items you want to add to the goods receipt or accrual.

7. Click Add. You can see the following details: Line ID, Line Description, Type, PO Qty, and unit of
measure (UoM). If you are adding a goods receipt, the following values are also shown:
previously received quantities, quantity, receiving amount, ERP system status, and ERP system
document ID. If you are adding an accrual, the following values are shown: previously received
quantities, accrual type, accrual GL account, accrual amount, ERP system status, and ERP system
document ID

When creating a goods receipt, if a line item has been tagged in the contract as not
requiring a goods receipt, or if a line item has been fully received, it will not populate in
the list of available line items.

When creating an accrual, all the line items that have not been paid out in full are
available for selection.

8. If you are adding a goods receipt, enter the value received in the in the quantity field. If a
submitted goods receipt has quantities that were entered in error, you can enter a negative
quantity up to the amount that has already been received. The receiving amount will auto
calculate based on the quantity entered, multiplied by the unit price.

If you are adding an accrual, enter an amount in the Accrual amount column.
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9. Optionally attach a copy of the receipt or invoice to the goods receipt or accrual. Click the Add
attachment link in the right side of the header. The Add supporting document dialog box opens.

10. Upload or link files via a URL, and then click Save.

This opens a window where a document can be uploaded or linked to via URL.

11. Click Save or Save and submit.
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What's next: In the Accruals/Receipts register, you can now see the receipt total and status have been
updated .

6.0.5 .22 Edi t ing an Accrua l or Goods Receip t

There are two ways to edit an accrual or goods receipt once a line item has been created. You can edit
the accrual or goods receipt by clicking the corresponding ID, or you can select the item you wish to
edit by checking the leftmost box and clicking the edit icon adjacent to the add icon.

6.0.5 .23 Dele t ing an Accrua l or Goods Receip t

You can delete an accrual or goods receipt which has not been submitted. Select the line item you
would like to remove and click the Delete icon. Accruals and goods receipts cannot be deleted once
submitted. To adjust a submitted accrual or receipt, a reversal must be done. This is covered in the
reversals section of accruals and receipts.
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6.0.5 .24 Revers ing an Accrua l /Goods Receip t

If an accrual or goods receipt has been submitted, it can no longer be adjusted or deleted. Instead, a
reversal can be made. Reversals send a negative amount equivalent to the original accrual or goods
receipt. This is an all-or-nothing process, intended to keep accruals and receipts clear cut regarding
submissions and changes made with the ERP system or accounts payable.

In i t ia t ing a Reversa l

1. From the Contract > Contracts page, open the Accruals/Receipts tab.

2. Select the line item for reversal and click Reverse Submission.

l A new page opens with the reversal information
l You may change the description to signify it is a reversal

3. Make any additional adjustments to the posting date and supporting document as needed.

4. Click Save and submit when done for submission to the ERP system or proxy ERP.

l A new Line Id appears in the Accrual/Receipts register with the reversal

InEight Inc.  |  Release 25.9 Page 295 of 378

Contract User Guide



Negat ive goods rece ip ts

If the values were entered in error, instead of reversing a goods receipt, you can back out the error by
adding a line with a negative quantity up to the amount that has already been received. For example, if
you submitted a goods receipt for a line item with a quantity of 100 and it needs to be adjusted to a
quantity of 10, you can create a goods receipt for a quantity of -90. After the goods receipt is
submitted, Contract automatically calculates the submitted receipt amount accordingly.

A goods receipt must already be submitted before you can create a goods receipt for a negative
quantity.
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CHAPTER 7 — PAYMENT
MANAGEMENT

The following topics describe payment forms and how to track payment progress.
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7.0.1 InEight Contract Workflow – Payment Management

7.0.2 Invoices

Invoices for a project can be added to the Invoices register. Invoices must be associated with both the
contract and the actual pay form. Invoices can be added at a project level, assigned to a contract and a
payment form on a later date. This helps businesses to manage an influx of invoices.

7.0.2 .1 Invo ice reg is ter

The Invoice register shows a list of all invoices associated with a project, including ERP system,
contract, invoice, payment form, and vendor-submitted invoice information. You can use the Invoice
type columns to quickly identify whether the invoice is a standard invoice or a retention release
invoice.

You can add standard invoices and retention release invoices into the invoice register and then assign
them on a later date. See Invoice attachments for more information about standard and retention
release invoices.
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Add an invo ice

Summary: Add an invoice to a project when a vendor has sent an invoice and you must add it
manually.

You can associate the invoice to a contract when you create the invoice or on a later date. An invoice
must be associated before it can be converted to a payment form.

1. From the Invoices register (Contract > Invoices), click the Add invoice icon. The Add invoice
dialog box opens.

2. Add the invoice information, including the invoice file or link, and then click Add if you are only
adding one invoice or Add and new if you want to add more invoices.

You cannot link to password-protected PDF documents.

3. Repeat step 2 as needed. If the Vendor invoice status column is used in the register, the invoices
have a vendor status of Not applicable.

If you did not assign a contract to the invoice, you can edit the invoice later.

To edit an invoice, select it, and then click the Edit icon. The Edit invoice dialog box opens, and you can
add or edit the contract or edit any other field.

To assign an invoice to a payment form, select one or more invoices, and then click the Convert invoice
icon. You can assign the selection to an existing payment form or convert to a new payment form..
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In a proxy ERP environment, you can only put one invoice on a payment form.

7.0.2 .2 Invo ice notes

To add a note to an invoice, select an invoice, and then click the Notes/feed icon. You can then add
notes to the Invoice tab of the Notes/Feed slide-out panel.
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Notes added to the Invoice tab show for the invoice only. You can add a note for the contract on the
Contracts tab of the slide-out panel.

If a vendor has submitted the invoice into Contract from the Vendor contract summary page, notes
from the vendor show with a blue bar on the left side of the note. When you add a note to a vendor-
submitted invoice, you can specify whether the note is sent to the vendor by selecting the Send note to
vendor check box. If the check box is not selected, the note is internal only. See Working with vendor-
submitted invoices for information about vendor-submitted invoices.

7.0.2 .3 Work ing wi th vendor-submi t ted invo ices

When you select a pending invoice, the Decline and Received buttons become enabled. Click Received
to accept the invoice or Decline to reject the invoice and send it back to the vendor. These buttons are
disabled when you select multiple invoices or an invoice created in the project.

When you click the Decline button, the Reject invoice dialog box opens. You must then enter a note
describing why the invoice was rejected, and then click Save to save the rejection and send it to the
vendor. The invoice remains in the register with a status of Declined until the vendor users recalls it.
After the vendor recalls the invoice, it is no longer shown in the register.

When you click the Received button, the Receive invoice dialog box opens. After you add an approval
note and click Save, the Vendor status column shows the Received status, and the invoice can be
added to a payment form like an invoice that was created in the project.
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7.0.3 Payment Forms

7.0.3 .4 Overv iew

An InEight Contract payment form is the form used to communicate with the Accounts Payable team,
to ensure that invoices are paid. The payment form allows the Contract Manager to identify the work
period represented by the invoice and to which line items the invoice should be applied. 

As invoices are received at the jobsite, you can attach them to your payment form and allocate how
much of the invoice will go towards your contract line items. As the contract manager, you can then
submit the payment form for approval. Once the payment details are reviewed to validate the charges
are correct and approved according to the project’s workflow assignments, the payment form will
directly sync to your ERP (Accounts Payable) system for accounts payable to process. The ERP system
will then send back an APAY number for reference on your payment form, along with the status of the
invoice in the ERP system.

The following diagram illustrates the typical workflow for processing payments between InEight
Contract and your ERP system.

Payment Workflow – InEight Contract and ERP

In a proxy ERP environment, the payment form is used to track line items for an invoice. Responses,
such as status, are autogenerated.
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The payment form is initiated at the project level, routed to your Business Services team for approval,
and then submitted to Accounts Payable.  A goods receipt or service confirmation must be completed
(if required) before the Accounts Payable team will approve the pay form.

7.0.3 .5 Add a Payment Form

The following steps walk you through how to add a new payment form to your contract.

Add a payment form

You can add a payment form when all invoices are received, and you want a standardized form to
submit for approval.

1. On the Contracts register, select a contract.

2. Select the Payment forms tab, and then click the Add payment form icon.

The Payment form details page opens.

3. Enter payment form information.

4. Click Save.

If you leave the Payment form details page without saving, the details you added are
discarded.

The default payment form automatically downloads as the cover letter.
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Field/Section Function

1 Net payable The total amount you are paying to the vendor towards the invoices on
this payment form.

2 Remaining to
allocate (pre-
tax)

The total amount of this payment form’s invoices that are not yet
allocated to contract line items. The value of this field must be zero +/-
0.00999 to start workflow, submit, publish, or execute the payment
form. The +/- 0.00999 accounts for differences in decimal precision.

3 Previous gross The total amount from the invoices of all payment forms submitted
before the one you are currently on.

4 Current gross The sum of the invoices attached to the payment form you are on.

5 To-date gross The total of all invoices on all this contract’s payment forms. This is the
sum of your Previous gross and To-date gross amounts.

6 Percentage
complete

The percentage that the To-date gross is of your total contract amount
(contract Current value).   

7 Payment form
status

Indicates if the payment form is new, in review, or submitted.

8 Tabs The payment form is organized into three tabs: Details, Invoice
Attachments, and Line Items.

9 Download
payment form
as PDF

Provides a PDF summary of the payment form, including line items,
invoices attached, back charges, and approvers. This summary
becomes the cover sheet for Accounts Payable when the form is
submitted.

10 Cancel, Save
and start
approval and
Save Buttons

These buttons allow you to cancel, save and begin approval or save
the payment form.

Overview – Payment Form Header
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Field/Section Function

1 Tabs Tabs that let you add invoice attachments, line items and supporting
documents to payment forms.

2 Toolbars Tools that let you do the following:
l Download a payment form.
l View contract totals.
l Add a supporting document.
l View and add notes. The Notes slide-out panel has tabs for
Contract notes, Supporting document notes, and Administrative
notes. Administrative notes are captured automatically when an
administrator makes changes to a payment form record or invoice
on the Payment progress tab.

2 Actions menu Lets you generate a payment form document.

3 Payment form
details

Where you can input or review the payment form’s basic information,
including: description, work completed dates, progress estimate
number and billing period, and comments.

4 Summary Summarizes the total gross amount of the invoices attached to the
payment form, less retention and back charges, resulting in the Net
amount payable this request, which is the amount you will pay to the
vendor.
The Progress estimate number and Billing period fields in invoices that
are associated to a payment form are manually entered by the user in
the payment form. If the information is different from the values from the
ERP system, Contract updates the fields with what was sent from the
ERP system.

5 Back charges Allows you to apply back charges from your contract’s Back Charges
tab to the payment form, to short-pay the invoice according to the back
charge amounts. 

Overview – Payment Form – Details Tab
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When the Progress estimate number and Progress estimate billing period fields are required for
the payment form, you can still save the form. The fields are required for submittal and
workflow. When the status of the payment form is New, a yellow warning icon shows next to
the Progress estimate number and Progress estimate billing period fields to remind you that the
fields are required for approval and submission.

7.0.3 .6 Overv iew – Schedule of va lues tab

The Schedule of values tab contains schedule of value items from the contract-level Schedule of values
page that you can use to build a payment form. Using a schedule of values to populate a payment form
gives you the flexibility to create a payment form based on the values claimed in a specific period. For
example, you could use the schedule of values to track the values used in a month. You can then push
the values to the Payment form Line Items tab, so you pay against the line items.

The payment form Schedule of values tab format is similar to the contract Schedule of values tab. It
contains the following sections:

Section Description

This submission The values used in this payment form.

Pending
submission

The values used in previous payment forms that are not in Submitted
status.

Previous
submissions

The values used in previous submissions that have been submitted.
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Section Description

Current total The sum of values in the This submission and Previous submissions
columns.

Remaining The Schedule quantity column in the Schedule of Values items section
minus the current total.

See 5.0.5 Schedule of values tab on page 200 for more information about the schedule of values.

Add schedule i tems

Add a schedule item to the payment form schedule of values to use in creating a payment form.

You can add schedule items that have already been added to the contract-level schedule of values.

1. From the Payment form Schedule of values page, click the Add icon. The Add schedule item
dialog box opens with a list of schedule of value items from the Contract schedule of values,
including the value remaining and the percent complete.
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2. Select one or more items, and then click Add. The items are added to the schedule.

3. Update the Quantity or Value columns in the This submission section. When you update the
Quantity column, the value in the Value column is automatically adjusted, and vice versa.

You can push the schedule of value items to the Line items tab. From the Line items tab, you can also
pull the items from the schedule of values.

Push schedule i tems to the L ine i tems tab

You must push the schedule items to the Line items tab, so they can be included in a payment form.

Considerations: The Push to line items button is enabled if any of the schedule items have a Contract
line item ID. When the Contract line item ID is blank for all items, the Push to line items button is
disabled, and you cannot push items to the line items.

1. From the Payment form Schedule of values page, click Push to line items. A warning message
indicates that the push updates the Line Items tab with values from the schedule items.

2. Click Yes to continue. All schedule items are pushed to the line items. Any value or line item that
was added to the Line Items tab is removed.

Contract pushes only the line items that are associated to the Contract schedule of values and
calculates the line item values. On the Line items page, the total values are shown in the Net price
column in the This submission section. If there are multiple schedule items tied to the line item,
Contract adds them together to populate the Net price column.
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7.0.3 .7 Prev ious, Current , and To-Date Gross Amounts

To follow along, select Contract > contracts > Payments forms tab and select a form which you just
completed.

The Previous gross, Current gross, and To-date gross amounts displayed in the payment form header
help you keep track of how much you have been invoiced.

Previous gross represents any invoices already submitted on previous payment forms. When you fill
out your first payment form for the contract, your Previous gross will be $0.00 since no previous
payment forms are submitted.

Your Current Gross is the total amount of the invoices you’ve added to your current payment form.

Once you’ve submitted the first payment form, when you add a second payment form to the contract,
the Current gross from your first payment form becomes the Previous gross amount.

The Current gross ($20,000.00) is the total of the invoices attached to your current payment form, and
the To-date gross amount is the total of all invoices on all your payment forms to date.
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7.0.3 .8 Invo ice at tachments

Invoice attachments associate an invoice you receive from a vendor to a payment form. You can add
standard invoices or release retention invoices and track them on the Invoice attachments tab. The
values you enter in the invoice attachment are used to populate the values in the header.

Retention release invoices help you manage retention release activities. Using a retention release
invoice lets you follow your regular process for submitting standard invoices and requesting retention
release, without leaving Contract.

Field/Section Function

1 Invoice details Shows the invoice information you enter when adding the invoice,
including invoice number, date, amount, tax, and invoice total, and
retention release requested.

2 Taxes The Total tax column shows a sum of all tax columns. The subsequent
tax columns are the active project-level tax types. You can hover over
the Information icon in the Total tax column to see a summary of all
taxes.

3 File/Link References the link to or file name of the invoice When you click the file
name to access it, the document opens a preview in a new tab, so you
can view the pages. The preview lets you view all pages of the
document by clicking the Previous and Next buttons. If you want to
download the document, click the Download file button in the preview.

4 Record ID and
Invoice status

These fields update with the number and status of the payment form
once it is processed, so you don’t have to manually search for it. The
status updates every time you open the payment form.

5 Estimated
posting date

For organizations that use a proxy ERP, this column lets you define your
own posting date instead of using the submitted date. If you are relying
on the integration with InEight Control for actuals, using the estimated
posting date with your proxy ERP can prevent incorrect actuals in
Control. When you use an ERP system, the ERP system provides the
posting date regardless of the value of this field. You must have
permission edit payment form to update the Estimated posting date
column. The actual posting date is on the Payment progress tab.

Overview – Payment Form – Invoice Attachments Tab
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Add a standard invo ice at tachment

Summary: Add a standard invoice attachment to a payment form when the payment is not for
retention release. The invoice provides the Invoice pre-tax remaining to allocate and Net payable
amounts required to submit a payment form.

Considerations: Taxes calculated on the gross and on the net show in the dialog box. Payments for
retention release must use a separate invoice attachment.

1. From the Invoice attachments page for a payment form, click the Add invoice icon, and then
select Add new invoice. The Add new invoice dialog box opens.

2. Enter the invoice information.

3. Click Add. Alternatively, you can click Add and new to add additional standard invoices. The Net
payable and Invoice pre-tax fields in the Payment forms header are updated with the amount of
the invoice.

What's next: You can submit the payment form. After the payment form has been submitted and
posted, invoice attachments can no longer be deleted.

Add a retent ion re lease invo ice at tachment

Summary: Add a retention release invoice attachment to a payment form so you can submit a payment
form specifically for retention release. The invoice provides information for the Retention release
remaining to allocate amount required to submit a payment form for retention release.

Considerations: Only taxes calculated on the net show in the dialog box. The retention amount cannot
be greater than the total of the retention withheld.

1. From the Invoice attachments page for a payment form, click the Add invoice icon, and then
select Add retention release invoice. The Add retention release invoice dialog box opens.
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2. Enter the invoice information.

3. Click Add. Alternatively, you can click Add and new to add additional retention release invoices.
The Net payable and Retention release Remaining to allocate fields in the Payment forms header
are updated.

What's next: You can submit the payment form. After the payment form has been submitted and
posted, invoice attachments can no longer be deleted.

7.0.3 .9 Schedule of va lues tab

The payment forms function has its own schedule of values page. You can add a schedule of values, so
you can see the quantity or value the payment form has against a component.

You can add or edit existing schedule items. Edits to schedule items show in the Schedule of values at
the contract level. When you add a value-only schedule item to a payment form, only the Value field is
editable.

After you submit a payment form, the Schedule of values tab is a snapshot of the values at the time of
submittal.

Impor t and expor t schedule i tems

You can use the payment form schedule of values template to quickly add schedule items and then
import them to a vendor change order. Use the template to update the amount that will be submitted
for payment on this payment form. For more information about how to use the template, refer to the
Instructions tab of the Microsoft Excel template.

For information about importing, see Imports and exports.

7.0.3 .10 L ine i tems tab

The Line items tab for a payment form shows the line items that are paid with the payment form. With
any invoice, it is important to pay on the correct line items of your contract that you are being invoiced
for. If for some reason you or your team receive an invoice that has line items on it that are not on the
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contract, you must verify that these charges are in fact correct. You will then need to determine if your
company's policy on change orders should be followed.

After you submit a payment form, the Line items tab is a snapshot of the values at the time of
submittal.

Overv iew – Payment Form – L ine I tems Tab

Field/Section Function

Details Provides detailed information for the line items added to the payment form.

This
submission

The total net amount and quantity allocated for this payment form. When you
enter the Net amount, the Quantity, Tax, and Retention are automatically
calculated. The tax column calculates a proportional estimate of the line item
taxes based on the taxes received in the purchase order response or
manually uploaded via a Logic Apps file, and whether the tax type should
calculate on net price or gross amount. These taxes are shown as a total and
hovering over the information icon shows the individual taxes. When the
payment form is for retention release, you can enter the value in the
Retention release column. See Payment form submittal for information about
submitting payment forms.

Pending
submissions

The total amount and quantity allocated to this line for pending payment
forms.

Previous
submissions

The total net amount and quantity allocated to this line item from previously
submitted payment forms.

Current total Calculates the total quantity and net amount allocated to the line item from all
payment forms (previous and current) on the contract, along with the
percentage of the total line item amount that has been allocated. 

Remaining Calculates the total quantity, amount, and retention release remaining for this
line in the payment form.

Pull from
schedule items

Lets you pull items from the Payment form Schedule of values tab into the line
items. The values on the Line items page are overwritten. A warning message
indicates that values in the line items will be overwritten. When you click Yes,
the values from the Schedule of values page overwrite the values on the Line
items page. If there are no values on the Schedule of values page, Contract
sets the quantity and net price to 0.00. Any value or line item that is not
associated to schedule items is removed.

Overview – Payment Form – Line Items Tab

InEight Inc.  |  Release 25.9 Page 313 of 378

Contract User Guide



You can use the arrows in the column headers to collapse or expand the section. Multiple sections can
be collapsed. The first section, which includes the line item ID, description, and WBS, cannot be
collapsed. You can click the double arrow in the first section to collapse the rest of the sections.

You can rearrange the columns within a section using the Column Selector Builder. To open the
Column Selector Builder, click theManage columns icon. The Available columns section shows all
columns that are available for each section. To add a selection or column, select it, and then move it to
the Selected Columns section. To remove a section or column, select it, and then move it to the
Available columns section. Click Save to apply the changes. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot add columns to the first section in the grid. You cannot move columns
between sections.
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Pul l i tems f rom schedule of va lues

You can pull items from the Payment form Schedule of values tab into the line items. When you click
the Pull from schedule items button, the values on the Line items page are overwritten.

A warning message indicates that values in the line items will be overwritten. If there are no values on
the Schedule of values page, Contract sets the quantity and net price to 0.00. Any value or line item
that is not associated to schedule items is removed.

Pul l i tems f rom schedule of va lues

You can pull in schedule of value items to the line items page to update line item values.

The values from the Schedule of values page overwrite the values on the Line items page. If there are
no values on the Schedule of values page, Contract sets the quantity and net price to 0.00. Any value or
line item that is not associated to a schedule item is removed. The Pull from schedule items button is
enabled if any of the schedule items have a Contract line item ID. When the line item ID is blank on all
schedule of value items, the Pull from schedule items button is disabled, and you cannot pull items
from the schedule of values.

1. From the payment form Line items page, click Pull from schedule items. A message warning that
the values in the line items will be overwritten is shown.
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2. Click Yes. The values from the Schedule of values page overwrite the values on the Line items
page.

Impor t and expor t L ine i tems

You can use the payment form Line items template to quickly add line items and then import them to a
payment form. Use the template to update the amount that will be submitted for payment on this
payment form. For more information about how to use the template, refer to the Instructions tab of
the Microsoft Excel template.

For information about importing, see Imports and exports.

7.0.3 .11 Payment forms reg is ter

When you are on a payment form record, you can go back to the payment forms register page, by
clicking on the Contract title in the breadcrumbs.

On the Payment forms register, you can check the status of all the payment forms on the contract. The
Unassigned invoices field in the toolbar shows the total amount of invoices from the Invoices register
that have been assigned to the contract but have not yet been added to a payment form in the
contract. The totals bar shows the sums of the Current gross, Retention, Net earned, Back charge
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amount, Tax, and Net Payable columns. The active project tax types show in columns on the Payment
form register.

To make scrolling through a large number of payment forms easier, you can click the Export icon to
export the information on the Payment Form register to a Microsoft Excel spreadsheet.

From the Contract Line Items tab, you can change the Viewset to Payment forms and the Payment
forms data block appears, so you can see how much of each line item has been submitted for payment.

Edi t payment forms f rom the Payment forms reg is ter

Users with the Edit payment progress permission can edit payment forms from the Payment forms
register.

Edi t payment forms f rom the reg is ter

Edit one or more payment forms when you must make changes to the payment to keep Contract in
sync with an ERP system.

You can make changes to the Payment form status, Record ID, Record status, and Notes fields only.
Changes made on the Payment forms tab affect the Payment forms tab only. They do not affect the
Payment progress tab. When you edit the Payment form tab, no APIs are triggered, so duplicate items
are not created and submitted to the ERP system.
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1. Select up to 10 forms, and then click the Edit icon. The Edit payment form slide-put panel opens.

2. Make changes to the Payment form status, Record ID, Record status, and Notes fields for each
payment form.

3. Click Save.

The changes are recorded on the Administrative notes tab of the Notes slide-out panel.

Delete a payment form

You can delete a payment form when it is not needed or has been entered in error. Payment forms
cannot be deleted if they have been submitted and posted, that is, the payment form has been
assigned a document ID by the ERP system.

Delete a payment form

Summary: Delete a payment form when you have no plans to submit the form and no longer want it to
show in the Payment forms register.
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Considerations: The payment form cannot have been submitted and posted.

1. From the Payment forms register, select the payment form you want to delete.

2. Click the Delete payment form icon.

3. Click the Yes button in the confirmation box. The payment form is removed from the register.

What's next: You can view a note indicating that the payment form has been deleted in the
Administrative Notes tab of the Payment form register's notes panel.

7.0.3 .12 Generate a payment form document

You can generate a payment form document from selected templates. The templates are specific to
payment forms and are configured in the project settings.

Generate a payment form

Generate a payment form when you want a document that has more information than what is
supplied in the payment form download. Payment form documents are saved in the Payment forms
Supporting documents tab.

You must have templates with the template type Payment Form. If no templates of this type are
available, you can click the Settings icon in the payment forms wizard to go to the Contract templates
page of the project settings to add templates.

1. From any page in a payment form, expand the Actions menu, and then select Generate Payment
form. The Payment forms wizard opens.

2. Select the Payment form templates you want to use from the Available templates column and
move them to the Selected templates column.
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Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

3. In the Contract template details section, choose one of the following in the Generate document
as field:

l Individual documents to get a separate PDF or template file type document for each
template you selected.

l Merged document (PDF only) to merge the templates into a single PDF document.

4. Use the toggle to indicate whether to save the contract document in the Supporting documents
tab for the payment form. If you choose to save in the Supporting documents tab, add the name
of the document.

5. Select the watermark text. If the organization-level settings require a watermark and the end
watermark event has not occurred, the Select watermark stamp field is required. If the end
watermark event has occurred, the watermark is optional.

6. Click Next. The Review templates page shows the templates in the order you selected them.

7. Choose the template you want to review from the Review templates list. The template tags show
as fields in the display area. The message, "No general tags found in this template" in the display
area can indicate that the table consists of only collection tags. If the Allow users to edit the
document during creation toggle in the template details is set to No, the fields on the Review
page are disabled.
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The Review templates dialog box lets you edit or add information to the fields that populate the
document after it is generated. Any field that is blank is not added to the document, and you
cannot add information later.

8. Make changes and additions to the payment form information. Use the Review templates list to
select the next template, and then make changes. Changing data in Review contract fields
updates the data published in the contract document but does not update the data field in
Contract.

9. After you have reviewed all changes, you can click Preview document to see a preview of your
document. The preview opens in a separate window with the tags filled in. If you used collection
tables in any of your templates, you can view them in the preview document. The content of the
preview varies as follows:

l If you selected Download as a PDF document when you generated the document, the
preview contains all the templates in the order you specified.

l If you selected Download as individual documents when you generated the document, the
preview contains only the template that showed when you clicked Preview document. You
can preview other documents by selecting the file from the Review templates list, and
then clicking preview document.

10. Click Finish. If you created a merged document, Contract writer downloads a PDF that includes
all the templates. If you created individual documents, Contract writer downloads a PDF or
original file type for the selected template only.

If you chose to save the document to the Supporting documents tab, the document is saved to the
Payment forms Supporting documents tab with type Payment request. It is not saved to the project-
and contract-level Supporting documents tabs.

7.0.3 .13 Payment form download

From the Payment form record, you can download a PDF summary of your payment form, which
includes the following information:

l Summary information
l Contract number, current value and work completed dates
l Gross amount this request
l Net amount this request
l Net payable this request
l Line items
l Back charges
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l Invoice attachment
l List of supporting documents
l Approvers

Downloading a PDF version of your payment form allows you to see how the payment form will look
for Accounts Payable and gives you an opportunity to verify the Gross amount this request amount
matches the Invoice amount (pretax).

To download the PDF, click on the Download payment form as PDF icon on the right toolbar.

7.0.3 .14 Payment form submi t ta l

The process for submitting your payment form depends on whether you have an approval workflow
set up on your project or contract level Workflow Assignments tab. See Workflow Assignments for
more information on how to set up an approval workflow.)

When you are ready to submit a payment form, you must update the columns in the This submission
section of the line items tab for the payment form.
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l If you are submitting a payment form with a standard invoice, update the value in the Quantity
or Net price column for the line item.

l If you are submitting a payment form with a retention release invoice, update the value in the
Retention release column for the line item.

VIDEO | Retention Release via Payment Form
After the payment form is submitted, Contract saves and stores snapshots of the Schedule of values
and Line items tabs, so you can see the values at the time of submission. These values can help you
track progress.

After the payment form has been submitted and posted, you can no longer delete an invoice
attachment or the payment form.

Submi t ta l w i thout Workf low Ass ignments

If your company has not enabled workflow assignments, the submittal process is managed from the
Payment form status drop-down list on your payment form record. From the drop-down list, you can
keep track of the payment form’s status by selecting either New, In Review, Submitted, or Dropped.

Selecting Submitted will send the payment form automatically to your ERP (Accounts Payable) system
for processing. Once submitted, you cannot recall the payment form, and you can no longer make
changes the form.

Submi t ta l w i th Workf low Ass ignments

Note that even before starting the approval process, you still have access to the Payment form status
drop-down list, but it is limited to only the New, In Review, and Dropped options.
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This allows you to track the progress of the payment form prior to sending it off for approval.

With workflow assignments enabled for your payment forms, once your payment form’s invoice
amount is allocated to your contract line items, submittal of your payment form begins by clicking the
Save and start approval button, located next to the Save button on the top right of the page.

After you click on the Save and start approval, the following occurs:

l Email notification is sent to the first approver in the workflow assignments specified for
your project or contract. The default payment form downloads as the cover letter. If no
payment form is marked as a default, Contract uses the standard payment letter provided
with the product.
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l The approver can view the payment form by clicking the appropriate link within the email
l When you start the approval process and you are the first approver in the approval
workflow, the first step of the workflow is automatically approved, and continues with the
next step, if applicable. If you are the only step in the approval, you receive a second email
confirming the new issue has been approved.

l Any invoices that were attached to the payment form are added to the attachment
l Once reviewed, the approver can approve or reject the payment form by clicking on the
appropriate link within the email

l Once approved, the next approver receives email notification to view and approve or reject
the payment form

l When the final approver approves the payment form, it is sent automatically to the ERP
system (Accounts Payable) for processing.

Once submitted, you cannot recall the payment form, and you can no longer make changes to
the form.

At any time during the approval process, you can:

l Recall the payment form. You do this by clicking on the Save and recall approval button on
the payment form record
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l Check which workflow step the payment form is on by hovering over the three blue dots
Approval status

Auto submission fails when the retention on a line item across payment forms is more than the total
retention withheld.

Overpayment to lerance

When you attempt to overpay a line item, Contract shows notifications and acts according to settings
for the contract type set at the organization level.

The contract type configuration setup (organization > Settings > Contract > Configurations > Contract
type configuration setup) has an Allow overpayment of line items toggle for each contract type. When
the toggle is set to No, overpayment of line items is not allowed. When the toggle is set to Yes,
overpayment is allowed with either unlimited overpayment or with a maximum percentage of
overpayment tolerance.

When the toggle is set to No and you try to submit a payment form, either through workflow or
manually, that exceeds the amount of the line item, a red warning message shows, and the form is not
submitted.

When the Allow overpayment online items toggle is set to Yes, and you have entered a percentage
instead of checking the Unlimited check box, Contract validates that the total of all submitted payment
forms does not exceed the overpayment percentage before submitting the form. A red warning icon is
shown on the Line items tab of the payment form. If the project is set up for auto submission, the
payment form is not submitted.
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When multiple payment forms are submitted on a line item, and one of the payment forms changes
the overpayment calculation to exceed the overpayment tolerance, auto submission of the form fails,
even if it had been approved. For example, if the overpayment maximum percentage is set to 25% and
the line item is $1000, the overpayment tolerance is $250 for a total of $1250. If you send a payment
form through workflow for $750, it is under the $1000 and, if approved, can be submitted. However, if
another payment form for $750 had already been sent through workflow, and your payment form is
approved, it is not submitted because the total paid is $1500 and exceeds the overpayment tolerance.

Contract sends an email to let you know the submission failed due to the overpayment tolerance.

7.0.3 .15 Suppor t ing documents tab

The Supporting documents tab contains all the documentation for a payment form in a single location
so you can view documents in one place. You can add a new supporting document, a document from
the Supporting documents list, or a document from InEight Document.

Documents added directly in the Payment for Supporting documents tab do not show in the main
Supporting Documents register by default. If you want them to show in the main register, you can add
them there and then associate them to a payment form by adding a document from the supporting
document list.

See 5.0.6 Supporting documents on page 221 for more information about how to add and approve
supporting documents.

View a suppor t ing document

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.

InEight Inc.  |  Release 25.9 Page 327 of 378

Contract User Guide



To download the document to your workstation, click Download file.

Send payment form documents for eSignature v ia DocuSign

When a project is integrated with DocuSign, you can send a payment form document DocuSign for an
eSignature.

DocuSign tags can be embedded in a payment form supporting document. The DocuSign tags
correspond to DocuSign recipients configured in the project setting sand project contacts.

See 5.0.8 Contract Writer on page 232 for information about sending documents for eSignature via
DocuSign. See 2.0.1 Organization settings on page 21 for information about using tags.

Create forms or mai l in InEight Document

If a project is associated with Document, you can create a form or mail item from a payment form.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract to Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.
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Creating forms or mail is initiated from the Actions menu. If Actions > Create document > Form
orMail is inactive, you can select the Settings (cogwheel) icon in the Actions menu to set up
integration with Document.

Create a form in Document

You can create a Client RFI or Request For Information form in Document and add it to the Supporting
documents for the payment form in a single procedure.

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.

Create mai l in Document

You can create a mail item in Document and add it to the Supporting documents for the payment form
in a single procedure.
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1. From the Details page go to Actions > Create document >Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

l To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document sourceMy computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

l To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
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select a document, click Save.

l To send mail without an attachment, click Create. The Mail module in Document opens.

5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

7.0.4 Payment claims

The Payment claims module lets you manage payment claims from Contract. The payment claims
function can be used when you are required to certify a vendor's claim of work in advance of receiving
an invoice or before the payment form is created. The payment claims functionality also can be used
when you want to create payment forms based on the schedule of values for the project instead of line
items. After a schedule item is associated to a payment claim, and you certify the claim, you can
convert the schedule item to a payment form.

The contract must have a schedule of values to use payment claims. You can add an existing or new
schedule items to the payment claim.

Payment claims also can be added by the vendor with the applicable roles and permissions via the
Vendor contract summary page. See Vendor submission setup for more information about configuring
access for vendors.

7.0.4 .16 Payment c la im dates

The payment claims function uses a series of dates scheduled based on your monthly payment claim
due date. Each date represents a requirement that you or your vendor must meet to ensure that the
vendor invoices match the work completed. You can configure up to 10 dates.

The Payment claims details and the Payment claims register show scheduled payment claim dates and
actual claim dates. You enter the date that scheduled event was completed. The Created date,
Submission date, and Certification date are always required. The Created date is generated by the
system when you create the payment claim. The Certification date is generated when you set the
Payment claim status to Certified. You must enter the actual date for any remaining dates.
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For information about configuring scheduled dates, see Payment claims configuration at the
organization level and Payment claims configuration at the project level.

7.0.4 .17 Invo ices

You can add new or existing invoices to the payment claim. All invoices must be added before the
claim is certified.

7.0.4 .18 Suppor t ing documents

You can add supporting documents to the payment claim. All supporting documents must be added
before the claim is certified.

7.0.4 .19 Payment c la ims reg is ter

The Payment claims register lets you see a summary of all payment claims in a project or contract.
Contract has Payment claims tabs at both the project and contract levels.

The column chooser shows only the dates set to Active in the settings.

You can add a payment claim from the Payment claims register at both the project and contract levels.

Add a payment c la im

Summary: Add a payment claim when you want to track communication dates with a vendor, to show
agreement on the work done and the amount to be invoiced.

Considerations: You must have a schedule of values and payment claims configured for the project.

Quick steps:

1. From the Payment claims register, click the Add payment claim icon. The Add payment claim
dialog box opens.
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2. Enter the payment claim information, including the description and work completed from and
work completed to dates. If you added the claim at the project level, you must assign a contract.
If you added a claim at the contract level, the claim is automatically assigned to that contract.

3. Click Add to add one claim. Click Add and new if you want to add additional claims. The claim is
added to the Payment claims register.

What's next: You can add comments and the scheduled dates on the Details tab. You can also add
schedule of values items, invoices, and supporting documents on their respective tabs.

Impor t payment c la ims

A convenient way to add payment claims is to import them using a payment claims import template.
Contract provides an import template that you can use to enter payment claims in bulk. To import
payment claims, click the Import data from template icon on the project level Payment claims register.
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For more information about importing, see Imports and exports.

After importing, you receive an email listing status, the total payment claims, the total imported, and
number of errors. If the status is pending, click the Review data link to see the payment claims that
have completed and those with errors. You can correct the lines with errors from the Import history
grid, select them, and then click Import to continue with the import process. The import is
reprocessed, and Contract sends you an email when the import is completed.

7.0.4 .20 Payment c la im deta i ls

The payment claim Details tab lets you view a summary of values, add and manage payment claim
dates, and add comments, and update the status.

Item Description

1 Header
values

The value of the payment claim. Values are read from the schedule of
values for the claim.

2 Payment
claim status

The current status of the payment claim. When you are ready to certify
the claim, you can set this value to Certified. The Certified by fields
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Item Description

shows the person who certified the claim. The Certified on field shows
the date the claim was certified.

3 Payment
claim dates

The scheduled dates configured in the settings for claims in this project.
The grid shows all dates that are set to Active and Default in the settings.
If the Allow users to edit dates in a payment claim toggle in the Payment
claim configuration at the project level (project > Settings > Contract >
Configurations > Payment claim configuration) is set to Yes, you can add
dates or remove dates except for the submission and the certification
dates.

4 Comments A text box for comments. You can continue to add comments after the
claim is certified.

Manage c la im dates

The dates shown in the Payment Claim Dates section of the Details page were configured in the
organization and project settings. You can add or remove dates to align with your business needs. You
can also enter the actual dates for dates other than the Created date, Certified date, and Submission
date, which are system generated.

Add a payment date

Summary: Add a payment date when you need additional dates for your business needs.

Considerations: Only dates that are set to Active in the settings are available. The toggle for Allow
users to edit dates in a payment claim in the Payment claim configuration at the project level (project >
Settings > Contract > Configurations > Payment claim configuration) must be set to Yes.

Quick steps:

1. Click Add payment claim in the Payment Claim Dates section of the Details page. The Add
payment claim dialog box opens.
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2. Click the Add icon next to the dates you want to add. The dates show in the Selected payment
claim dates box.

3. Click Add. The dates are added to the Payment Claim Dates grid.

4. Click Save.

What's next: When the requirements for a date has been met, you can add the actual date to the grid.

Update a payment date

Summary: Update the payment date when the communication for the date has been completed.

Considerations: The Created date, Submission date, and Certification date are generated automatically.

Quick steps:
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1. Click the Actual date field for the scheduled date.

2. Use the calendar toggle or manually enter the actual date.

3. Click Save.

Remove a payment date

Summary: Remove a payment date when it is not needed for the payment claim.

Considerations: You cannot remove the Created date, Submission date, or the Certification Date. The
toggle in the Payment claim configuration at the project level for Allow users to edit dates in a
payment claim(project > Settings > Contract > Configurations > Payment claim configuration) must be
set to Yes.

Quick steps:

1. In the Payment Claim Dates section, click the Delete icon next to the payment.

2. Click Save. The payment date is removed from the list.
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7.0.4 .21 Schedule of va lues

The Payment claims function has its own schedule of values page. You can add a schedule item to the
payment claim, so the payment claim is associated to work on the project. After the payment claim is
certified, you can convert the schedule item to a payment form instead of having to create the
payment form from a line item. You can also convert a certified payment claim to a contract claim
without leaving the Schedule of values page.

Schedule of va lues reg is ter

The schedule of values register for payment claims includes the following sections:

Section Description

Schedule
items

Shows schedule item details from the contract's schedule of values.

Summary
progress

Lets you track the contract and component progress claims on existing
schedule of values items. The Quantity claimed is the contract quantity
claimed plus the component progress quantity claimed. The Value claimed is
the contract value claimed plus the component progress value claimed. When
you add a schedule of values from the Payment claims Schedule of values
page, these fields are zero.

Previous
certification

Shows the quantity and value of the schedule item that have already been
certified.

Vendor
submission

Lets you enter quantities, values, and percent complete information that were
submitted by the vendor outside of InEight. You can also import Vendor
submission values.

Certification Lets you update the quantity, value, and percent complete that are to be
certified. To save time and reduce entry errors, you can click the Copy Vendor
Submission button to copy the information from the Vendor Submission
section into the Certification section. If the Schedule item ID is New, you
cannot certify if the quantity is greater than 0.

Current total The current quantity and value of the schedule item.

Remaining The quantity and value left to claim in the schedule item.
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After you certify a payment claim, the Schedule of values tab is a snapshot of the values at the time of
the claim.

Add an ex is t ing schedule i tem

Summary: Add an existing schedule of values item when you want to associate a known schedule item
to a payment claim.

Quick steps:

1. From the payment claims Schedule of values register, click the Add icon, and then select Add
existing schedule of value. The Add schedule item dialog box opens.

The dialog box shows a list of all schedule of values items that are available for the payment
claim. You can use the column filters to help you narrow the list. Date fields in the dialog box let
you filter the Schedule item and Summary progress columns to show the values of a specific date
range. Click the Calendar picker icon to quickly enter dates for a range such as To date or
Current week.
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2. Select one or more schedule items.

3. Click Add. The are added to the Schedule of values register.

What's next: The values in the Summary progress section of the Payment claim Schedule of values
register reflect all progress to date. When you change the date range on the Payment claim Schedule
of values register, the Summary progress section is updated.

Add a new schedule i tem

Summary: Add a new schedule of values item when an existing item does not exist.

Considerations: New items are added with a schedule item ID of New. You cannot certify a claim if the
schedule item ID is New and the quantity in the Certification section is not 0. New schedule of value
items cannot be added to payment forms.

Quick steps:

1. From the Schedule of values register, click the Add icon, and then select Add new schedule of
value. The Add schedule item dialog box opens.

2. Select a contract line item ID, and then enter the schedule item information. A description and
unit of measure are required.

3. Click Add. The item is added to the Schedule of values register with a schedule item ID of New.
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What's next: To assign a schedule item ID, you must associate the schedule item to a vendor change
order and then execute the vendor change order. After the vendor change order is executed, the
schedule item gets an ID, and you can then add it to a payment form or certify the claim.

Conver t a schedule i tem to a vendor change order

Summary: Convert a schedule of values to a vendor change order when you and the vendor agree that
the schedule item represents a new scope of work.

Considerations: If you convert to an existing vendor change order, the selected schedule items
overwrite any existing schedule of value items on the vendor change order.

Quick steps: 

1. From the Schedule of values register, select a schedule item, and then click the Convert schedule
of value icon.

2. Select Convert to vendor change order. The Associate schedule item dialog box opens.

3. Indicate whether to associate the schedule item to a new or existing schedule item.

4. Complete the vendor change order information.

l When converting to an existing vendor change order, enter the vendor change order ID.

l When converting to a new vendor change order, enter the vendor change order details,
vendor change order number, description and vendor change order type are required.

5. Click Save.
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Conver t a cer t i f ied payment c la im to a cont rac t c la im

Summary: You can convert a certified payment claim to a contract claim from the payment claim
schedule of values page to take advantage of a single entry of values.

Considerations: The payment claim must be certified. The schedule item's Hide in Plan and progress
check box must be selected. If the check box is not selected, the schedule items are not available for
contract claims.

1. From the payment claim schedule of values page, select one or more schedule items.

2. Click the Convert schedule of value icon, and then select Convert to contract claim. The Update
contract claim for below schedule of value items dialog box opens.

The Posted date field defaults to the date the claim was certified. You can edit the date as
needed.

3. Optionally, click Add schedule item to add more schedule items to the claim. The Add schedule
items dialog box opens, where you can select and add schedule items to the contract claim.

4. Click the Claim button to claim the schedule items.

The columns in the Summary progress section of the contract schedule of values are updated with the
claim information.

Percent complete c la iming

The % Complete columns in the Vendor Submission and Certification section show the percentage of
the schedule item that has been claimed. The % Complete values are updated if any quantity or value
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changes are made to the Schedule of values from the contract-level schedule of values or as part of a
vendor change order.

You can also manually enter % Complete column values. The Period Quantity and Value are used as the
source of truth if changes occur.

When a change is made to the Vendor submission Quantity or Value columns, Contract recalculates
the Vendor submission % Complete value as

( (Vendor submission value ÷ Scheduled value) + (Previous certification value ÷ Scheduled value) ) ×
100

When a change is made to the Certified Quantity or Value columns, Contract recalculates the Certified
% Complete as

(Previous certification value + Certification value) ÷ Scheduled value) × 100

When a Schedule of value item is on multiple pending claims, a pending uncertified claim warning
shows in the Schedule ID column. The icon shows so that you can be aware that totals for the schedule
of values item will change.

7.0.4 .22 Work ing wi th vendor-submi t ted payment c la ims

After a vendor has submitted payment claims, a badge indicating the number of payment claims that
need attention shows in the Payment claims tab. New vendor-submitted payment claims show with
the status Pending in the Vendor claim status column of the Payment claims register.
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To acknowledge that you have received the payment claim from the vendor, click the Received button.
After the claim has been accepted, the claim is given a numeric ID instead of the New ID.

A vendor can submit a schedule of values and invoices with the payment claim. Any schedule item
added by a vendor is automatically hidden in InEight Plan and InEight Progress. You can edit the
schedule item to make it visible in Plan or Progress if applicable.

When a vendor adds an invoice to a payment claim, a badge shows on the Invoices tab. The invoices
show in the Draft status. For more information about vendor-submitted invoices, see Working with
vendor-submitted invoices. If the payment claim needs attention from the vendor, click the Send to
vendor button. The claim is sent back to the vendor, where they can make changes and resubmit it.
The Notes panel shows all actions from both you and the vendor.

7.0.4 .23 Cer t i f i ca t ion

When you and the vendor have agreed on a payment amount, you can certify the payment claim. You
must certify a claim before you can convert a schedule item to a payment form. After the payment is
certified, you might have a certain number of days to make the payment, depending on your business
practices and local laws.

Approva l work f low

If workflow is configured for the payment claim, the claim must be approved before it can be certified.
To start the approval workflow, click Save and start approval on the payment claim Details page.

Cert i fy a payment c la im

To certify a payment claim, select Certified from the Payment claim status drop-down menu in the
Payment claims header. The Certification Actual date is updated on the Details page and on the
Payment claims register.

After the payment claim is certified, the claim becomes locked, and you can edit only the Comments
field on the Details page and add invoices. You also can edit invoices after certification if they are not
on a submitted payment form or if the payment form is approved or in any approval workflow.

Contract also saves and stores snapshots of the Payment claim Schedule of values and Line items tabs,
so you can see the values at the time of certification. These values can help you track progress.
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7.0.4 .24 Conver t to a payment form

After the claim is certified, you can convert the payment claim to a payment form, so you can start
your internal payment process. The conversion lets you base the payment form on the schedule of
values instead of a line item. A payment claim can be associated with only one payment form, and a
payment form can be associated with only one payment claim.

Conver t to a payment form

Summary: After a payment claim is certified, you can convert the schedule items to a payment form.
Converting from the schedule of values lets you create a payment form that reflects the work you and
the vendor have agreed upon rather than a line item.

Considerations: The payment claim must be certified. All schedule of value items are used in the
payment form regardless of what is selected. If workflow is configured for approving payment forms,
the payment form must go through workflow.

Quick steps:

1. From the payment claim Schedule of values page, select a schedule item, and then click the
Convert schedule of value icon.

2. Select Convert to Payment Form. The Convert to Payment Form dialog box opens.

3. Enter the payment form details, and then click Next.

4. Optionally, select the applicable invoices to convert to the payment form, and then click Next. By
default, all invoices are selected.

5. Optionally, select any of the supporting documents listed to convert to the payment form, and
then click Convert. The schedule of values is converted to a payment form. The certification
values are now included in the Current total in the schedule of values register.

7.0.5 Vendor submission setup

Vendors with the applicable permission can submit invoices and payment claims into your Contract
environment. Before a vendor can submit invoices, you must set them up as a user with specific roles
and project access.

7.0.5 .25 Vendor ro les and permiss ions

Vendor users must be assigned to a role that includes the View Contract vendor page permission (Suite
Administration > Roles and permissions > Suite administration > Vendor > View Contract vendor
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page). This permission automatically includes the Documents permissions under Suite Administration >
Roles and permissions > Organization and project > Documents.

When you create a vendor permission, set the administrator level to base level 0. The Vendor landing
page view must be assigned in the View assignments section.

7.0.5 .26 User management

The vendor user must have a vendor assigned in the Vendor field of the User details. You can assign a
vendor user to a specific project on the project home page or assign the user at the organization level.

After you add the vendor user, they receive an InEight notification with a link and sign-in information.

7.0.6 Vendor Contract functions

As a vendor you can use Contract to submit invoices and payment claims to the contractor. Using the
vendor Contract functions can make the payment process go quickly and helps to reduce errors that
might occur when contractors enter information manually. Contact your InEight representative for
more information about accessing vendor Contract functions.

7.0.6 .27 Vendor home page

To access the InEight system, click the link provided in the notification email, and sign in using your
credentials. After you have successfully signed, the home page opens to a vendor view. A tile labeled
Contracts lists the contracts you have with the contractor.
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You can click a contract ID to go to the Vendor contract summary page.

7.0.6 .28 Vendor cont rac t summary page

The Vendor contract summary page lets vendors add, edit and track invoices and payment claims for a
contract. Invoices and payment claims added to the page are automatically sent to the contractor.

The Vendor contract summary page shows contract information, including contract totals and contact
details.
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Payment c la ims

The Payment claims section shows all payment claims submitted to the contractor. You also use this
section to add payment claims to Contract and view comments on existing payment claims.
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After you save the payment claim, you can enter new or existing schedule of value items and invoices.
After you have added the applicable items, you can submit your payment claim to the contractor. See
Submit a vendor payment claim for more information about submitting payment claims.

7.0.6 .29 Get t ing star ted wi th vendor invo ice submiss ion

As a vendor, you can submit invoices directly into your contractor's invoice register where they can be
processed quickly. After you have been set up as a vendor by the contractor, you will receive an email
from ineight.mail@ineight.com with a link to the vendor home page and sign-in credentials.

Invo ice funct ions

The Invoices grid shows all invoices for the contract. The total number of invoices and their total value
are shown at the bottom of the grid.
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After the contractor applies the invoice to a payment form and the payment form is submitted, the
value in the Paid amount column is updated with the amount paid.

You can use this page to add new invoices, edit existing invoices, and add notes to invoices.

Add invo ices

You can add an invoice directly from the Vendor contract summary page. After the invoice is
submitted, it is automatically sent to the contractor. The Add invoice interface lets you upload or link
to invoice documentation from your organization, so you do not have to send it by some other means.

Add an invoice

Summary: Add an invoice directly into the contractor's InEight system.

Considerations: You must be set up as a vendor user by your contractor.

1. From the Vendor contract summary page, click the Add icon at the top right of the grid. The Add
invoice dialog box opens.
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2. Enter the invoice number, invoice date, invoice amount, and tax information.
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3. In the File/Link field, enter a URL for an online invoice, or click the Select file button to add an
invoice file from your computer.

4. Enter comments regarding the invoice if needed.

5. Click the Submit button. The invoice is sent to the contractor added to the grid with a status of
Pending, and the item total and the Invoice total at the bottom of the grid are updated. You can
no longer edit the invoice unless it is recalled by the contractor first.

What's next: The contractor either receives or declines the invoice. When the Record status is
Received, the contractor has agreed to it and will enter it into their payment for system. When the
Record status is Declined, you can recall it and resubmit it to the contractor.

Edi t invo ices

Sometimes the contractor identifies problems with the submitted invoice that must be corrected.
When the contractor identifies errors, they decline the invoice, and the Vendor invoice submission
page shows the Record status for the invoice as Declined.

Recall and edit an invoice

Summary: Recall an invoice when you want to edit it and resubmit it to the contractor for payment.
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Considerations: You can edit invoices with the Record status Declined or Pending. You cannot edit an
invoice with the Record status Received.

1. From the Vendor contract summary page grid, click the invoice number of the invoice you want
to correct. The Edit invoice dialog box opens.

2. Scroll to the bottom of the dialog box, and then click the Recall button. The fields become
editable, and the button name changes to Submit. The Record status in the Invoices grid changes
to Recalled. The invoice is also removed from the contractor's invoice list.

3. Update the information as needed, and then click the Submit button. The invoice is sent to the
contractor, and the Record status of the invoice changes to Pending.

Add and read invo ice notes

You can view or read notes on an invoice without opening the invoice. To view or add a comment to
the invoice, select an invoice and then click the Notes/feed icon. The Notes/feed slide-out panel
opens. You can then add notes. Any comments entered when adding the invoice are automatically
applied and are shown in the feed.
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After you add notes and then click Add, the note is added with a time stamp. The contractor can also
add notes to an invoice. These are shown with a blue bar on the left side of the note.

7.0.6 .30 Payment c la ims funct ions

You can submit payment claims to the contractor to help the claim of work certification process. You
can also submit payment claims when payment is based on a schedule of values rather than line items.

The Payment claims section of the Vendor contract summary page lets you add payment claims
directly into the contractor's Contract system. You can also view comments on existing payment
claims.
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Add a payment c la im to the Vendor cont rac t summary page

Summary: Add a new payment claim to the vendor contract summary page to ensure accuracy and
help the payment claims process go quickly.

Considerations: You must have access to the Vendor contract summary page. These steps describe
adding the payment claim to the grid. See Submit a vendor payment claim for information about
submitting the payment claim to the contractor.

1. In the Payment claims section of the Vendor contract summary page, click the Add icon. The
Payment claim details page opens.

2. Enter the payment claim description, the dates of the work completed, the date of the payment
claim and any comments you might have. The Payment claim ID is set to New and cannot be
changed. Click the Save button. The payment claim is added and also shows in the grid on the
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Vendor contract summary page.

What's next: The Schedule of values tab and Invoices tab are enabled, and you can add schedule of
values items and invoices as needed. The Submit button also shows.

Add a vendor payment c la im

You can add a payment claim directly from the Vendor contract summary page. After the payment
claim is submitted, it is automatically sent to the contractor. You can also add schedule of values items
and invoices to support the payment claim.

Schedule of va lues

Adding a schedule of values to a payment claim lets you associate the payment claim to work on the
project. The payment claim's Schedule of values page lets you add new or existing schedule of values
items.

Schedule of va lues reg is ter

The schedule of values register for payment claims includes the following sections:

Section Description

Schedule
items

Shows schedule item details from the contract's schedule of values.

Previous
certification

Shows the quantity and value of the schedule item that have already been
certified.
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Section Description

Vendor
submission

Lets you enter quantities, values, and percent complete information that were
submitted by the vendor directly from the vendor Payment claim page. You
can also import Vendor submission values.

Certification Shows you the quantity, value, and percent complete that are to be certified.

Current total The current quantity and value of the schedule item.

Remaining The quantity and value left to claim in the schedule item.

Add an ex is t ing schedule of va lues to a payment c la im

Summary: Add an existing schedule of values item when you want to associate a known schedule item
to a payment claim.

Considerations: If you cannot find an existing schedule of values, you can add a new one. See the step
by step Add a new schedule of values to a payment claim.

1. From the payment claim's Details page, click the Schedule of values tab. The Schedule of values
page opens.

2. Click the Add icon, and then select Add exisitng schedule of value. The Add schedule item dialog
box opens.

The dialog box shows a list of all schedule of values items that are available for the payment
claim. You can use the column filters to help you find what you need.
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3. Select one or more schedule items.

4. Click Add. The are added to the Schedule of values register.

Add a new schedule of va lues to a payment c la im

Summary: Add a new schedule of values item to a payment claim when the schedule item you want to
associate does not already exist in the contractor's project.

1. From claim's Details page, click the Schedule of values tab. The Schedule of values page opens.

2. Click the Add icon, and then select Add new schedule of value. The Add schedule item dialog
box opens.
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3. Select a contract line item ID, and then enter the schedule item information. A description and
unit of measure are required.

4. Click Add. The item is added to the Schedule of values register with a schedule item ID of New.

Invo ices

You can add invoices to support the payment claim to help the contractor ensure the payment process
goes more efficiently.

If you attach the invoice prior to submitting thhe payment claim, the invoice is submitted with
the claim.

Add a new invo ice

Summary: Add a new invoice that is associated to the payment claim. Invoices added to

this page are automatically added to the Invoices list.

Considerations: These steps add the invoice to the payment claim. You must also submit the invoice to
add it to the contractor's InEight system. See the step by step Submit an invoice from the Invoices
register.
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1. From a payment claim, click the Invoices tab. The Invoices register opens.

2. Click the Add icon, and then select Add new invoice. The Add new invoice dialog box opens.

3. Enter the invoice number, invoice date, invoice amount, and tax information.

4. In the File/Link field, enter a URL for an online invoice, or click the Select files button to upload
an invoice file from your computer.

5. Click Add to add the invoice or Add and new to add the invoice and open a new dialog box to
add another invoice.

What's next: You can submit the invoice to the contractor's InEight system.

Add an invo ice f rom the invo ices l is t

Summary: Add an invoice from the invoice list to a payment claim.
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Considerations: These steps associate an invoice that has already been added but have not been
submitted.

1. From a payment claim, click the Invoices tab. The Invoices register opens.

2. Click the Add icon, and then select Add new invoice. The Add from invoice list opens. The list
shows all invoices that are not already associated to another payment claim or do not have a
status of Removed or Recalled.

3. Select one or more invoices, and then click Add. The invoices are added to the payment claim
and cannot be added to another claim.

What's next: You can submit the invoice to the contractor's InEight system. You can submit invoices
from the Invoices register or when you submit the payment claim.

Submi t an invo ice f rom the Invo ices reg is ter

Summary: Submit an invoice to add it to the contractor's invoices.
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1. In the Invoices register, select one or more invoices, and then click the Submit invoices button.

The Submit invoices dialog box opens.

2. Add submission notes, and then click Submit. The invoice is submitted and the invoice status in
the Invoices register is updated to Pending.

See Add an invoice for more information about vendor-submitted invoices.

Submi t a vendor payment c la im

When you have all the information entered for the payment claim, you can submit it to the contractor,
so they can begin their certification procedures.

Submi t a payment c la im to the cont rac tor

Summary: Send a payment claim to the contractor to add it to their Payment claims register.

Considerations: Any invoices that are in the Draft state are automatically submitted, and their statuses
are set to Pending.
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1. From the payment claim Details page, click the Submit button.

If the payment claim has any invoices attached that have not been submitted, the Submit
Payment Claim dialog box opens.

2. Enter submissions notes for the unsubmitted invoice, and then click the Submit button.

What's next: The payment claim is submitted to the contractor. If you submitted an invoice, the invoice
status is updated to Pending. The Payment claim details become disabled, and the Submit button
changes to Recall.

Recal l a submi t ted payment c la im

Summary: When you find an error or have another reason to undo a recently submitted payment
claim, you can recall it. After you recall a payment claim, you have the ability to update it as needed.

Considerations: You can only recall payment claims that have not been received by the contractor.
Payment claims that have been received show a value other than New in the Payment claim ID field.
You can add or edit notes at any time; you do not need to recall the payment claim.

1. From the payment claims Details page, click the Recall button. The Recall Payment Claim dialog
box opens.
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2. Enter notes in the Recall Notes field, and then click the Recall button.

What's next: The payment claim is recalled. The payment claim status is removed from the contractor's
Payment claims register. You can make changes to the payment claim and resubmit it.

Work ing wi th the cont rac tor

After the contractor receives your claim, the Recall button changes back to Submit on theDetails page,
and the Payment claim ID field of the payment claim details shows a number ID. The notes for the
payment claim includes a note from the contractor saying the claim was received.

If the contractor has made changes or wants you to make corrections, they can send the payment
claim back. A returned payment claim shows Returned as the payment claim status. The Notes page
shows the Returned status and shows you if any changes and comments were made by the contractor.
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You can now make any corrections and additions and resubmit the claim to the contractor.

7.0.7 Payment Progress

Payment progress shows you the actual invoice payments once they are processed in your ERP system
or by your Accounts Payable department. As they are processed, ERP software syncs the information
back to InEight Contract, populating it in the Payment progress tab on your contract record for your
review. In a proxy ERP environment, you can update the Payment progress tab manually if the edit
progress payment permission is assigned to your role.

Field/Section Function

1 Invoice
information

Shows the invoice information, including, the invoice total specified by
the vendor, the invoice tax amount from the ERP system or the proxy
ERP, the date of the invoice from the vendor, and the number of days
the invoice has been opened before payment.

2 Payment form
ID

The payment form ID associated with the payment.

3 Record ID The record ID associated with the payment.

Overview – Payment Progress Register
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Field/Section Function

4 Record status The status of the record associated with the payment

5 Posting date The date the payment was posted.

6 Paid amount The amount of the invoice paid by Accounts Payable. If you have a
proxy ERP, you can update this field manually.

7 Method What method was used for invoice payment. If you have a proxy ERP,
you can update this field manually.

8 Check
number/ACH

The check or ACH number used for payment. If you have a proxy
ERP, you can update this field manually.

9 Date cashed The date the check or payment was cashed. If you have a proxy ERP,
you can update this field manually.

10 Withheld The amount the invoice was withheld for retainage.   

11 Retention
released

How much of retention was released. If you have a proxy ERP, you
can update this field manually.

12 Progress
estimate
number

The estimate number from InEight Progress

13 Billing period The billing period associated with the payment.

14 Document
year

The year the payment took place. If you have a proxy ERP, the
document year is based on the Estimated posting date in the
Payment form Invoices Attachment register and is not updated when
you update the value in the Posting Date column. You can manually
update the document year as needed.

15 Export Lets you download a version of the Payment progress grid in a
Microsoft Excel spreadsheet.

16 Notes Lets you view and add notes about the payment. The Notes panel has
tabs for contract notes, supporting document notes, and
administrative notes. The Administrative notes tab is updated when
there is a change to the payment form or the payment progress made
by an administrator with Edit payment progress permission.

Overview – Payment Progress Register (continued)
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Field/Section Function

17 Totals The total amounts of the Invoice totals, Paid amounts, Invoice net
amount, and Invoice tax amount columns.

Overview – Payment Progress Register (continued)

If you have the permission EditPaymentProgress, you can edit the following fields from the Payment
progress register to keep Contract in sync with an ERP system:

l Record ID

l Record status

l Paid amount

l Method

l Check number/ACH

l Date cashed

l Retention released

Changes made on the Payment progress tab affect the payment progress tab only. They do not affect
the Payment forms tab.

7.0.7 .31 Pay when Paid

In some cases, the invoices may be posted, but the check or ACH does not go to the vendor right away
because the payment terms may say “pay when paid”. This means even though the invoice is
processed, the money is not sent to the vendor until the project is paid from the client/owner.
Additionally, one payment may reflect several invoices; this tab is a way to tie those together.
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CHAPTER 8 — CONTRACT
CLOSEOUT

When a contract is deemed complete and all the work has been verified by onsite, or when all material
has been delivered and accounted for, you can close out your contract.
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8.0.1 InEight Contract Workflow – Contract Closeout

8.0.2 Contract Closeout Overview

To make sure all items have been verified and closed out, you follow a closeout process located on the
Contract Closeout tab of your contract.

From the Contract Closeout tab, you assign people to approve and verify that all the requirements of
the contract are fufilled.

8.0.3 Contract Closeout Project Settings

Before you can initiate contract closeout, the setup of contract closeout needs to be completed in
Project settings. This setup consists of selecting what closeout sections you want to include in the
closeout process, and what questions you want in each closeout section. These will be the questions
the person doing the closeout will need to answer to consider each section of closeout complete. This
setup will typically be done by a project administrator.
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The following steps walk you, as a project administrator, through setting up your contract closeout
settings.

Set Up Cont rac t Closeout Set t ings

1. From the Project home page of the Steel Structure Training Job, click on the 1st level drop-down
menu and select Settings.

2. Select the Contract tab on the left.

3. Click on the Contracts sub-tab.
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4. Select the Contract closeout tab under Contracts.

l Under the Contract closeout section, you have the following default sections
included on your project:

l You can remove any of these sections if they are not needed in your closeout
process by clicking on the minus sign

l Each section has a Questions link you can click on to decide what questions to
include in that section

5. Click on the Questions link for Engineering closeout.

l A slide out panel appears with two sections:
l Available questions – Contains a list of questions you can select from to include in
your selected closeout section

l Assigned questions – Displays the closeout questions you have selected for the
section (This is blank because you haven’t selected any yet.)
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6. Click the Add button next to each question you want to add.

l You can add as many as necessary as per the project’s requirements
l The questions show up under the Assigned questions section below
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The questions you select from in Project settings are created in the Organizational settings
by your company’s designated administrative group. Your company should have a
procedure for requesting the addition of new questions for you to use on your projects.

7. Click Save.

8. Follow these same steps to select questions for your other closeout sections.

l Once you have your questions set, they will populate for all new contracts

8.0.4 Contract Closeout Process

When your contract is closed, you can initiate the closeout process by reviewing and answering the
closeout sections you are responsible for. Once completed, you can Save and mark as complete. If your
company has an overall contract closeout process set up in your Project settings, you will Save and
send closeout request, and the person assigned to the closeout sectionwill be notified via email. Upon
completion the contract manager receives a notification email stating that the closeout section is
complete.
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The following Step by Step walks you through the contract closeout process. Note that this Step by
Step assumes that setup of your contract closeout sections and questions has already occurred.

Contract Closeout Process

1. From the Contracts page of InEight Contract, select the Structural Steel contract used in
previous Step by Steps.

2. Select the Contract Closeout tab.

l You may need to click the side arrow to locate the tab

3. On the Contract Closeout tab, click the Refresh checklist button. This will pull the information
from Project settings and refresh your Contract Closeout tab. You can refresh a checklist in a
contract if any questions have been updated in the project settings. Only checklists that have not
been started, are not completed, or are not recalled are refreshed.

l Your closeout sections display in boxes as either Not Started or Not Applicable,
depending on what you set up in your project workflow

4. Select the Engineering section by clicking on the Engineering closeout box.

l The Engineering closeout page appears
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5. Answer the closeout questions for the Engineering closeout section, by selecting the appropriate
answers from the drop-down lists.

l You can add notes to further explain and clarify your responses

l On the left hand side of the page, you have the Scheduled Closeout Date and
Forecasted Closeout Date

6. Select the appropriate Scheduled and Forecasted closeout dates.

l This function will push to InEight Report where you can run reports to see what is
closed out and what is remaining

7. Repeat these steps for the other closeout sections.

8. After you have filled in the sections, click Save and send closeout request.
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l If you feel that something may not be complete yet, you can click Save to revisit later

l The first approver that is assigned in the workflow will then receive an email from
InEight.Mail@ineight.com to review the closeout section and either mark it as complete or
recall the closeout section

9. If you are the approver, review the closeout section that was submitted.

10. If you are ok with marking this complete, do so by selecting Save and mark complete.

l You can always see the status when you click the contract totals button

l Once all your applicable closeout boxes on the Contract Closeout tab are marked as
complete, your contract is closed

l When your closeout section is marked as complete they will display the following:
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l A notification email message is sent to the contract creator when the checklist is complete.
English is the only language supported for any localization settings in email.
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